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Introduction to Computers 

 
What is a computer? 
 
Definitions 
A computer is a machine that manipulates data according to a list of 
instructions called a program. 
   
A computer can also be defined as an electronic machine that accepts input 
(data), processes it and gives out results (information). A program in 
memory manages the processing. It can make use of data or information 
stored in memory and remember the results of the processing for later use, 
again in memory. 
 
A computer is also a (fairly complicated) tool intended to assist the user in 
accomplishing information-based tasks ranging from locating and 
acquiring data/information to to processing it to presenting or transmitting 
it. 
 
Basic characteristics about computer are: 
 
1. Speed: - As you know computer can work very fast. It takes only few 
seconds for calculations that we take hours to complete. You will be 
surprised to know that computer can perform millions (1,000,000) of 
instructions and even more per second. 
 
Therefore, we determine the speed of computer in terms of microsecond 
(10-6 part of a second) or nanosecond (10 to the power -9 part of a second). 
From this you can imagine how fast your computer performs work.  
 
 
2. Accuracy: - The degree of accuracy of computer is very high and every 
calculation is performed with the same accuracy. The accuracy level is 7  
 
determined on the basis of design of computer. The errors in computer are 
due to human and inaccurate data.  



 

 
3. Diligence: - A computer is free from tiredness, lack of concentration, 
fatigue, etc. It can work for hours without creating any error. If millions of 
calculations are to be performed, a computer will perform every calculation 
with the same accuracy. Due to this capability it overpowers human being 
in routine type of work.  
 
4. Versatility: - It means the capacity to perform completely different type 
of work. You may use your computer to prepare payroll slips. Next 
moment you may use it for inventory management or to prepare electric 
bills.  
 
5. Power of Remembering: - Computer has the power of storing any 
amount of information or data. Any information can be stored and recalled 
as long as you require it, for any numbers of years. It depends entirely 
upon you how much data you want to store in a computer and when to 
lose or retrieve these data.  
 
6. No IQ: - Computer is a dumb machine and it cannot do any work 
without instruction from the user. It performs the instructions at 
tremendous speed and with accuracy. It is you to decide what you want to 
do and in what sequence. So a computer cannot take its own decision as 
you can.  
 
7. No Feeling: - It does not have feelings or emotion, taste, knowledge and 
experience. Thus it does not get tired even after long hours of work. It does 
not distinguish between users.  
 
8. Storage: - The Computer has an in-built memory where it can store a 
large amount of data. You can also store data in secondary storage devices 
such as floppies, which can be kept outside your computer and can be 
carried to other computers. 
 
 
Block Diagram of Computer 

 



 

 
 

Types of Computers  

Computer sizes and power 

Computers can be generally classified by size and power as follows, 
though there is considerable overlap: 

 Personal computer: A small, single-user computer based on a 
microprocessor.  

 Workstation: A powerful, single-user computer. A workstation is like 
a personal computer, but it has a more powerful microprocessor and, 
in general, a higher-quality monitor.  

 Minicomputer: A multi-user computer capable of supporting up to 
hundreds of users simultaneously.  

 Mainframe: A powerful multi-user computer capable of supporting 
many hundreds or thousands of users simultaneously.  

 Supercomputer: An extremely fast computer that can perform 
hundreds of millions of instructions per second.  

Supercomputer and Mainframe 

Supercomputer is a broad term for one of the fastest computers currently 
available. Supercomputers are very expensive and are employed for 
specialized applications that require immense amounts of mathematical 
calculations (number crunching). For example, weather forecasting 
requires a supercomputer. Other uses of supercomputers scientific 
simulations, (animated) graphics, fluid dynamic calculations, nuclear 
energy research, electronic design, and analysis of geological data (e.g. in 



 

petrochemical prospecting). Perhaps the best known supercomputer 
manufacturer is Cray Research. 

Mainframe was a term originally referring to the cabinet containing the 
central processor unit or "main frame" of a room-filling Stone Age batch 
machine. After the emergence of smaller "minicomputer" designs in the 
early 1970s, the traditional big iron machines were described as 
"mainframe computers" and eventually just as mainframes. Nowadays a 
Mainframe is a very large and expensive computer capable of supporting 
hundreds, or even thousands, of users simultaneously. The chief difference 
between a supercomputer and a mainframe is that a supercomputer 
channels all its power into executing a few programs as fast as possible, 
whereas a mainframe uses its power to execute many programs 
concurrently. In some ways, mainframes are more powerful than 
supercomputers because they support more simultaneous programs. But 
supercomputers can execute a single program faster than a mainframe. The 
distinction between small mainframes and minicomputers is vague, 
depending really on how the manufacturer wants to market its machines. 

  

Minicomputer 

It is a midsize computer. In the past decade, the distinction between large 
minicomputers and small mainframes has blurred, however, as has the 
distinction between small minicomputers and workstations. But in general, 
a minicomputer is a multiprocessing system capable of supporting from up 
to 200 users simultaneously.  

  

Workstation 

It is a type of computer used for engineering applications (CAD/CAM), 
desktop publishing, software development, and other types of applications 
that require a moderate amount of computing power and relatively high 
quality graphics capabilities. Workstations generally come with a large, 
high-resolution graphics screen, at large amount of RAM, built-in network 



 

support, and a graphical user interface. Most workstations also have a 
mass storage device such as a disk drive, but a special type of workstation, 
called a diskless workstation, comes without a disk drive. The most 
common operating systems for workstations are UNIX and Windows NT. 
Like personal computers, most workstations are single-user computers. 
However, workstations are typically linked together to form a local-area 
network, although they can also be used as stand-alone systems.  

N.B.: In networking, workstation refers to any computer connected to a 
local-area network. It could be a workstation or a personal computer.  

  

Personal computer: 

It can be defined as a small, relatively inexpensive computer designed for 
an individual user. In price, personal computers range anywhere from a 
few hundred pounds to over five thousand pounds. All are based on the 
microprocessor technology that enables manufacturers to put an entire 
CPU on one chip. Businesses use personal computers for word processing, 
accounting, desktop publishing, and for running spreadsheet and database 
management applications. At home, the most popular use for personal 
computers is for playing games and recently for surfing the Internet. 

Personal computers first appeared in the late 1970s. One of the first and 
most popular personal computers was the Apple II, introduced in 1977 by 
Apple Computer. During the late 1970s and early 1980s, new models and 
competing operating systems seemed to appear daily. Then, in 1981, IBM 
entered the fray with its first personal computer, known as the IBM PC. 
The IBM PC quickly became the personal computer of choice, and most 
other personal computer manufacturers fell by the wayside. P.C. is short 
for personal computer or IBM PC. One of the few companies to survive 
IBM's onslaught was Apple Computer, which remains a major player in the 
personal computer marketplace. Other companies adjusted to IBM's 
dominance by building IBM clones, computers that were internally almost 
the same as the IBM PC, but that cost less. Because IBM clones used the 
same microprocessors as IBM PCs, they were capable of running the same 
software. Over the years, IBM has lost much of its influence in directing the 



 

evolution of PCs. Therefore after the release of the first PC by IBM the term 
PC increasingly came to mean IBM or IBM-compatible personal computers, 
to the exclusion of other types of personal computers, such as Macintoshes. 
In recent years, the term PC has become more and more difficult to pin 
down. In general, though, it applies to any personal computer based on an 
Intel microprocessor, or on an Intel-compatible microprocessor. For nearly 
every other component, including the operating system, there are several 
options, all of which fall under the rubric of PC 

Types of Programming Language 
 

Low-level language 

A low-level language is a programming language that provides little or no 

abstraction of programming concepts, and is very close to writing actual 

machine instructions. Two good examples of low-level languages are 

assembly and machine code 

Assembly language 

Sometimes referred to as assembly or ASL, assembly language is a low-

level programming language used to interface with computer hardware. 

Assembly language uses structured commands as substitutions for 

numbers allowing humans to more easily read the code versus looking at 

binary. Although easier to read than binary, assembly language is a 

difficult language and is usually substituted for a higher language such as 

C. Below is an example of assembly language in a debug routine. 

Machine language 

Sometimes referred to as machine code or object code, machine language 

is a collection of binary digits or bits that the computer reads and 

interprets. Machine language is the only language a computer is capable of 

understanding. 

http://www.computerhope.com/jargon/p/proglang.htm
http://www.computerhope.com/jargon/c/compinst.htm
http://www.computerhope.com/jargon/a/al.htm
http://www.computerhope.com/jargon/m/machlang.htm
http://www.computerhope.com/jargon/p/progming.htm
http://www.computerhope.com/jargon/b/binary.htm
http://www.computerhope.com/jargon/c/c.htm
http://www.computerhope.com/jargon/b/binary.htm


 

Computer programs are written in one or more programming languages, 

like C++, Java, or Visual Basic. A computer cannot directly understand the 

programming languages used to create computer programs, so the 

program code must be compiled. Once a program's code is compiled, the 

computer can understand it because the program's code has been turned 

into machine language. 

 

High-level language 

Sometimes abbreviated as HLL, a high-level language is a computer 

programming language that isn't limited by the computer, designed for a 

specific job, and is easier to understand. It is more like human language 

and less like machine language. However, for a computer to understand 

and run a program created with a high-level language, it must be compiled 

into machine language.  

The first high-level languages were introduced in the 1950's. Today, there 

are many high-level languages in use, including BASIC, C, C++, Cobol, 

FORTRAN, Java, Pascal, Perl, PHP, Python, Ruby, and Visual Basic. 

Memory 

A memory is just like a human brain. It is used to store data and 

instructions. Computer memory is the storage space in computer where 

data is to be processed and instructions required for processing are stored. 

The memory is divided into large number of small parts called cells. Each 

location or cell has a unique address which varies from zero to memory 

size minus one. For example if computer has 64k words, then this memory 

unit has 64 * 1024=65536 memory locations. The address of these locations 

varies from 0 to 65535. 

Memory is primarily of three types 

http://www.computerhope.com/jargon/p/proglang.htm
http://www.computerhope.com/jargon/c/cplus.htm
http://www.computerhope.com/jargon/j/java.htm
http://www.computerhope.com/jargon/v/vb.htm
http://www.computerhope.com/jargon/c/compile.htm
http://www.computerhope.com/jargon/b/basic.htm
http://www.computerhope.com/jargon/c/c.htm
http://www.computerhope.com/jargon/c/cplus.htm
http://www.computerhope.com/jargon/c/cobol.htm
http://www.computerhope.com/jargon/f/fortran.htm
http://www.computerhope.com/jargon/j/java.htm
http://www.computerhope.com/jargon/p/pascal.htm
http://www.computerhope.com/jargon/p/perl.htm
http://www.computerhope.com/jargon/p/php.htm
http://www.computerhope.com/jargon/p/python.htm
http://www.computerhope.com/jargon/r/ruby.htm
http://www.computerhope.com/jargon/v/vb.htm


 

 Cache Memory 

 Primary Memory/Main Memory 

 Secondary Memory 

Cache Memory 

Cache memory is a very high speed semiconductor memory which can 

speed up CPU. It acts as a buffer between the CPU and main memory. It is 

used to hold those parts of data and program which are most frequently 

used by CPU. The parts of data and programs are transferred from disk to 

cache memory by operating system, from where CPU can access them. 

Advantages 

The advantages of cache memory are as follows: 

 Cache memory is faster than main memory. 

 It consumes less access time as compared to main memory. 

 It stores the program that can be executed within a short period of time. 

 It stores data for temporary use. 

Disadvantages 

The disadvantages of cache memory are as follows: 

 Cache memory has limited capacity. 

 It is very expensive. 



 

 
Primary Memory (Main Memory) 

Primary memory holds only those data and instructions on which 

computer is currently working. It has limited capacity and data is lost 

when power is switched off. It is generally made up of semiconductor 

device. These memories are not as fast as registers. The data and 

instruction required to be processed reside in main memory. It is divided 

into two subcategories RAM and ROM. 

RAM or Primary Memory 

RAM stands for Random Access Memory. It is the primary storage for the 
computer. All programs, including the operating system, and any data they 
are using must be in RAM for the computer to access them. Whenever I 
hear the term, I think, "DAM, why'd they call it RAM?" It is 
called random because the computer can directly access any location in RAM 
(using its memory "address"), though we rarely have call to access memory 
randomly. Thus, Direct Access Memory would have been a better name. 

By comparison, a tape (video or audio) is a sequential medium. Accessing a 
particular note in a song is virtually impossible and requires scanning 
forward to find it. An audio editing program working on a song in RAM 
can and does directly access any point you want in the song. (Specifying it 
might be a problem, but consider cutting a section out to use as a ring tone. 

http://en.wikipedia.org/wiki/Random-access_memory


 

Once you specify the end points, the program goes directly to the indicated 
beginning and end.) 

RAM is volatile, or temporary, storage. When the computer is booted, the 
operating system is loaded into RAM. Any applications you use are located 
in RAM, along with the data the application may use. A loss of power 
means that everything in RAM is lost. Data that you did not save (any 
changes you have made recently) are lost. To help protect you from this 
loss many applications automatically save a working copy to the 
(permanent) storage on the hard disk at regular intervals. (You can then 
recover most of your work.) 

 
Secondary Memory 

This type of memory is also known as external memory or non-volatile. It 

is slower than main memory. These are used for storing data/Information 

permanently. CPU directly does not access these memories instead they are 

accessed via input-output routines. Contents of secondary memories are 

first transferred to main memory, and then CPU can access it. For example : 

disk, CD-ROM, DVD etc. 

Characteristic of Secondary Memory 

 These are magnetic and optical memories 

 It is known as backup memory. 

 It is non-volatile memory. 

 Data is permanently stored even if power is switched off. 

 It is used for storage of data in a computer. 



 

 Computer may run without secondary memory. 

 Slower than primary memories 

Peripheral and I/O Hardware 

Input [ 

Since the computer is a digital device, all input devices must provide data 

in digital form. A key function of most of the devices listed below is to 

convert data from analog to digital form for transmission to the computer 

through a hardware interface (for our purposes, a port). 

 

Keyboard 

The keyboard is the most popular input device for a computer. It translates 
numbers, letters, symbols and control keys into digital data (bytes) that can 
be interpreted by the PC. Most English keyboards today are based on 
the QWERTYdesign, a de facto standard. It takes its name from the first six 
letters seen in the keyboard's top first row of letters. 

Mouse/Pointing Device 
A mouse is an input device that allows the user to point (locate) and click 
(select) . With the rise in graphical user interfaces, mice became the most 
commonly used method in controlling a computer. A mouse is used to 
manipulate objects and text on the computer screen. This device can be 
plugged in or can be cordless. 
 

 

Ball mouse 

The ball mouse utilizes a small rubber ball inside to transmit a spatial 
relationship between objects on the screen. The mechanical movement is 
done by 2 scroll bars that detects X and Y axis movement of the ball to allow 
it go glide on the desktop plane. The ball mouse was invented by Bill 



 

English in 1972. 

Since it contained moving parts, the ball mouse was prone to dirt build up 
inside. Hairs would often get caught and rolled into the ball mechanism, 
causing the mouse to function erratically. With the falling cost of 
technology, ball mice have now been mostly replaced with lighter optical 
mice. 

 

Trackball 

By essentially flipping the mechanical ball mouse "upside down", we get 
atrackball. The ball is directly manipulated to move the screen pointer. 

These are great for mobile applications and public computer kiosks. 

 

Optical 

The optical mouse uses a light-emitting diode and photodiodes to detect 
movement relative to the underlying surface, rather than moving some of 
its parts like the traditional ball mouse. In order to increase the precision of 
the mouse, multiple infrared lasers with increasing resolution are used. 

 

 

Stylus 
A stylus is a small pen-like device used to enter data by reacting to a touch-

sensitive screen or film. Styli allow a user to input handwriting specific 

pieces of information like signatures. Many artists also use a stylus 

combined with a tablet. 

One important feature of a stylus is its tip which ideally is made of a firm, 
non-scratching form of plastic. The body of a stylus can be made from any 



 

suitable material. 

Styli are used with many popular devices like Palm Pilots and Trios, 
Blackberries and Nintendo DSs. Their popularity has reached a point where 
some companies offer conversion kits to change high-end or ergonomic 
writing pens into a stylus. 

Like the mouse, light pen, and digitizer, a stylus is typically more accurate 
than using a finger as a pointing device. 

 

Light Pen 

A light pen is a computer input device, with a light sensitive wand that 
works with CRT monitors. Used like a touch screen, but with higher 
resolution. They were used in engineering, graphic design and illustrating, 
but light pens have generally been replaced by other technologies. 

At right is a photo of the Hypertext Editing System (HES) console in use at 
Brown University, circa October 1969. 

 

Digitizer 
A digitizer is a pointing technology implemented on computer tablets. It 

consists of the tablet, an electronically integrated surface representative (to 

the computer) of an XY-axis grid. Using the electronic stylus (pen), the 

tablet will detect the stylus' movements and convert it into digital signals 

for the computer to use. A digitizing tablet is commonly used in the 

engineering and architectural industries as well as for fine and commercial 

art. 

 

http://en.wikipedia.org/wiki/CRT_monitor
http://en.wikipedia.org/wiki/Hypertext_Editing_System


 

Microphone 

A microphone converts sound to an electrical signal that is digitized and 
sent to the computer. 

Microphones on laptops and smartphones typically appear as no more than 
a pin hole on the device. 

 

Images 

Cameras 

Digital cameras are now standard, with most people uploading the pictures 
to their computer for processing, printing or sharing. Digital cameras are 
built into most laptops and hand-held devices, especially mobile phones. 
They are commonly added onto computers as webcams. 

Video cameras are not yet all digital, although videos created using laptops 
and smartphones are digital. Older videos need to be converted (using 
a CODEC) for storage or manipulation on the computer. 

 

Scanner 

A scanner is a device that uses light to read an image or text and turn it into 
digital information. This media can then be used to store, change and send 
the image or text. There are various types of scanners. The three most 
common are drum, flatbed and hand. Drum scanners mechanically move the 
document to be scanned past the sensor. Flatbed scanners use a glass pane on 
which a document is placed while the sensor moves underneath – generally 
the most accurate method. Hand-held scanners are dragged across the the 
image manually. 

 

Specialized & Commercial 

http://cs.sru.edu/~mullins/cpsc100book/sideBars/sidebar02-codec.html


 

Bar-Code 

A (linear) barcode is a series of stripes that vary in thickness. These stripes 
represent numbers, which a computer reads as data. Bar codes are printed 
on products that are sold in retail, as well as postal service packages, rental 
videos etc. Bar Codes are still in common use today. With the introduction 
of WiFienabled smartphones with cameras, barcodes can be scanned on 
products and matched to an online database which allows price 
comparisons between various retail stores without having to visit each one. 
Another use of this combination is finding the nutritional content of a 

consumable product by scanning its barcode. 

 

Other barcodes are two dimensional, as show at right. There are a 
number of barcode standards. QR codes or Quick Response 
codes are an example of two dimensional bar codes. 

Sidebar: joke using QR code 

 

RFID [src] 

Radio-Frequency IDentification (RFID) is a technology that uses radio 
waves to transfer data between a reader and an electronic tag attached to an 
object, for the purpose of identification and tracking. 

Over the forty years leading up to the turn of the 21st century, barcode 
technology brought inconspicuous, yet remarkable, changes to various 
industries and has had an impact on our lives. RFID, especially if its uses 
continue to multiply, will have an even greater impact. 

RFID makes it possible to give each product (in a store) its own unique 
identifying number – like the license plate on a car but for every item in the 
world. This is a vast improvement over paper and pencil tracking or bar 
code tracking that has been used since the 1970s. With bar codes, it is only 
possible to identify the brand and type of package in a grocery store, for 

http://www.webopedia.com/TERM/W/Wi_Fi.html
http://en.wikipedia.org/wiki/Barcode#Types_of_barcodes
http://en.wikipedia.org/wiki/QR_Code
http://en.wikipedia.org/wiki/QR_Code
http://en.wikipedia.org/wiki/Rfid
http://en.wikipedia.org/wiki/Rfid
http://cs.sru.edu/~mullins/cpsc100book/sideBars/SideBar15-QRcodes.html


 

instance. Furthermore, passive RFID tags, those without a battery, can be 
read if passed near to (up to ten meters or 33 feet) an RFID reader. It is not 
necessary to "show" the tag to the reader device, as with a bar code. In other 
words it does not require line of sight to "see" an RFID tag, the tag can be 
read inside a case, carton, box or other container, and unlike barcodes RFID 
tags can be read hundreds at a time. Bar codes can only be read one at a 
time. 

Active RFID tags, those with a battery, can be read from as much as 100 
meters (330 feet) away and beyond the line of sight of the reader. The 
application of bulk reading enables an almost parallel reading of tags. 

Radio-frequency identification involves the hardware known as 
interrogators (also known as readers), and tags (also known as labels), as 
well as RFID software or RFID middleware. 

Most RFID tags contain at least two parts: one is an integrated circuit for 
storing and processing information, modulating and demodulating a radio-
frequency (RF) signal, and other specialized functions; the other is an 
antenna for receiving and transmitting the signal. 

RFID can be either passive (using no battery), active (with an on-board 
battery that always broadcasts or beacons its signal) or battery assisted 
passive (BAP) which has a small battery on board that is activated when in 
the presence of an RFID reader. Passive tags in 2011 start at $0.05 each. 

 

"Wal-Mart Stores Inc. plans to roll out sophisticated 
electronic ID tags to track individual pairs of jeans and 
underwear, the first step in a system that advocates say 
better controls inventory but some critics say raises privacy 
concerns."[Wall Street Journal] 

 

Speech Recognition 

http://online.wsj.com/article/SB10001424052748704421304575383213061198090.html#ixzz1ORrzCftA
http://cs.sru.edu/~mullins/cpsc100book/sideBars/SideBar06-RFID.html


 

Sounds (phonemes) are the basis of words. The computer can identify the 
sounds and match them with potential words. Word with the same 
phonemes (their and there) can be selected by the words around them using 
grammar. 

 

Portable Devices 

The current generation of portable devices, such as laptops and 
smartphones, include many of the devices described above, including 
keyboard, cursor control, touch screen (as described below), digital camera, 
and microphone. "Scanning" a barcode involves snapping a digital picture. 
The network (phone and Internet) can both act as an input device, as well as 
an output device. 

 

Touchpad/Pointing Stick 

Touch pads are most commonly built into a laptop computer. A touch pad 
is a rectangular plastic piece which can control the pointer on a computer 
simply by dragging your finger across its surface. A pointing stick 
resembles a pencil eraser and is commonly located in between keys on a 
laptop key board. To control the pointer on the computer with a pointing 
stick you use your finger to push the stick in the direction you would like 
the pointer to move. 

Touchpads were originally known as trackpads. Some touchpads can have 
multiple mouse buttons by either tapping in a special corner of the pad, or 
by tapping with two or more fingers. Scrolling is implemented in touchpads 
along the sides, although this can be configured in touchpad settings. Some 
touchpads respond to multitouch, like the touchpads found on MacBooks. 

Both the touchpad and the point stick allow one to move the cursor about 
with minimal hand/arm movement, though some users find accuracy to be 
a problem (more so with the pointing stick). By contrast, the mouse often 
requires large movements, but excels at accuracy. 



 

 

Touch Screen 

A touch screen allows the user's finger(s) to act as a point & click device, 
providing the user interface with a more direct manipulation of objects and 
text displayed on the screen. That is, it gains most of the advantages of the 
light pen or stylus, without the need for a separate device. Accuracy is one 
problem, especially for small hand-held device where the (relatively large 
and blunt) finger occludes a significant part of the screen. Touch screens are 
commonly used on hand-held devices, kiosk computers, ATMs, and public 
workstations, like self check out (point of sale) devices in a store. 

There are two common types of touch screen, resistive screens and 
capacitive screens. Resistive screens operate by using two thin layers. When 
one layer comes into contact with another (from someone pressing the 
screen), they form a connection which can be translated into a pair of 
coordinates a computer uses. Resistive screens have the advantage of 
allowing the use of a (normal) stylus or a hand wearing a glove. They are 
used in many hand-held devices. 

Capacitive screens utilizes the concept that the human body is a conductor. 
When someone taps on a resisting material (such as a glass panel), a change 
in capacitance is observed, and the computer can determine where the user 
made a selection. This type of technology is known as capacitive sensing. 
Capacitive screens may only be used with styli and gloves when they are 
specially designed. A popular use of capacitive sensing is the touch screens 
in popular smartphones such as the iPhone. 

 

http://en.wikipedia.org/wiki/Touch_screen


 

Network Interface 
A network interface allows the computer to input data to your computer. 

Output 

Monitor  

A monitor, or visual display unit, is an electronic visual display for 
computers. It is now common for a single computer to have multiple 
monitors. Currently, most monitors are backlit LCD (flat panel liquid 
crystal) displays, which use much less energy than the older CRT (Cathode 
Ray Tube) displays. CRTs aim a stream of electrons through a mask at a 
phospher coated, fluorescent screen creating a bright, sharp image, and 
much more electromagnetic radiation and heat. 

The image is created from approximately one million (1000x1000) pixels, 
orpicture elements. Each pixel includes subpixels for the primary colors (red, 
green & blue) which are mixed to create a color on the screen. You will 
recall that a true color display provides approximatley 16 million colors 
(using one byte each for the red, green & blue subpixels). 

LCD monitor. Note profile and 

greatly improved viewing 

angle 

By Silmar2008 (Own work) 

[CC-BY-3.0], via Wikimedia Commons 

CRT 

monitor. Not

e profile 

By Ceedrun 

(Own work) 

[GFDL or CC-BY-SA-3.0-2.5-

2.0-1.0], via Wikimedia 

Commons 
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Monitor performance characteristics 

The performance of a monitor is measured by the following parameters: 

 Luminance, or over-all brightness, is measured in candelas per square 
meter (cd/m2 also called a Nit). 

 Aspect ratios is the ratio of the horizontal length to the vertical length. 
Monitors usually have the aspect ratio 4:3, 16:10 or 16:9. 

 Viewable image size is usually measured diagonally, but the actual 
widths and heights are more informative since they are not affected 
by the aspect ratio in the same way. For CRTs, the viewable size is 
typically 1 in (25 mm) smaller than the tube itself. 

 Display resolution is the number of distinct pixels in each dimension 
that can be displayed. Maximum resolution is limited by dot pitch. 

 Dot pitch is the distance between subpixels of the same color in 
millimeters. In general, the smaller the dot pitch, the sharper the 
picture will appear. 

 Refresh rate is the number of times in a second that a display is 
illuminated. Maximum refresh rate is limited by response time. 

 Response time is the time a pixel in a monitor takes to go from active 
(black) to inactive (white) and back to active (black) again, measured 
in milliseconds. Lower numbers mean faster transitions and therefore 
fewer visible image artifacts. 

 Contrast ratio is the ratio of the luminosity of the brightest color 
(white) to that of the darkest color (black) that the monitor is capable 
of producing. 

 Power consumption is the amount of energy needed (measured in 
Watts). 

 Viewing angle is the maximum angle at which images on the monitor 
can be viewed, without excessive degradation to the image. It is 
measured in degrees horizontally and vertically. 

 



 

Electronic Paper [src] 

Electronic paper, e-paper and electronic ink are a range of display 
technologies which are designed to mimic the appearance of ordinary ink 
on paper. Unlike conventional backlit flat panel displays, electronic paper 
displays reflect light like ordinary paper. Many of the technologies can hold 
text and images indefinitely without using electricity, while allowing 
images to be changed later. Flexible electronic paper uses plastic substrates 
and plastic electronics for the display backplane. 

Electronic paper is often considered to be more comfortable to read than 

conventional displays. This is due to the stable image, which has no need to 

be refreshed constantly, a wider viewing angle, and that it reflects ambient 

light rather than emitting its own light. An ideal e-paper display can be read 

in direct sunlight without the image appearing to fade. The contrast ratio in 

available displays as of 2008 might be described as similar to that of 

newspaper, though newly-developed displays are slightly better. There is 

ongoing competition among manufacturers to provide full-color ability. 

http://en.wikipedia.org/wiki/Electronic_paper
http://en.wikipedia.org/wiki/Electronic_paper


 

Printing Technology [src] 

Printers are routinely classified by the printer technology they employ; 
numerous such technologies have been developed over the years. The 
choice of engine has a substantial effect on what jobs a printer is suitable 
for, as different technologies are capable of different levels of image or text 
quality, print speed, cost, and noise. In addition, some printer technologies 
are inappropriate for certain types of physical media, such as carbon paper 
or transparencies. 

A second aspect of printer technology that is often forgotten is resistance to 
alteration: liquid ink, such as from an inkjet head or fabric ribbon, becomes 
absorbed by the paper fibers, so documents printed with liquid ink are 
more difficult to alter than documents printed with toner or solid inks, 
which do not penetrate below the paper surface. (This is important in many 
financial and business applications.) 

Toner-based printers 

A laser printer rapidly produces high quality text and graphics. As with 
digital photocopiers and multifunction (print, copy, fax) printers, laser 
printers employ axerographic printing process but differ from analog 
photocopiers in that the image is produced by the direct scanning of a laser 
beam across the printer's photoreceptor. 

Another toner-based printer is the LED printer which uses an array of LEDs 
instead of a laser to cause toner adhesion to the print drum. 

Liquid inkjet printers 

Inkjet printers operate by propelling variably-sized droplets of liquid or 
molten material (ink) onto almost any sized page. They are the most 
common type of computer printer used by consumers. 

Solid ink printers 

Solid ink printers are a type of thermal transfer printer. Rather than mixing 

http://en.wikipedia.org/wiki/Printer_%28computing%29
http://en.wikipedia.org/wiki/Computer_printer
http://en.wikipedia.org/wiki/Xerography


 

red, green and blue, they use solid sticks of CMYK-colored ink, similar in 
consistency to candle wax, which are melted and fed into a piezo crystal 
operated print-head. The printhead sprays the ink on a rotating, oil coated 
drum. The paper then passes over the print drum, at which time the image 
is transferred, or transfixed, to the page. Solid ink printers are most 
commonly used as color office printers, and are excellent at printing on 
transparencies and other non-porous media. Solid ink printers can produce 
excellent results. Acquisition and operating costs are similar to laser 
printers. Drawbacks of the technology include high energy consumption 
and long warm-up times from a cold state. Also, some users complain that 
the resulting prints are difficult to write on, as the wax tends to repel inks 
from pens, and are difficult to feed through automatic document feeders, 
but these traits have been significantly reduced in later models. In addition, 
this type of printer is only available from one manufacturer, Xerox. 

Dye-sublimation printer 

A dye-sublimation printer is a printer which employs a printing process that 
uses heat to transfer dye to a medium such as a plastic card, paper or 
canvas. The process is usually to lay one color at a time using a ribbon that 
has color panels. Dye-sublimation printers are intended primarily for high-
quality color applications, including color photography; and are less well-
suited for text. While once the province of high-end print shops, dye-
sublimation printers are now increasingly used as dedicated consumer 
photo printers. 

Inkless printers 

Thermal printer 

Thermal printers work by selectively heating regions of special heat-sensitive 
paper. Monochrome thermal printers are used in point of sale devices, such 
as, cash registers, ATMs, and gasoline dispensers. Colors can be achieved 
with special papers and different temperatures and heating rates for 
different colors; these colored sheets are not required in black-and-white 
output. 

 
 

http://en.wikipedia.org/wiki/Cmyk
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Plotter 
 
The plotter is a computer printer for printing vector graphics. In the past, 
plotters were used in applications such as computer-aided design, though 
they have generally been replaced with wide-format conventional printers. 
A plotter gives a hard copy of the output. It draws pictures on a paper 
using a pen. Plotters are used to print designs of ships and machines, plans 
for buildings and so on. 
 
Number System 
 

When we type some letters or words, the computer translates them in numbers as 

computers can understand only numbers. A computer can understand positional 

number system where there are only a few symbols called digits and these symbols 

represent different values depending on the position they occupy in the number. 

A value of each digit in a number can be determined using 

 The digit 

 The position of the digit in the number 

 The base of the number system (where base is defined as the total number of digits 

available in the number system). 

Decimal Number System 

The number system that we use in our day-to-day life is the decimal number system. 

Decimal number system has base 10 as it uses 10 digits from 0 to 9. In decimal number 

system, the successive positions to the left of the decimal point represent units, tens, 

hundreds, thousands and so on. 

Each position represents a specific power of the base (10). For example, the decimal 

number 1234 consists of the digit 4 in the units position, 3 in the tens position, 2 in the 

hundreds position, and 1 in the thousands position, and its value can be written as 

(1x1000)+ (2x100)+ (3x10)+ (4xl) 

https://en.wikipedia.org/wiki/Computer
https://en.wikipedia.org/wiki/Printer_(computing)#Pen-based_plotters
https://en.wikipedia.org/wiki/Vector_graphics
https://en.wikipedia.org/wiki/Computer-aided_design


 

(1x103)+ (2x102)+ (3x101)+ (4xl00) 

1000 + 200 + 30 + 4 

1234 

As a computer programmer or an IT professional, you should understand the following 

number systems which are frequently used in computers. 

S.N. Number System and Description 

1 
Binary Number System 

Base 2. Digits used : 0, 1 

2 

Octal Number System 

Base 8. Digits used : 0 to 7 

3 

Hexa Decimal Number System 

Base 16. Digits used : 0 to 9, Letters used : A- F 

Binary Number System 

Characteristics of binary number system are as follows: 

 Uses two digits, 0 and 1. 

 Also called base 2 number system 

 Each position in a binary number represents a 0 power of the base (2). Example 20 

 Last position in a binary number represents a x power of the base (2). Example 2x where 

x represents the last position - 1. 

Example 

Binary Number : 101012 

Calculating Decimal Equivalent: 



 

Step Binary Number Decimal Number 

Step 1 101012 ((1 x 24) + (0 x 23) + (1 x 22) + (0 x 21) + (1 x 20))10 

Step 2 101012 (16 + 0 + 4 + 0 + 1)10 

Step 3 101012 2110 

Note : 101012 is normally written as 10101. 

Octal Number System 

Characteristics of octal number system are as follows: 

 Uses eight digits, 0,1,2,3,4,5,6,7. 

 Also called base 8 number system 

 Each position in an octal number represents a 0 power of the base (8). Example 80 

 Last position in an octal number represents a x power of the base (8). Example 8x where 

x represents the last position - 1. 

Example 

Octal Number : 125708 

Calculating Decimal Equivalent: 

Step Octal Number Decimal Number 

Step 1 125708 ((1 x 84) + (2 x 83) + (5 x 82) + (7 x 81) + (0 x 80))10 

Step 2 125708 (4096 + 1024 + 320 + 56 + 0)10 

Step 3 125708 549610 

Note : 125708 is normally written as 12570. 



 

Hexadecimal Number System 

Characteristics of hexadecimal number system are as follows: 

 Uses 10 digits and 6 letters, 0,1,2,3,4,5,6,7,8,9,A,B,C,D,E,F. 

 Letters represents numbers starting from 10. A = 10. B = 11, C = 12, D = 13, E = 14, F = 

15. 

 Also called base 16 number system 

 Each position in a hexadecimal number represents a 0 power of the base (16). Example 

160 

 Last position in a hexadecimal number represents a x power of the base (16). Example 

16x where x represents the last position - 1. 

Example 

Hexadecimal Number : 19FDE16 

Calculating Decimal Equivalent: 

Step Binary Number Decimal Number 

Step 1 19FDE16 ((1 x 164) + (9 x 163) + (F x 162) + (D x 161) + (E x 160))10 

Step 2 19FDE16 ((1 x 164) + (9 x 163) + (15 x 162) + (13 x 161) + (14 x 160))10 

Step 3 19FDE16 (65536+ 36864 + 3840 + 208 + 14)10 

Step 4 19FDE16 10646210 

 
 
 
 
 
 
 



 

Algorithm and Flowcharts 

 
ALGORITHM: 

DEFINITION:-   An algorithm is a well-ordered collection of unambiguous and 

effectively computable operations that when executed produces a result and halts in a 

finite amount of time. 

Characteristics of Algorithms: 

we can identify five important characteristics of algorithms. 

1. Algorithms are well-ordered.  
2. Algorithms have unambiguous operations.  
3. Algorithms have effectively computable operations.  
4. Algorithms produce a result.  
5. Algorithms halt in a finite amount of time.  

These characteristics need a little more explanation, so we will look at each one in 
detail. 

Algorithms are well-ordered 

Since an algorithm is a collection of operations or instructions, we must know the 
correct order in which to execute the instructions. If the order is unclear, we may 
perform the wrong instruction or we may be uncertain which instruction should be 
performed next. This characteristic is especially important for computers. A computer 
can only execute an algorithm if it knows the exact order of steps to perform. 

Algorithms have unambiguous operations 

Each operation in an algorithm must be sufficiently clear so that it does not need to be 
simplified. Given a list of numbers, you can easily order them from largest to smallest 
with the simple instruction "Sort these numbers." A computer, however, needs more 
detail to sort numbers. It must be told to search for the smallest number, how to find the 
smallest number, how to compare numbers together, etc. The operation "Sort these 
numbers" is ambiguous to a computer because the computer has no basic operations for 
sorting. Basic operations used for writing algorithms are known as primitive operations 
or primitives. When an algorithm is written in computer primitives, then the algorithm 
is unambiguous and the computer can execute it. 

Algorithms have effectively computable operations 



 
Each operation in an algorithm must be doable, that is, the operation must be 
something that is possible to do. Suppose you were given an algorithm for planting a 
garden where the first step instructed you to remove all large stones from the soil. This 
instruction may not be doable if there is a four ton rock buried just below ground level. 
For computers, many mathematical operations such as division by zero or finding the 
square root of a negative number are also impossible. These operations are not 
effectively computable so they cannot be used in writing algorithms. 

Algorithms produce a result 

In our simple definition of an algorithm, we stated that an algorithm is a set of 
instructions for solving a problem. Unless an algorithm produces some result, we can 
never be certain whether our solution is correct. Have you ever given a command to a 
computer and discovered that nothing changed? What was your response? You 
probably thought that the computer was malfunctioning because your command did 
not produce any type of result. Without some visible change, you have no way of 
determining the effect of your command. The same is true with algorithms. Only 
algorithms which produce results can be verified as either right or wrong. 

Algorithms halt in a finite amount of time 

Algorithms should be composed of a finite number of operations and they should 
complete their execution in a finite amount of time. Suppose we wanted to write an 
algorithm to print all the integers greater than 1. Our steps might look something like 
this: 

1. Print the number 2.  
2. Print the number 3.  
3. Print the number 4. 

. 

. 

.  

While our algorithm seems to be pretty clear, we have two problems. First, the 
algorithm must have an infinite number of steps because there are an infinite number of 
integers greater than one. Second, the algorithm will run forever trying to count to 
infinity. These problems violate our definition that an algorithm must halt in a finite 
amount of time. Every algorithm must reach some operation that tells it to stop. 

ADVANTAGE OF ALGORITHM: 

 it is a step-by-step rep. of a solution to a given prblem ,which is very easy to 
understand 

 it has got a definite procedure. 



 
 it easy to first develope an algorithm,&then convert it into a flowchart &then into 

a computer program. 
 it is independent of programming language. 
 it is easy to debug as every step is got its own logical sequence. 

 

 

DISADVANTAGE OF ALGORITHM: 

  it is time consuming & cubersome as an algorithm is developed first which is 
converted into flowchart &then into a 

  computer program. 

 

ALGORITHM EXAMPLE: 

algorithm to find out number is odd or even 

step 1 : start 

step 2 : input number 

step 3 : rem=number mod 2 

step 4 : if rem=0 then 

               print "number even" 

           else 

               print "number odd" 

           endif 

step 5 : stop 

 

 



 
FLOWCHART: 

DEFINITION:  

A flowchart is a graphic representation of how a process works, showing, at a 
minimum, the sequence of steps. 

 

The flowchart is a means to visually present the flow of data through an information 

processing systems, the operations performed within the system and the sequence in 
which they are performed. In this lesson, we shall concern ourselves with the program 
flowchart, which describes what operations (and in what sequence) are required to 
solve a given problem. The program flowchart can be likened to the blueprint of a 
building. As we know, a designer draws a blueprint before starting to construct a 
building. Similarly, a programmer prefers to draw a flowchart prior to writing a 
computer program. As in the case of the drawing of a blueprint, the flowchart is drawn 
according to defined rules and using standard flowchart symbols prescribed by the 
American National Standard Institute, Inc. 

Meaning of a Flow Chart 

A flowchart is a diagrammatic representation that illustrates the sequence of operations 
to be performed to get the solution of a problem. Flowcharts are generally drawn in the 
early stages of formulating computer solutions. Flowcharts facilitate communication 
between programmers and business people. These flowcharts play a vital role in the 
programming of a problem and are quite helpful in understanding the logic of 
complicated and lengthy problems. Once the flowchart is drawn, it becomes easy to 
write the program in any high level language. Often we see how flowcharts are helpful 
in explaining the program to others. Hence, it is correct to say that a flowchart is a must 
for the better documentation of a complex program. 

Flow is a representation of a series of logic operations to satisfy specific requirements. A 
flow exists naturally. It can be irregular, unfixed or full of problems. For this reason, it 
may apparently be absent in some situations. Lately, members of a team were assigned 
to investigate the flow of a business process, and I was told that there were some 
deficiencies in the flow. The reply from the person who was in charge of the team was 
that no flow was shown in part of the business process. As a matter of fact, it is 
impossible for a business carried out without a flow. It may be a flow in an unfixed 
form, or, may be the person himself whom you investigated does not have a clear sense 
about the flow. 

https://www.edrawsoft.com/flowchart.php
https://www.edrawsoft.com/flowchart-solutions.php


 
Chart, or diagram, is a presentation or a written description of some regular and 
common parts of the flow. A chart is conducive to communication and concentration 
and offers references for process reengineering. 

Flow chart can be seen from the definition that a flow accompanies always with 
business or transaction. Not all of the flows, however, are appropriate to be expressed 
by flowcharts. Flows that can be expressed by charts follow some fixed routines, and 
the key links of flows won't be changed constantly. 

Symbols of Flowchart : 

 

Figure: Start/Stop terminal box 

 

 

Figure: Input/Output box 

 

 

Figure: Process/Instruction box 

 

 

Figure: Lines or Arrows 

 

http://3.bp.blogspot.com/-b6TQd1_QrPw/UGyQt8YViLI/AAAAAAAAAhM/eYSjwtZ_rsI/s1600/terminal+start.jpg
http://3.bp.blogspot.com/-Yid4V_bSR_c/UGyRqbo5VJI/AAAAAAAAAhU/whLrCtdgJ64/s1600/output-input_03.jpg
http://2.bp.blogspot.com/-_9v1CN97nDg/UGyS39rrvrI/AAAAAAAAAhc/Hp_-6eIbRIg/s1600/process_03.jpg
http://3.bp.blogspot.com/-WxJxEWb6kog/UGyUKDim_3I/AAAAAAAAAhk/tIFW7IKLdHg/s1600/arrows_03.jpg


 

 

Figure: Decision box 

 

 

Figure: Connector box 

 

 

Figure: Comment box 

 

 

Figure: Preparation box 

 

 

Figure: Separate box 

 

Advantages and Disadvantages of Flowchart 

Advantages Of Using FLOWCHARTS: 
• Communication: Flowcharts are better way of communicating the logic of a system to 
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http://3.bp.blogspot.com/-lF6ruaOQHC0/UGyWTq_1EXI/AAAAAAAAAh0/A48lWRxi5Q8/s1600/connector_03.jpg
http://2.bp.blogspot.com/-ooGY7zWcYC8/UGyXJhJizRI/AAAAAAAAAh8/tjlvXzNI0Qs/s1600/comment_03.jpg
http://1.bp.blogspot.com/-b46AsIGxAUw/UGyYG5sEUUI/AAAAAAAAAiE/GjdWhaa0po0/s1600/preparation_03.jpg
http://4.bp.blogspot.com/-Bgqd8R0EnN0/UGyZFfCjCVI/AAAAAAAAAiM/m-L7gqrT40g/s1600/separate_03.jpg


 
all concerned or involved. 
• Effective analysis: With the help of flowchart, problem can be analysed in more 
effective way therefore reducing cost and wastage of time. 
• Proper documentation: Program flowcharts serve as a good program documentation, 
which is needed for various purposes, making things more efficient. 
• Efficient Coding: The flowcharts act as a guide or blueprint during the systems 
analysis and program development phase. 
• Proper Debugging: The flowchart helps in debugging process. 
• Efficient Program Maintenance: The maintenance of operating program becomes easy 
with the help of flowchart. It helps the programmer to put efforts more efficiently on 
that part 

 

Disadvantages Of Using FLOWCHARTS: 
• Complex logic: Sometimes, the program logic is quite complicated. In that case, 
flowchart becomes complex and clumsy. This will become a pain for the user, resulting 
in a waste of time and money trying to correct the problem 
• Alterations and Modifications: If alterations are required the flowchart may require 
re-drawing completely. This will usually waste valuable time. 
• Reproduction: As the flowchart symbols cannot be typed, reproduction of flowchart 
becomes a problem. 

EXAMPLE OF FLOW CHART: 



 

Flow Chart Example 1 

We will now draw a flow chart for having a bath.  

We start by thinking about the steps involved: 
(1) Fill the bath with water 
(2) Get undressed. 
(3) Get into bath. 
(4) Wash. 
(5) Get out of bath. 
(6) Empty the bath water. 
(7) Get dressed.  

Now we need to draw the chart with instruction 
boxes. 
There are no decisions on this chart - the steps all 
follow 
on from one another. Remember the Start and End 
boxes.  

The final chart is shown on the right. Of course some 
people might do some of these steps in a different 
order, 
but hopefully they get undressed before getting in the 
bath!  

 



 

Flow Chart Example 2 

The step Fill the bath with water in the previous 
example 
could have been more detailed. For example, you need 
to 
check if there is enough water and whether it is at the 
right 
temperature while running the bath. 

Again we need to think about the steps involved: 
(1) Turn on the hot and cold taps. 
(2) Is it too hot or cold? If it is, go to step 3, otherwise 
go to step 4. 
(3) Adjust the hot and cold taps and go back to step 2. 
(4) Wait for 2 minutes. 
(5) Is the bath full? If it is, go to step 7, otherwise go to 
step 6. 
(6) Go back to step 4. 
(7) Turn off the hot and cold taps.  

Now we need to draw the chart. This time we need to 
use decision boxes for steps 2 (where the temperature 
of the 
water is checked) and 5 (where it is checked if the bath 
is full).  

The final chart is shown on the right.  

 

 
 
DOS 

MS-DOS (pronounced "em ess doss") stands for Microsoft disk operating system, the 

most widely-used operating system for IBM PC and compatible computers (an operating 

system is the master control software program that runs the computer itself). This means 

that MS-DOS is the most widely used computer operating system, period, since there 

are something like 80 to 100 million PCs in the world, and most of them use MS-DOS. 

There are at least two other versions of DOS that are compatible with MS-DOS 

(meaning they work the same way and run the same programs). So please see the 

definition for DOS for the whole story.  

http://ecomputernotes.com/fundamental/disk-operating-system/what-is-operating-system
http://ecomputernotes.com/fundamental/introduction-to-computer/personal-computer
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http://ecomputernotes.com/fundamental/introduction-to-computer/what-is-computer


 

The history of MS-DOS is a fascinating study in how business success often depends 

more on good timing, a nose for a good deal, and aggressive marketing, than on the 

technical merits of your product. When IBM first developed the IBM PC, it wanted to 

license a crude operating system called CP/M, which was the dominant one for 

personal computers at the time (ever hear of a Kaypro or an Osborne?) Apparently 

IBM'S offer was too low for the makers of CP/M, so IBM went shopping at Microsoft. 

Microsoft didn't have a suitable product at the time, but the boss, Bill Gates could smell 

money. He bought out a little company that was making an imitation version of CP/M, 

and rushed out a revision that worked on IBM'S machine. When the IBM PC caught on, 

Bill got really rich-even though MS-DOS is really not so hot.  

Guy Kawasaki says that MS-DOS stands for Microsoft Seeks Domination of Society. 

 

WHAT IS DOS? 
Dos is a disk operating system with a set of programs that act as a translator between 
the user  
 
and the computer in order to perform the task of the user. Ms-Dos is a popular 
operating system  
 
on Micro-Computers. 

Dos commands are of two types:  

Internal Commands: 
Cls : This command is used to clear the screen. 
 
Ver : This helps us to know the later version of dos. 
 
Vol : This command shows the label of the current drive & and its serial number. 
 
Date : This command display the current date. Also called as the system date. 
 
Time : This command display the current time and also the message to enter the new 
time. 
 
Dir : This command display the list of files and directory in the mentioned directory or 
drive. 
 



 
Dir/P : This command show all the files pagewise. Once the screen is full of filename a 
message saying “press any key to continue” is displayed, he user can take his/ her own 
time o view the files & its details. 
 
Dir/w : This command is used to display the content of disk i.e files width wise i.e:- five 
filenames perline. 
 
Wild Characters : There are 2 wild characters. 
 
?: denoted any one single characters. 
 
* : denotes any no of characters. 

Type : This command is used to see the content of a specific file on the screen. 
 
Rename or Ren : This command is used to change the filename. 
 
Del (Deleting) : This command is used to erase the file from the disk. 
 
Copy : This commands is used to duplicate the content of one file in to another file. 
 
Directories : A directories is a separate area on the disk to store some files. 
 
Md<directory name> 
 
Rd<removing directory> 
 
Edit : is a Dos Editor. It is an internal command. 

External Commands : 
 
External commands are ones which requires certain special Dos files for their execution. 
 
Tree : This command display path and optionally list the content of each directory and 
sub directory  
 
on the specified drive. 
 
Sort : The sort filter reads input ,sorts the data and then writes the sorted data screen or 
to a file  
 
or another device. 
 



 
Find : Locates all the lines which contain a specific string of text in a file or files. 
 
Print : This command used to print to content of the files. 
 
Chkdsk: This command is used to display the report regarding the status of the disk. 
 
Diskcopy: This command is used to copy the content of one disk to another. 
 
Attrib : Each and every file has some attributes stored for it. 
 
Backup: The hardisk can sometimes suffer a head crash. In such occasion all data on the 
disk is 
 
lost and irrecoverable. 
 
Format : To make a floppy or hardisk capable of storage. 
 
Deltree: It is used to delete all files or directories from the drive or directory from drive 
or directory. 

Types of Operating Systems 

Following are some of the most widely used types of Operating system. 

1. Simple Batch System 

2. Multiprogramming Batch System 

3. Multiprocessor System 

4. Distributed Operating System 

5. Realtime Operating System 

 

SIMPLE BATCH SYSTEMS 

 In this type of system, there is no direct interaction between user and the computer. 

 The user has to submit a job (written on cards or tape) to a computer operator. 

 Then computer operator places a batch of several jobs on an input device. 

 Jobs are batched together by type of languages and requirement. 

 Then a special program, the monitor, manages the execution of each program in the 

batch. 

 The monitor is always in the main memory and available for execution. 



 

Following are some disadvantages of this type of system : 

1. Zero interaction between user and computer. 

2. No mechanism to prioritize processes. 

 

MULTIPROGRAMMING BATCH SYSTEMS 

 In this the operating system, picks and begins to execute one job from memory. 

 Once this job needs an I/O operation operating system switches to another job 

(CPU and OS always busy). 

 Jobs in the memory are always less than the number of jobs on disk(Job Pool). 

 If several jobs are ready to run at the same time, then system chooses which one to 

run (CPU Scheduling). 

 In Non-multiprogrammed system, there are moments when CPU sits idle and does 

not do any work. 

 In Multiprogramming system, CPU will never be idle and keeps on processing. 

Time-Sharing Systems are very similar to Multiprogramming batch systems. In fact 

time sharing systems are an extension of multiprogramming systems. 

In time sharing systems the prime focus is on minimizing the response time, while in 

multiprogramming the prime focus is to maximize the CPU usage. 

 

MULTIPROCESSOR SYSTEMS 

A multiprocessor system consists of several processors that share a common physical 

memory. Multiprocessor system provides higher computing power and speed. In 

multiprocessor system all processors operate under single operating system. 

Multiplicity of the processors and how they do act together are transparent to the 

others. 

Following are some advantages of this type of system. 



 

1. Enhanced performance 

2. Execution of several tasks by different processors concurrently, increases the 

system&apos;s throughput without speeding up the execution of a single task. 

3. If possible, system divides task into many subtasks and then these subtasks can be 

executed in parallel in different processors. Thereby speeding up the execution of 

single tasks. 

 

DISTRIBUTED OPERATING SYSTEMS 

The motivation behind developing distributed operating systems is the availability of 

powerful and inexpensive microprocessors and advances in communication 

technology. 

These advancements in technology have made it possible to design and develop 

distributed systems comprising of many computers that are inter connected by 

communication networks. The main benefit of distributed systems is its low 

price/performance ratio. 

Following are some advantages of this type of system. 

1. As there are multiple systems involved, user at one site can utilize the resources of 

systems at other sites for resource-intensive tasks. 

2. Fast processing. 

3. Less load on the Host Machine. 

 

REAL-TIME OPERATING SYSTEM 

It is defined as an operating system known to give maximum time for each of the 

critical operations that it performs, like OS calls and interrupt handling. 



 

The Real-Time Operating system which guarantees the maximum time for critical 

operations and complete them on time are referred to as Hard Real-Time Operating 

Systems.  

While the real-time operating systems that can only guarantee a maximum of the time, 

i.e. the critical task will get priority over other tasks, but no assurity of completeing it in 

a defined time. These systems are referred to as Soft Real-Time Operating Systems. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

Microsoft Windows 

Windows is an operating system designed by Microsoft. The operating system is 

what allows you to use a computer. Windows comes preloaded on most new 

personal computers (PCs), which helps to make it the most popular operating 

system in the world. 

Windows makes it possible to complete all kinds of everyday tasks on your 

computer—for example, you can use Windows to browse the Internet, check your 

email, edit digital photos, listen to music, play games, and do much more. 

 

Windows is also used in many offices because it gives you access to productivity 

tools such as calendars, word processors, and spreadsheets. 

 



 
 

Microsoft released the first version of Windows in the mid-1980s. There have been many 

versions of Windows since then, but the most recent ones include Windows 10 (released in 

2015), Windows 8 (2012), Windows 7 (2009),Windows Vista (2007), and Windows XP (2001). 

 

 

Introduction to MS Windows  

MS Windows is an operating system that lets you use different types of 

applications or software. For example, it allows you to use a word processing 

application to write a letter and a spreadsheet application to track your financial 

information. 

MS Windows is a graphical user interface (GUI). It has pictures (graphical) that 

you use (user) to communicate (interface) with the computer. This type of system 

is popular because it's logical, fun, and easy to use. 

This operating system has multi-tasking capabilities, meaning it can run several 

applications at the same time. Multi-tasking allows you to view this lesson on the 

Internet at the same time you practice using other applications with MS 

Windows. 

Windows XP desktop 

Windows XP uses a desktop for the standard interface. Think of the desktop as a 

workspace where you can access everything you need to operate your computer, 

such as system components, applications, and the Internet. 

The desktop contains: 

 Start button: This is one of the most important tools you will use while working 

with Windows XP. The Start button allows you to open menus and start 

applications. 



 

 Taskbar: This is primarily used to switch between open windows and 

applications. Learn more about using the taskbar in a later lesson. 

 Icons (or graphical pictures): This represent applications, files, and other parts of 

the operating system. By default, Windows XP provides you with one desktop 

icon, the Recycle Bin. Learn more about the Recycle Bin in a later lesson. 

 

The Start menu 

To begin exploring Windows XP, click the Start button. 

 

When you click the Start button, the Start menu appears. The Start menu is your gateway to 

the applications on your computer. The left side of the Start menu lists programs, while the 

right side allows access to common Windows folders (My Documents, for example). It also 

provides access to Help and Support, Search, and Run. 



 

 

If you select All Programs, a pop-up menu appears. Pop-up menus like this are 

called cascading menus. If a cascading menu is available, a small black 

triangle appears next to the name of the application or function. 

In the example below, the Word program has been selected. 

 



 

To explore the Start menu: 

1. Click the Start button. 

2. Move the mouse pointer to each option, and view the various cascading menus. 

3. Click (or roll your mouse pointer over) All Programs. 

4. Move the mouse pointer to the right, and view other cascading menus. 

5. To exit the menus, click outside the menu area or press Esc on your keyboard. 

The Start menu remembers items you've recently opened and places each icon on the Start 

menu so you can easily open them the next time you open the Start menu. For example, if you 

recently opened Microsoft Word using Start All Programs Microsoft Word, the next time 

you open the Start menu simply click the Word icon on the left side of the Start menu. 

 

 

Understanding icons 

The small pictures on the desktop are called icons. One type of icon is an object icon. Examples 

of object icons are My Computer, Recycle Bin, and Internet Explorer. These icons allow you to 

open files and programs on your computer. 

 

Shortcut icons allow you to open applications quickly. These icons appear on your desktop and 

with little arrows in the left corner. Desktop shortcuts are links to files and programs. You can 

add or delete shortcuts without affecting the programs on your computer. You'll learn about 

creating shortcuts in a later lesson. 

 



 

To open a program using an icon: 

1. Place your mouse over the icon. 

2. Text appears identifying its name or contents. 

3. Double-click the icon. 

Understanding the taskbar 

The taskbar is the small blue bar you see at the bottom of your desktop. It contains the Start 

menu and the Quick Launch bar, which contains icons for Internet Explorer, Windows Media 

Player, and Show Desktop. Click an icon to open a program. Click Show Desktop to quickly 

view your desktop without closing any programs or windows. 

 

The box on the right is called the Notification Area. Here, you'll find the clock and several other 

icons, depending on what you have installed on your computer. Other icons appear in the 

Notification Area detailing the status of your activity. For example, when you're printing a 

document, a printer icon appears. Microsoft also uses the Notification Area to remind you 

when software updates are available for download. 

 

When you open or minimize a window or program, a rectangular button appears on the 

taskbar that shows the name of the application. These buttons disappear when you close a 

window. 

Log off and switch users 

More than one person can use your computer. For example, many family 

members might use the same computer at home, while several coworkers may be 

able to access your computer on a computer network. Windows XP allows 

everyone who uses your computer to have separate computer accounts. A 

computer account tracks each person's unique settings, documents, and email 

accounts. 



 

Windows XP even enables you to log off the computer so someone else can log in 

without having to restart the computer. 

To log off or switch users: 

1. Click the Start menu, then click Log Off. 

2. A dialog box appears asking you if you want to Switch User or Log Off. 

3. Switch User allows someone else to log on to the computer. If you choose to 

Switch User, your applications will continue to run in the background while the 

new user logs on. 

4. If you choose Log Off, your applications will close. 

5. In either case, you're taken to a Windows XP log on screen, where you're 

prompted to enter your username and password. 

 

Turn off and restart your computer 

When you've finished using Windows XP, be sure to turn off (or shut down) the 

computer correctly. 

To turn off the computer: 

1. Click the Start menu. 

2. Click Turn Off Computer. 

3. A dialog box opens. Click Turn Off. 



 

 

If you're experiencing computer problems or have installed something new, you 

can simply restart your computer. 

To restart the computer: 

1. Click the Start menu. 

2. Click Turn Off Computer. 

3. A dialog box opens. Click Restart. 

 

Recycle Bin 
When you delete a file, it is moved to the Recycle Bin. This allows you to recover the 
file if you change your mind. To permanently delete the file, you will need to empty the 

Recycle Bin. 

 
 

Desktop background 
The desktop background, or wallpaper, allows you to personalize your computer. You 
can choose a built-in background or use one of your own images 
 
 

Date & Time and Settings 
On the right side of the taskbar, you will see the date and time. There will also be 
shortcuts to different settings, like Internet settings andsound volume. 
 

 

 



 

File Basics 

What is a file? 

There are many different types of files you can use. For example, Microsoft Word 

documents, digital photos, digital music, and digital videos are all types of files. 

You might even think of a file as a digital version of a real-world thing you can 

interact with on your computer. When you use different applications, you'll often 

be viewing, creating, orediting files. 

Files are usually represented by an icon. In the image below, you can see a few 

different types of files below the Recycle Bin on the desktop. 

 

What is a folder? 

Windows uses folders to help you organize files. You can put 

files inside a folder, just like you would put documents inside a real folder. In the 

image below, you can see some folders on the desktop. 

 



 

 

Windows Explorer 

You can view and organize files and folders using a built-in application known 

as Windows Explorer  

To open Windows Explorer, click the Windows Explorer icon on the taskbar, or double-click 

any folder on your desktop. A new Windows Explorer window will appear. Now you're ready 

to start working with your files and folders. 

 

From Windows Explorer, double-click a folder to open it. You can then see all of the 

files stored in that folder. 



 

 

Notice that you can also see the location of a folder in the address bar near the top of the 

window. 

 

To open a file: 

There are two main ways to open a file: 

 Find the file on your computer, and double-click it. This will open the file in 

its default application. In our example, we'll open a Microsoft Word document 

(Chicago Trip Details.docx), which will open inMicrosoft Word. 



 

 

 Open the application, then use the application to open the file. Once the 

application is open, you can go to the File menu at the top of the window and 

select Open. 

 

Moving and deleting files 

As you begin using your computer, you will start to collect more and more files, 

which can make it more difficult to find the files you need. Fortunately, Windows 

allows you to move files to different folders and delete files you longer use. 



 

To move a file: 

It's easy to move a file from one location to another. For example, you might have 

a file on the desktop that you want to move to your Documents folder. 

1. Click and drag the file to the desired location. 

 

Release the mouse. The file will appear in the new location. In this example, we have opened 

the folder to see the file in its new location.  

 

You can use this same technique to move an entire folder. Note that moving a folder will also 

move all of the files within that folder. 

 

 



 

To create a new folder: 

1. Within Windows Explorer, locate and select the New folder button. 

 

2. The new folder will appear. Type the desired name for the folder and press Enter. 

In our example, we'll call itSchool Documents. 

 

3. The new folder will be created. You can now move files into this folder. 

To rename a file or folder: 

You can change the name of any file or folder. A unique name will make it easier 

to remember what type of information is saved in the file or folder. 

1. Click the file or folder, wait about one second, and click again. An editable text 

field will appear. 



 

2. Type the desired name on your keyboard and press Enter. The name will be 

changed. 

 

Alternatively, you can right-click it and select Rename from the menu that 

appears. 

 

To delete a file or folder: 

If you no longer need to use a file, you can delete it. When you delete a file, it is 

moved to the Recycle Bin. If you change your mind, you can move the file from 

the Recycle Bin back to its original location. If you're sure you want to 

permanently delete the file, you will need to empty the Recycle Bin. 



 

1. Click and drag the file to the Recycle Bin icon on the desktop. Alternatively, you 

can click the file to select it and press the Delete key on your keyboard. 

 

2. To permanently delete the file, right-click the Recycle Bin icon and select Empty 

Recycle Bin. All files in the Recycle Bin will be permanently deleted. 

 

Note that deleting a folder will also delete all of the files within that folder. 

Selecting multiple files 

Now that you know the basics, here are a few tips to help you move your files 

even faster. 

Select more than one file 

There are a few different ways to select more than one file at a time: 



 

 If you're viewing your files as icons, you can click and drag the mouse to draw a 

box around the files you want to select. When you're done, release the mouse; the 

files will be selected. You can now move, copy, or delete all of these files at the 

same time. 

 

 To select specific files from a folder, press and hold the Control key on your 

keyboard, then click the files you want to select. 

 

 To select a group of files from a folder, click the first file, press and hold 

the Shift key on your keyboard, then click the last file. All of the files between the 

first and last ones will be selected. 



 

 

Select all 

If you want to select all files in a folder at the same time, open the folder in 

Windows Explorer and press Ctrl+A(press and hold the Control key on your 

keyboard and then press A). All of the files in the folder will be selected. 

 

 

Shortcuts 

If you have a file or folder you use frequently, you can save time by creating 

a shortcut on the desktop. Instead of navigating to the file or folder each time you 



 

want to use it, you can simply double-click the shortcut to open it. A shortcut will 

have a small arrow in the lower-left corner of the icon. 

Note that creating a shortcut does not create a duplicate copy of the folder—it's 

simply a way to access it more quickly. If you delete a shortcut, it will not delete 

the actual folder or the files it contains. Also note that copying a shortcut onto a 

flash drive will not work; if you want to bring a file with you, you'll need to 

navigate to the actual location of the file and copy it to the flash drive. 

To create a shortcut: 

1. Locate and right-click the desired folder, then select Send to Desktop (create 

shortcut). 

 

2. A shortcut to the folder will appear on the desktop. Notice the arrow in the 

lower-left corner of the icon. You can now double-click the shortcut to open the 

folder at any time. 



 

 

Alternatively, you can hold the Alt key on your keyboard and then click and 

drag the folder to the desktop to create a shortcut. 

Cut, copy, and paste 

Many applications allow you to copy items from one place and then paste them 

to another. For example, if you're working with a word processor, you might 

copy and paste text to avoid typing the same thing over and over. If there's 

something you want to move from one place to another, you can cut and 

paste instead. 

To copy and paste: 

1. Select the item you want to copy. In our example, we'll select a word in a 

document. 

2. Right-click the mouse and select Copy from the menu that appears. Alternatively, 

you can press Ctrl+C on your keyboard. 



 

 

3. Locate and right-click the desired location for the item, then select Paste. 

Alternatively, you can press Ctrl+Von your keyboard. 

 

4. The item will be copied to the new location. Notice how the original text that was 

copied has not been moved or changed. 

 

To cut and paste: 

1. Select the item you want to cut. In our example, we'll select a paragraph of text in 

a document. 



 

2. Right-click the mouse and select Cut from the menu that appears. Alternatively, 

you can press Ctrl+X on your keyboard. 

 

3. Locate and right-click the desired location for the item, then select Paste. 

Alternatively, you can press Ctrl+Von your keyboard. 

 

4. The item will be pasted, or moved, to the new location. In our example, we used 

the cut and paste commands to move the second paragraph above the first 

paragraph. 



 

 

To copy and paste files: 

You can use the cut, copy, and paste commands for a variety of tasks on your 

computer. For example, if you wanted to create a duplicate copy of a file, you 

could copy it from one folder to another. 

1. Right-click the file and select Copy from the menu that appears. Alternatively, 

you can press Ctrl+C on your keyboard. 

 



 

2. Locate and right-click the new location, then select Paste. Alternatively, you can 

press Ctrl+V on your keyboard. In our example, we'll paste the file to 

the desktop. 

 

3. The duplicate file will appear. Notice how the original file has not been moved or 

changed. Note that if you make a change to the original file, it will not update any 

copies of that file.  

 

Adjusting your settings 

At some point, you may want to adjust your computer's settings. For example, 

you might want to change yourdesktop background or modify 

your Internet settings. You can change many different settings from the Control 

Panel. 



 

To open the Control Panel (Windows 7 and earlier): 

1. Click the Start button, then select Control Panel. 

 

2. The Control Panel will appear. Simply click a setting to adjust it. In this example, 

we'll click Change desktop background to choose a new wallpaper for our 

desktop. 

 

 

What are keyboard shortcuts? 

Keyboard shortcuts are keys or a combination of keys you can press on your 

keyboard to perform a variety of tasks. Using keyboard shortcuts is often faster 

than using a mouse because you can keep both hands on the keyboard. Keyboard 



 

shortcuts are also universal, which means you can use many of the same 

shortcuts in a variety of applications. For example, you can use the shortcuts to 

copy and paste text in a word processor and in a web browser. 

Using shortcuts 

Many keyboard shortcuts require you to press two or more keys in a specific 

order. For example, to perform the shortcut Ctrl+X, you would press and hold 

the Ctrl key, then press the X key, then release. 

 

You'll use the Ctrl (Control) or Alt key to perform most keyboard shortcuts. 

You'll find these keys near the bottom-left corner of your keyboard. 

 

Working with text 

These keyboard shortcuts are useful when working with text in word processors, 

email applications, and more. They can help you perform commonly repeated 

tasks, such as copying and pasting text. 

 Ctrl+X: Cut the selected text. 

 Ctrl+C: Copy the selected text. 

 Ctrl+V: Paste the copied or cut text. 

 Ctrl+A: Select all of the text on the page or in the active window. 



 

 

 Ctrl+B: Bold the selected text. 

 Ctrl+I: Italicize the selected text. 

 Ctrl+U: Underline the selected text. 

 Working with files and applications 

You can use keyboard shortcuts to open, close, and switch applications. When 

working with a file, such as a Microsoft Word document, shortcuts can be used 

to create new files, find words, and print. 

 Ctrl+Alt+Delete: Force an unresponsive or frozen program to quit. This 

keyboard shortcut opens the Task Manager. You can then select the unresponsive 

application and close it. 

 

 Delete: Send a selected file or files to the Recycle Bin. 

 Enter: Open a selected application or file. 



 

 Ctrl+N: Create a new file. 

 Ctrl+O: Open an existing file. 

 Ctrl+S: Save the current file. 

 Ctrl+Z: Undo the previous action. If you want to redo the action, press Ctrl+Y. 

 Windows key: Open the Start menu (or the Start screen in Windows 8). 

 

Internet shortcuts 

Keyboard shortcuts can also be used to navigate your web browser. Many of 

the text shortcuts above are also useful online, such as the shortcuts 

for selecting, copying, and pasting text into your web browser's address bar. 

Note that some of these shortcuts may work a bit differently depending on the 

web browser you're using. 

 Ctrl+N: Open a new browser window. 

 Ctrl+T: Open a new browser tab. 

 

 Ctrl+D: Bookmark the current page. 

 Ctrl+B: View bookmarks. 

 Ctrl+J: View recently downloaded files. 

 



 

Using the Alt key to navigate menus 

When you press the Alt key, you will have access to all of the menus in the 

current application. This means you can perform almost any task with just your 

keyboard. For example, you can type Alt+F+X to quit an application. When 

performing these shortcuts, you will not need to hold down the Alt key. 

 

How to find more keyboard shortcuts 

In many applications, you'll find keyboard shortcuts next to menu items. In some 

applications, you may need to hover over a button to display its keyboard 

shortcut. 

 

 
  



 

Microsoft Word 
 
Microsoft Word is part of the Microsoft Office. Its main function is for producing 
documents that can includes text, graphics, table, clip art, etc. 
 
To start Word using the Windows Start menu 

 Startbutton, point toPrograms, following by Microsoft Office and click 

on Microsoft Office Word 2003. 

 

Note: For Office previous version of Office - Click on theStart button, point toPrograms and 

click on Microsoft Word. 

 

 

u will see the screen shown below. In the right hand side of the screen, the 

Getting Started task pane provides help to you. 

 
 

 Close icon to close it. 

features including the Menu bar, Standard 

toolbar, Formatting toolbar, etc. 

 



 

 
 
To insert text into a document 

example, you can type the following text into it accordingly.My name is John Smith. Today I just 

learn how to type using MS Word.  

 

To save a file 
 File menu, click Save. 

 
 



 
 Save in drop down menu, select the location where you want to save the file or to 

the different folder by clicking on it. 

 File name box, type in the file name that you would like to give (e.g. File1). 

 Save button. 

 

 

To close a document 
 File menu, select Close. 

To exit Microsoft Word 
 Close icon displayed on the top-right corner of the Word screen. 

Opening a file in Microsoft Word 2003 
To open a file 

 File menu, click Open. 

 
 

 Open dialog box as displayed, use the Look in: drop down menu to select the drive 

or folder that contains the file you want. 

 open the file you can either double-click on the file name 

OR select the file name by clicking on it, and then click on the Open button. 



 
 
Moving through a Word document 
 
Using the Keyboard Arrow keys 
Place the insertion point anywhere in your document. Use the keyboard arrow keys to move 

up, down, left and right throughout the document. 

 

Using the Keyboard Page Up / Page Down keys 
If you press the keyboard Page Up or Page Down keys you will move through your document 

by approximately one screen per press. 

 

Using the Scroll Button 
If you click once on the down or up arrows at the top or bottom of the scroll bar you will scroll 

through your document one line at a time. 

 

Using the Scroll Bar 
Click on the scroll bar within the vertical scroll bar. As you drag it up and down, you will see 

page number displayed. When you release the mouse button, you will go to the page number 

indicated within the yellow colored pop-up. 

 
 
Microsoft Word 2003 Toolbars 
 
To display additional toolbars 

 View menu, point to Toolbars. 

 Toolbars sub-menu, click on the required toolbar name. The toolbars that are 

already displayed on the screen are checked (ticked). 



 
To turn a fixed toolbar to a floating toolbar 

the particular toolbar you wish to move until you see 

the 'cross' symbol appear. 

 
 

 the toolbar. 

To re-attach a floating toolbar 
 Title Bar of the particular floating toolbar you wish to re-

attach and double-click with the mouse button. 

Microsoft Word 2003 Selection Techniques 
 
Important: Before you can apply any formatting to the text, you need to select 
(highlight) the text first. It can be a word, a line, a paragraph or entire Word document. 
To select a word 

-click on the word. 

To select a line 

to select, until the mouse pointer changes from an I-bean 

to an arrow pointing upwards and to the right. Click once 

with the mouse button.  

 

 

 

 

 

 

 

To select a paragraph 
 

pointer changes from an I-bean to an arrow pointing upwards and to the right. Double-click 

with the left mouse button. 

To select the entire document 
 Edit menu, choose Select All. 



 
 

Deleting Text in Microsoft Word 2003 
 
If you wish a particular text to be disappear from your Microsoft Word 2003 document, 
then you can use the delete function. 
To delete a character 

to the left of the character to be deleted and press Delete key on 

your keyboard. 

To delete a word 
-click on it and press the keyboard Delete key.  

To delete a line or lines 
(as describe in the Selection Techniques section above) 

 Delete key. 

To delete a block of text 

with the left mouse button depressed. 

t is selected press the Delete key. 

To delete the entire document 
 

 Delete key. 
To copy text, graphic, or other items to the Clipboard 

ish to copy to the Clipboard. 

 Edit menu, click Copy. 

Note: The item here can be highlight text, select a graphic, etc. 

 

To copy multiple items to the Clipboard 
 items, simply select each item and copy it to the Clipboard. 

Note: Microsoft Office 2003 allows you to copy 24 items to the clipboard at once. 

 

To cut selected items from a document 
 items that you want to cut. 

 Edit menu, click Cut. 

 



 
To paste data from the Clipboard 

wish to Cut or Copy. 

 Cut or Copy command to place the data in the clipboard. 

indeed in a different document, or even a different Windows program). 

m the Edit menu, click Paste. 

 

 

To paste multiple items from the Clipboard 
 

 Clipboard toolbar is not displayed, then you can display it by clicking on View menu, 

point to Toolbars and click on Clipboard. 

Icons on this toolbar include Copy, Paste All and Clear Clipboard. 

 simply click on the appropriate icon on the Clipboardtoolbar. 

To paste multiple items, just click on the multiple icons located on theClipboard toolbar. 

Formatting Toolbar and Text Formatting in Word 2003 
 
The formatting toolbar is a toolbar that contains icons on it as shown below. Each of the 
icons has a specific purpose that can change the outlook of your document text when 
you apply to it. 

 
 
The formatting toolbar is designed to apply many effects of text. Here is the list of icons 
and it function: 

Icon Function 

Style Menu 
Allows you to define a group of paragraph and character formats as a 

style, and then the styles in a style sheet. 

Font Menu 

Click the arrowhead to the right of the font name box to view the list 

of fonts available. Scroll down to the font you want and click once to 

select it. 

Font Size 
Click on the white part of the font size box to enter a value for the 

font size or click the arrowhead to the right of the box to view a list 

of font sizesavailable. Select a size by clicking on it once. A font size 



 

of 10 or 12 is best for paragraphs of text. 

Font Style Use these buttons to bold, italic and underline the selected text. 

Alignment 
Text can be aligned to the left, center, or right side of the page or it 

can be justified and distributed across the page. 

Line Spacing 
Allows you to set the amount of space between one line to another 

line. 

Numbering and Bullets 
It is used to set-off and emphasize sections of text and are presented 

by dots or numbers. 

Increase/DecreaseIndent 
Change the indentation of a paragraph in relation to the side of the 

page. 

Outside Border Add a border around selected text. 

Highlight 

Use this option to change the color behind a selected text. The color 

shown on the button is the last color used. To select a different color, 

click thearrowhead next to the button. 

Font Color 

This option changes the color of the text. The color shown on the 

button is the last color chosen. Click the arrowhead next to the button 

to select another color. 

 

 

 

To change the font used by selected text 

document from the single character, a word, a sentence, a paragraph, or the entire document. 

 Format menu, click Font. 

 

 



 

 
 

 Font dialog box, change from the following options: 

 

Text font Specifies the overall look of the character set. 

Font Style Determines the emphasis given to a character, i.e. Bold or Italic. 

Size 
Determines the size of the character in points. The higher the points, the 

larger the character will be. 

Font Color Determines the color of the text as it appears on the screen. 

Underline style 
Determines whether you have None, Single, Double, or Word Only 

underlining etc. 

Underline Color 
Determines the underline color of the text appears on the screen. 

Only available after you choose the underline style. 

Strikethrough A strikethrough line is drawn through selected characters. 

Double 

Strikethrough 
Two strikethrough lines are drawn through selected characters. 



 

Superscript Text is raised above its normal position on the text line. 

Subscript Text is lowered below its normal position on the text line. 

Shadow Adds a shadow behind the text. 

Outline Displays the inner and outer borders of each character. 

Emboss Text appears to be raised off the page in relief. 

Engrave Text appears to be printed or pressed into the page. 

Small caps Text is formatted in capital letters (smaller size). 

All caps Text is formatted in capital letters (normal size). 

Hidden Characters are hidden on the page. 

Preview The effect of the font is displayed before you apply it. 

 OK button or press Enter. 

To highlight pre-selected text 
 

 Highlight icon on the Formatting toolbar and the selected text will be displayed 

with a yellow box around it. 

 

To remove highlighting from text 
xt that the highlighting is to be removed from. 

 Highlight icon on the Formatting toolbar. 

 

To change the color used for highlighting 
Click on the down arrow to the right of the Highlight icon on the Formatting toolbar. 

This will display a range of colors that you can select from. Once you have selected an 
alternative this will become the default highlight color, until you select a different color. 
Using Bullet and Numbering 
 
What is the bullet and numbering feature in Word? 
Bullets are used to set-off and emphasize sections of text and are symbols such as dots or 

diamonds. 



 
The numberingfeature also acts like the bullets only that it use the number instead 
of symbol to represent. 
Why bullet and numbering is so critical to your document? 

Break the long sentence into points form. 

 readability and credibility. 

 

Then, here I let you know how to apply bullet or numbering in Microsoft Word.  
 
To apply default bullet formatting to a list 

 the list you wish to apply number of bullet formatting to. 

 Bullets icon on the Formatting toolbar. 

 

To apply alternate bullet formatting to a list 
ullets to. 

 Format menu, click Bullets and Numbering. 

 Bullets and Numbering dialog box displayed, the Bulletedtab should be 

displayed, if not, select it. 

 
 

like. 



 
 OK button or press Enter.  

 

To remove bullet formatting from a list 
 the list to which the bullet formatting has been applied. 

 Bullets icon on the Formatting toolbar. 

 

To add numbering to a list 
text you wish to re-format as a numbered list. 

 Numbering icon on the Formatting toolbar. 

 

To add alternative numbering styles to a list 
-format as a numbered list. 

 Format menu, click Bullets and Numbering. 

 Bullets and Numbering dialog box displayed, click on theNumbered tab. 

 

 OK button or press Enter. 

 

To remove numbering from a list 
 the list to which the bullet formatting has been applied. 

 Numbering icon on the Formatting toolbar. 
Microsoft Word Table 
Microsoft Word table feature enables you toorganize items in columns and rows. They 

are easier tomanipulate and readthe data display in table format. 

Inserting table is easy but do you really know how to manipulate it? For example, you 
wish to merge or split table cells, insert, resize and delete row or column…can you do 
it? 
Here is the proper guides for you. 
 
To create a table using the Insert Table icon 

 

 Insert Table icon on the Standard toolbar and drag the mouse over the grid to 

select the number of rows and columns you required. 



 

 
 
Note: You will notice that the maximum number of columns and rows are 4 X 5 Table. 
If you are creating a Microsoft Word table that is more that 4 X 5, just click on the 
existing grid and drag the mouse to the required columns and rows. 
 
To enter text into a Microsoft Word table 

l and start typing text or number to the table. 

 Tab key or mouse click. 

 

To resize column widths and row heights 
 them 

with the mouse. 

 

To select a column or multiple columns 
-bean 

to a small, thick downward pointing arrow. Click to select the column. 

ple columns, just drag the mouse across the columns. 

 

To select a row or multiple rows 

mouse pointer changes from an I-bean to an arrow pointing upwards and to the right. Click 

once to select the row. 

 

 

To select the whole table 
 

 Table menu, point to Select and click on Table.  

 



 
To insert a column or row into the table 

 

 Table menu, point to Insert and select the appropriate options: Columns to the 

Left / Columns to the Right / Row Above / Row Below. 

 

To delete a column or row from the table 
 

 Table menu, point to Delete and select either Columns / Rows. 

 

To delete the entire Microsoft Word table 
 table. 

 Table menu, point to Delete and select Table. 

OR click the Cut icon on the Standard toolbar. 

 

To merge cells in a table 
 

 Table menu, click Merge Cells. 

 

To split cells in a table 
To split cells into two or more cells, select the cells you wish to split. 

 Table menu, click Split Cells. 

 Split Cells dialog box displayed, enter the number of columns or rows you wish to 

split the cell into and then select OK or press Enter. 

 

To split a Microsoft Word table 

contains 5 rows, so place the insertion point on row 3. 

 Table menu, click Split Table. 

will appear in the table, above the current row, to create a separate 
table. 
Drawing Toolbar 
Drawing toolbar can be use to create a drawing that contains many objects, i.e. circles, 
lines, autoshapes, arrows, etc and they can be layered behind each other. 



 

 
To display a drawing toolbar 

 Viewmenu, point toToolbars and clickDrawing. 

OR right-click on an existing toolbar and choose Drawing from the drop down list. 

To create a drawing 
 AutoShapesicon and choose a shape from one of the menus. 

button. 

AutoShapes icon in order 

to get familiar with it. 

Note: You only can draw objects in Microsoft Word when you are inPrint Layout view. 

 

Drawing toolbar icons and functions are listed below: 

 

Draw 
Enables you to apply lots of changes to the drawing object such as flip, 

rotate, text wrapping, etc. 

Select Objects Enables you to select a particular drawing object. 

AutoShapes 

Click on the AutoShapes button to bring up a list of shape 

menus.Drag the mouse on to a selected set of shapes and select one 

from the list. 

Line 
Used to draw a line. To draw perfectly horizontal or vertical line, 

depress the Shift key while dragging. 

Arrow Used to draw a line with an arrowhead on it. 

Rectangle 
Used to draw a rectangle. To draw perfect square, depress the Shift 

key while dragging. 

Oval 
Used to draw an oval. To draw perfect circle, depress the Shift key 

while dragging. 

Text Box Used to draw a text box into which you can enter text. 

Vertical Text Box Used to draw a text box into which you can type a vertical text. 



 

Insert WordArt Used to insert WordArt. 

Insert Diagram or 

Organization Chart 
Used to insert Diagram or Organization Chart. 

Insert Clip Art Used to insert clipart. 

Insert Picture Used to insert pictures from the location that you saved before. 

Fill Color Used to fill a drawing object with a color or shading. 

Line Color Used to define the line color of a drawing object. 

Font Color Used to formats the selected text with the color you pick. 

Line Style Used to define the line style used by an object. 

Dash Style Used to define the dashed line style used by an object. 

Arrow Style Used to define the arrow line style. 

Shadow Style Click the shadow style you want for the selected object. 

3-D Style Click the 3D style you want for the selected object. 

 

To draw lines, arrows, rectangles and ovals 
select on the Drawing toolbar, i.e. click on the Oval icon, to 

draw an oval. 

 

f object you require. 

the mouse button when the object is the desired length or shape. 

 

To create a text box 
 View menu, click Print Layout to ensure you are in this view. 

 Text Box. 



 
 Insert menu, click Text Box.  

OR click on the Text Box icon on the Drawing toolbar. 

-hair pointer using the mouse and depress the left mouse button. Drag the 

mouse until the size you require, then release the mouse button. 

 in the document, and you can now type in text or import a graphic 

into the text box. 

 

To create a WordArt object 
WordArt object. 

 Insert menu, point to Picture and click WordArt 

OR click on the WordArt icon on the Drawing toolbar or WordArttoolbar. 

 WordArt Gallery select a style to use and click on the OKbutton 

OR double-click on the intended style. 

 Edit WordArt Text dialog box displayed, enter the required text in the 'Your Text 

Here' area. 

 OK button to insert the WordArt. Tip: Right clicking on theWordArt will bring 

up a menu with a number of options. A particularly good option is Format WordArt that will 

let you format your WordArt in detail. You also can edit the WordArt using WordArt toolbar. 

 

To insert a clipart 
 Insert Clip Art icon, located on the Drawing toolbar to open the Clip Art side 

pane.  



 

 
 

 Search for: field allows you to enter one or more words pertaining to a specific graphic 

you wish to search for. Once enter, click on Gobutton to begin search. Note: Most of the time, 

this required Internet connection. If you do not have, then… 

 Organize clips… (blue color wordings) 

 Microsoft Clip Organizer window, double-click on the Office Collections. 



 

 
 

-categories such as academic, agriculture, etc. Each category has 

few clip arts on it. 

the right hand side of the picture and selectCopy. 

 
 



 
clip art. Click 

the Paste icon on the Formatting toolbar.  
 
To Create A Professional Resume 
To create a resume using the Wizard 

  From the File menu, click New. 

 the New Document task pane, under Templates section, click On my computer. 

 
 

 Templates dialog box, click the Other Documents tab. 

 
 

-click on the Resume Wizard. This will start the Wizard, clickNext to continue. 



 
screen below: 

 
 

 Next. 

click Next. 

 
 

proceed by clicking Nextbutton. 



 

 
 

se the resume standard headings according to your needs and qualifications. 

Remember, you need to fill up those particulars later as you tick. Click Next. 

 
 

resume such asobjectives, hobbies, etc. 

Click Next to continue. 



 

 
 

 the wizard as needed here. You also can rearrange 

the headings in the page using the Move Up andMove Down buttons. Click Next to continue. 

finish the wizard, click on the Finish button. You can see the resume headings are 
added to your document and you can start entering data to your resume. 
Step-by-step Guides to Document Printing 
Document printing is easy right? Just click on the print icon! 

But before you print, Microsoft Word requires that a printer driver has been installed in 
your computer and matches the printer you are currently using. ON the printer. 
The 3-step below guides you to proper document printing in Microsoft Word: 
Step 1: To Preview a Document 

 

 File menu, click Print Preview. 

 

screen, you will see the Print Preview toolbar. Each of the toolbar icon will 

have their own function as describe below: 

 
 

Print The document is send to the printer. 



 

Magnifier The same as clicking inside the document. It gives a single-level zoom. 

One Page Single-page view. 

Multiple 

Pages 
Allows you to print preview up to six pages at a time on the screen. 

Zoom Control Allows you to control Zoom view percentages. 

View Ruler Allows you to view the ruler showing tabs and measurements. 

Shrink to Fit 
Enables you to fit a document that is just more than one page long into a single 

page. 

Full screen Allows you to change to Full Screen view. 

Close Allows you to leave Print Preview and return to the MS Word screen. 

 

Note: The step 1 of document printing here is to let you see (preview) the document. If you 

satisfied, only proceed to the step 2 otherwise just make the necessary changes. 

Step 2: To Change the Printer Settings 
 File menu, click Print. 

 Print dialog box displayed, you needs to do some settings as describe below: 



 

 
 
Printer: 

Name Select the printer you wish to use from the list of installed printers. 

Properties button Important! Refer below. 

Print to file Will print the document to another file, rather than the printer. 

Page range: 

All Will print all the pages of a document. 

Current 

page 
Will print the current page only. 

Pages 
Allows you to print a single page, a range of pages, or disconnected ranges of 

pages. Enter the value such as 1, 5-9, 18, 25-33. 

Print what: 

Document Will print the document (normally we choose this option). 

Document 

Properties 

Will print summary information about the current document such as file 

size, word count, etc. 

Document Will print the document that show markup. Note: Markupfeatures can 



 

Showingmarkup quickly see who made changes to your document, because Word color 

codes changes by reviewer. 

List ofmarkup Will print the list of markup. 

Styles 
Will print the construction and set up of the styles for the current 

document. 

AutoText entries Will print the AutoText entries for the current document. 

Key assignments Will print the keystroke assignments that are used in Microsoft Word. 

Print: 

All pages in range Will print all of the pages in a specified range. 

Odd pages Will print only the odd pages of a document. 

Even pages Will print only the even pages of a document. 

Copies: 

Number of 

copies 

Enter the number in the box will specify the number of copies that you wish to 

print the document. 

Collate 

Will print an entire copy of a document before the next copy of it begins to print. 

When you select this option, MS Word creates the number of copies specified, and 

then sends all the copies to the printer. Printing takes longer if you choose the 

option. 

Zoom: 

Pages per sheet: 
Will specify the number of pages in a sheet of paper, range from 1 page up to 

16 pages. 

Scale to paper 

size: 
Specify the different types of paper size to be use. 

 

The Properties Button 
Important: You need to click on this button, as it will let you set the printing paper size, paper 

orientation, color or black/white printing, etc. 



 
This is critical, as it will affect the printing output. However, different printer installed 
will have slightly different settings. Click OK when finish and return to the Print dialog 
box. 
Note: The step 2 of document printing is very important as you are required to change 
the printer related settings so that the outputs come out will fulfill your needs. 
Step 3: To Print 

 setup, and print the document click on the OK button. 

 OK button, ensure that you have put the plain papers to the printer tray. 

 Cancel. 
Customizing Microsoft Word Keyboard Shortcut 
Customizing Microsoft Word Keyboard Shortcut keys is easy. 

You can create customized keyboard shortcuts in any document, or any template.  
 
 
When you create a shortcut, you must make sure you’re putting it in the right place: 

 available whenever you’re using Word, create them in 

Normal.dot. Normal.dot is a global template loaded all the time when Word is running. 

e it in that 

template. 

y in a particular document, create it in that document. 

 

To Create a new Microsoft Word Keyboard Shortcut 
 Tool menu, click on the Customize button. 

 Customize dialog box displayed, click on the Keyboardbutton to display 

the Customize Keyboard dialog box.  



 

 
 

 Customize Keyboard dialog box lets you assign a keyboard shortcut to almost any 

command, macro, font, AutoText entry, style, or common symbol. 

 
 



 
 Categories: list box, select the category of item for which you want to create or change 

the keyboard shortcut. The list box to the right of the Categories: list box changes its name to 

match the category you select. 

- Each of the eight menu categories (File, Edit, View, Insert, Format, Tools, Table, and 
Window and Help) lists the commands associated with that menu. The more commonly 
used commands appear on the menus, while the less-used commands don’t appear. For 
example, the FilePrint command appears on the File menu as the Print command, but 
the FileConfirmConversions command doesn’t appear.  
- The Drawing category lists the commands associated with the Drawingtoolbar.  
- The Borders category lists the commands associated with the border buttons on the 
Tables and Borders toolbar.  
- The Mail Merge category lists the commands associated with the Tools > Letters and 
Mailings submenu (in Word 2003 and XP) and with the Mail Merge toolbar.  
- The All Commands category lists all Word commands. Because there are so many 
commands, this list is awkward to use, so you’ll probably want to use it only when you 
can’t remember which menu a command is associated with.  
- The Macros category lists all the macros available in the active document and 
templates.  
- The Fonts category lists the fonts installed on Windows XP.  
- The AutoText category lists the AutoText entries defined in Word.  
- The Styles category lists the styles available in the active document and templates.  
- The Common Symbols category lists frequently used symbols (such as dashes, ® and 
© marks, and paragraph marks).  

 Commands: list box, select the command for which you want to create or change a 

keyboard shortcut. Word displays any existing keyboard shortcut for the command in 

the Current Keys: list box. 

If you wish to assign the keyboard shortcut for a specific command, key in the shortcut in 

the Press new shortcut key: text box. 

Note: If this shortcut is currently assigned to another command, Word displays the Currently 

Assigned To line listing the command, so that you’ll know which existing shortcut you’re about 

to overwrite. Choose a different keyboard shortcut if necessary. 

 Assign button to assign the keyboard shortcut to the command. 

 Close button to close the Customize Keyboard dialog box. 

To Remove and Reset Microsoft Word Keyboard Shortcut 
 Tool menu, click on the Customize button. 

 Customize dialog box displayed, click on the Keyboardbutton to display 

the Customize Keyboard dialog box. 



 
 Save changes in: list box, choose which document or template you want to affect, and 

select the command so that Word displays the current keyboard shortcut. 

 Current keys list box, and then click theRemove button. 

 keyboard shortcuts in the specified document or template to their default 

settings, click the Reset All button. 

Yes button. 
 
Note: The Reset All button isn’t available until the document or template contains 
customized keyboard shortcuts. After removing or resetting Microsoft Word keyboard 
shortcuts, save the document or template. 
Microsoft Word Add-in 
What is an Add-in andMicrosoft Word add-in? 

An add-in is an applicationthat can be installed to give additional functionality for the 
particular program. Add-ins for Word are specific to Word and cannot be used with 
any otherapplication. 
A Word add-in has the file extension (".dot") and is a template that is always loaded 
when Word is open. 
There is a lot of third party Word add-ins available for free download from websites. 
But remember that the more add-ins you have installed, the longer Word will take to 
open. 
Word has several add-ins that come as standard in the following locations: 

Word 2003 - C:-Program Files-Microsoft Office-Office11-Library 

Word 2002 - C:-Program Files-Microsoft Office-Office10-Library 

Word 2000 - C:-Windows-Application Data-Microsoft Addins 

Word 97 - C:-Program Files-Microsoft Office-Office-Library 

Installing a Word Add-in 
 Tools menu, click Templates and Add-ins. 



 

 
 

 Templates and Add-ins dialog box, click on the Attach button will bring out 

the Attach Template dialog box. 

 



 
 

nd click on 

the Open button. This will attach a different template to the active document. 

 Add button will loads a template or installed add-in program that doesn't 

appear in the list. If the template or add-in is listed, select the item's check box to load it. 

 Remove button will removes the selected template or add-in from the list. 

Uninstalling the Add-in 
 Tools menu, click Templates and Add-ins. 

 Templates and Add-ins dialog box, if the add-in you want to uninstall is in the 

list then untick the corresponding check box. 

 OK button to uninstall the add-in. 

Remove the Add-in 
 Tools menu, click Templates and Add-ins. 

 Templates and Add-ins dialog box, clear the check box that you wish to remove 

the particular Add-in. 

  Click the Remove button to remove the add-in. 
 
Note: If you remove a Word Add-in the changes are not saved until you actually close 
Word completely. 
Hyperlink Feature 
You can hyperlink documents together so that when someone read and see the link, 
they can click on a hyperlink and it will take them to a previous document that is 
referred to in the instant document. 
Word hyperlinks feature makes it easy to link to from one document to the other. Also, 
you can prevent readers from changing the hyperlinks. 
To insert Word hyperlinks in a document 

 

 Window menu, click Arrange All. You will see both documents are open in one 

screen. 

will 

appear as a text link in another document later. 

-click and drag the selected text to any place of the new document that you wish to 

insert the hyperlink. You will see something like this: 

 



 

 
 

 the mouse button and select Create Hyperlink Here. 

 word" will appear in new document as a hyperlink. 

 the mouse move to the hyperlink word, press the Ctrl key and then click the hyperlink 

word in your document. 

w: 

 

 
 

 Yes button will bring you to the previous Word document. 

 

 

To prevent from changing Word hyperlinks 
 Tools menu, click Options. 

 



 

 
 

 Options dialog box displayed, click the Edit tab. 

 Editing options section, clear the check mark in the “Use CTRL + Click to follow 

hyperlink” check box. 

 OK.Now, when the reader clicks on the hyperlink, the page will link directly to 
the location of another page. They will have to press Ctrl + link to edit it. 
Envelope Printing Software 
 printing software to help you printing the envelopes effortless in Word (see below). 

However, Microsoft Word Envelopes and Labels feature also can be use to print 
envelopes. Here is the guide: 
To add information to an envelope 

  Open a blank document in Microsoft Office Word. 

 Tools menu, point to Letters and Mailings submenu, and click on Envelopes and 

Labels. 



 
 Envelopes and Labels dialog box displayed, click onEnvelopes tab, and key in 

the Delivery Address and Return Addresscolumn. 

 

 
 

 Options button in the Envelopes and Labels dialog box. This will display 

the Envelope Options dialog box. 

 



 

 
 

 Envelope size: section, choose the size of your envelope. 

can choose the Delivery point bar code option before click on 

the OK button. 

 Envelopes and Labels dialog box, click the Print button will print. 

 

 

To Utilize Free Envelope Printing Software 
Here are two freeware envelope printing software that makes printing envelopes effortless: 

 

1.) Free Envelope Printing Software: Envelope Wizard 

This program will guide you through the steps, necessary for using your computer and 
printer for addressing an envelope. At each step along the way, you be asked to provide 
information for addressing the envelope. You may then proceed to the next step, if you 
find that you have made a mistake in a previous step, you can back up and redo it.  
 
2.) Free Envelope Printing Software: Quick Envelopes 
This free software also easy to use and it covers all most commonly used envelopes.   



 
Header and Footer 
Word Header and Footer allow you to insert information at the top or bottom of every page. 

This information normally consists of chapter headings, page number, etc. 

You can see header and footer information on your screen when in Print Layout View 
and Print Preview, but not in the Normal view. 
To create a header or footer 

 View menu, click Header and Footer. 

 Print Layout view and the Header and Footertoolbar is displayed. 

 Header and Footer text entry boxes appear at the top (header) and bottom 

(footer) of the page. 

 
 

rt the text for the header or footer in the appropriate text entry box. You can just type any 

text that you like. 

 Switch Between Header and 

Footer icon. 

 Header and Footer toolbar icons to insert the page 

number, time, date, etc in the header or footer. The following options are available: 

Icon Function 

Insert AutoText Inserts the default auto text. 

Insert Page Number Inserts page number into the header or footer. 



 

Insert Number of Pages Inserts the total number of the document. 

Format Page Number Format the page number. 

Insert Date Inserts the current date. 

Insert Time Inserts the current time. 

Page Setup Opens the Page Setup dialog box. 

Show/Hide Document 

Text 
Displays or hides document text. 

Same as Previous 
Section header/footers should be the same as the previous section, or 

new. 

Switch Between Header 

and Footer 
Toggle between allowing you to edit the header and footer. 

Show Previous 
Shows the previous section header/footer (only useful where a 

document is made up of multiple sections). 

Show Next 
Shows the next section header/footer (only useful where a document 

is made up of multiple sections). 

 

 

 Closebutton on the Header 

and Footer toolbar. 

 

To move text in the header or footer text entry box 
 View menu, click Header and Footer. 

 press the Tab key on your keyboard to move the 

cursor to the middle or right hand side of the entry box. 

Formatting toolbar to do this. 



 
Paragraph Indent Feature 
 
Paragraph Indent is the amount of horizontal space of the paragraph i.e. offset them to 
the right or left of the body text margin. 
To apply the paragraph indent 

wish to indent. 

rom the Format menu, click Paragraph. 

 
 

 Paragraph dialog box, select the Indents and Spacing tab (if not ready displayed). 

 Indentation section, enter a positive number in the Left: box (try 0.5”) 

 OK. This will offset the entire paragraph to the right.Note: If you enter a positive 

number in the Right: box, this will offset the entire paragraph to the left (from the 

paragraph right hand side) 

Tip: You can apply the negative indent too. Just enter the negative number to the Left: 
or Right: box. 



 
To apply the first line indent 

insertion point in the paragraph you 

wish to indent. 

 Format menu, click Paragraph. 

 Paragraph dialog box, select the Indents and Spacing tab (if not ready displayed). 

 
 

he Indentation section, choose First line from the Special: drop down menu. 

 the range in the By: box, the default is 0.5”. 

To apply the hanging indent 
h you 

wish to indent. 

 Format menu, click Paragraph. 

 Paragraph dialog box, select the Indents and Spacing tab (if not ready displayed). 

 Indentation section, choose Hanging from the Special: drop down menu.You 
can modify the range in the By: box, the default is 0.5”. 
The Word Table of Contents 
A Word table of contents (TOC) is a guide at the beginning of a document/book that 
tells the reader where to find sections within a document. The table of contentslists 
section headings and their corresponding page numbers. 
 
Microsoft Word has a wonderful built-in function to create atable of contents, using 
headings within a document or from an outline. Here we will tell you how to create a 
TOC using heading styles. 
To create a Word Table of Contents 

ished and formatted with heading styles. 

 

 Insert menu, point to Reference and click on Index and Tables. 



 

 
 

m the Index and Tables dialog box displayed, click the Table of Contents tab. 

 General section, choose the pre-defined styles Formats: . 

 displayed in the TOC by modifying the Show 

levels: box. 

er options already pre-selected by default: 

Show page numbers: You can show (or omit) page numbers in the TOC. 

Right align page numbers: Make your page numbers right align in the TOC. 

 

 Tab leader, which controls the appearance of the space between the end 

of the section title and the page number in the TOC. 

 OK. 

To update a Table of Contents 
Update Field from the pop-

up menu. This will display the Update Table of Contents dialog box. 



 

 
 

From the Update Table of Contents dialog box displayed, you can choose to update page 

numbers only or entire table. 

 OK button.  

To delete a Table of Contents 
 

ss the Delete key.  
Word Symbol and Word Special Character 
Word Symbol are character that do not appear on the computer keyboard or difficult to 
type using the normal keyboard.  
 
If you are looking for a special character such as the different country currency sign or 
the copyright or trademark symbols, here we show you how to find it. 
To insert a symbol 

 symbol. 

 Insert menu, click Symbol to open the dialog box. 

 Symbol dialog box displayed, click the Symbol tab. 



 

 
 

 Font: drop-down box, click the font that you want. 

 symbol you want to insert and click the Insert button. 

 Close button. 

To insert a Word special characters 
aracter. 

 Insert menu, click Symbol to open the dialog box. 

 Symbol dialog box displayed, click the Special Characterstab. 



 

 
 

 Insert button. 

 Close button.  
Word Backup – Create backups of Word documents Automatically 
To create automatic backups of Word documents 

 Tools menu, select Options. 

 Options dialog box displayed, click on the Save tab, check the Always create 

backup copy option. 



 

 
Click OK. 
Controlling Word Page Break 
Word Page break is the point at which one page ends and another begins. Microsoft Word 

inserts an "automatic" (or soft) page break for you, or you can force a page break at a specific 

location by inserting a "manual" (or hard) page break. 

For some types ofdocuments you may want to make sure that any given paragraph 
appears all on one page or another. Word includes a formatting feature that allows you 
to ensure that paragraphs stay together without a page break in the middle of them. 
You can control this by setting pagination options. 
To set the page break pagination options 

 

 Format menu, click Paragraph.  



 

 
 

 Paragraph dialog box displayed, make sure the Line and Page Breaks tab is 

selected. 

 

Widow/Orphan control: Control widow and orphan lines. This option is turned on by 
default.  
Keep lines together: To keep lines of a paragraph together on a page or in a column.  
Keep with next: To paragraphs together on a page or in a column.  
Page break before: Always force a page break before a paragraph.  

 OK button. 
Word Password Protection 
The Word password protection feature can be use to protect your personal document from 

beingopen by other people that can access to your PC. 

If you share a computer with someone else or you work in a multi-user environment 
where it is possible for others on your network togain access to your hard drive, you 
may want to assign password protection to some of your documents containing 
sensitive information.  



 
To assign password protection in Word 

 Tools menu, click Options.  

 
 

 Options dialog box displayed, click the Security tab 

 File encryption options for this document section enter a password in the box 

labeled Password to open: 

 Advanced… button opens a dialog box that allows you to specify more options, such as 

whether you wish to protect the document properties. 

 OK will open the Confirm Password dialog box. 



 

 
 

 OK to save your password. 

 OK. 

Note: If you do not want other to modify your document, enter a password in 
the Password to modify: box under the File sharing options for this document section. 

Word Keyboard Shortcuts for Formatting Text 

1.) Display the Font dialog box 
[Ctrl]+[D] 
2.) Select the Font Size drop-down list 
[Ctrl]+[Shift]+[P] 
3.) Increase the font size in jumps 
[Ctrl]+[>] 
4.) Decrease the font size in jumps 
[Ctrl]+[<] 
5.) Increase the font size by one point 
[Ctrl]+[ ] ] 
6.) Decrease the font size by one point 
[Ctrl]+[ [ ] 
7.) Toggle all caps 
[Ctrl]+[Shift]+[A] 
8.) Toggle small caps 
[Ctrl]+[Shift]+[K] 
9.) Cycle the case of the selection 
[Shift]+[F3] 
10.) Toggle boldface 
[Ctrl]+[B] 
11.) Toggle underline 
[Ctrl]+[U] 
12.) Toggle word underline 
[Ctrl]+[Shift]+[W] 
13.) Toggle double underlining on the selection 
[Ctrl]+[Shift]+[D] 
14.) Toggle subscript 
[Ctrl]+[=] 



 
15.) Toggle superscript 
[Ctrl]+[+] 
16.) Toggle character and character code 
[Alt]+[X] 
17.) Apply the Symbol font 
[Ctrl]+[Shift]+[Q] 
18.) Display the Style dialog box 
[Ctrl]+[Shift]+[S] 
19.) AutoFormat the document 
[Ctrl]+[Alt]+[K] 
20.) Make the selection hidden text 
[Ctrl]+[Shift]+[H] 
21.) Copy the formatting of the selection 
[Ctrl]+[Shift]+[C] 
22.) Apply the copied formatting to the selection 
[Ctrl]+[Shift]+[V] 
Word Paste Special 
What you can do with the Word Paste Special? Let’s see… 

Word typically preserves all formatting when you copy or cut information from aWeb 
page or other documents and paste it into a Word document. Sometime this is good and 
helpful, but it can get annoying --such as when you copy the text from web that 
happens to be a hyperlink and Word inserts the link into your document. 
There is a simple way to avoid pasting text with all that formatting using the paste 
special feature.  
To use Paste Special to paste unformatted text 

 

te the text. 

 Edit menu, click Paste Special 



 

 
 

 Paste Special dialog box displayed, select Unformatted Text. 

 OK. You'll insert the words themselves, without all that extraneous formatting. 
Email Signature: How to Create or Modify it ? 
 
An email signature consists of text or pictures, or both. Microsoft Word provides the 
capability to email documents directly from Word. You can even use Word to create an 
e-mail signature file to be included with your messages. 
To create an e-mail signature 

Open Microsoft Word. 

 Tools menu, click Options. 

 Options dialog box displayed, click the General tab. 



 

 
 

 E-mail Options button to display the E-mail Options dialog box. 



 

 
 

 Email Options dialog box displayed, click the E-mail Signature tab. 

 Type the title of your e-mail signature or choose from the list box, type a name for 

your signature. 

 Create your e-mail signature box, insert the text or pictures, or both, that you want to 

use for a signature. (You can format the text using the available formatting tools). 

 OK to close the Email Options dialog box. 

 OK. 

To modify an e-mail signature 
 Microsoft Word. 

 Tools menu, click Options. 

 Options dialog box displayed, click the General tab. 

 E-mail Options button to display the E-mail Options dialog box. 

 E-mail Options dialog box displayed, click the E-mail Signature tab. 



 
 Type the title of your e-mail signature or choose from the list box, click the signature 

you want to change. 

 Create your e-mail signature box, make the necessary changes. 

 Replace. 
Word Document Map 
A Word Document Mapis useful when navigating a large document. It displays a list of 

headings in your document in a separate left hand pane of the screen. When you use this 

feature, Word will create a list based on its heading styles (Heading 1, Heading 2, and so on). 

The headings must be formatted using one of the built-in heading styles. 

When you click on any of the headings in the map, Word will quickly jump to the 
corresponding heading in the document. TheDocument Map is to assist you when you 
are working on your document. 
To enable the Document Map 

Open a Word document that already being formatted using the heading styles. 

 View menu, click Document Map. 

 the example:  

 



 
 
To navigate a document with the Document Map 

 a Word document that already being formatted using the heading styles. 

 View menu, click Document Map. 

-click a heading in the Document 

Map, and then click a number on the. For example, clickShow Heading 3 to display heading 

levels 1 through 3. 

o collapse or expand the subordinate headings under an individualheading, click the minus 

(-) or plus (+) sign next to the heading. 

 Document Map from the View menu again. 
Modify Word normal dot template! How to prevent it? 
Word's master template 

There are two basic types of files used in Word, that is .doc, which stands forDocument. 
The other is a .dot, which stands for Document Template. 
When Microsoft Word starts up it loads a template file called Normal.dot and you use 
this template to create all documents. Else, you can use customized template you've 
created before to create the documents. 
The Word Normal.dot template contains the basic layout (i.e. default font, page 
margins, styles, etc) and helps shape any documents created from this template. So, it’s 
important that you need to prevent accidental keystrokes or macro viruses from 
changing your Word defaults normal template. 
You can force Microsoft Word to ask you every time it closes whether you want to save 
the Normal.dot file. This way, if you know you made necessary changes to your default 
template you can save the file. Otherwise, you can help prevent mysterious or 
unintended changes by not overwriting the default template. 
To prevent accidental changes to Normal.dot template 

 Tools menu, click Options. 

 Options dialog box displayed, click the Save tab. 



 

 
 

 Prompt to save Normal template option. 

 OK. 

 

A fairly common question is: "How come every time I start a new document there's the same text 

already written on my page?" That's because, somehow, the user managed to open the blank 

document template (Normal.dot), typed something on the page, and saved the text to the 

Normal.dot, as well as whatever document name they saved the file. So they've altered the 

master template! 

To fix the problem, the user needs to reopen the Normal.dot file, remove the text and 
resave that master template file without the text. Then, when you open again a new 
Word document, the page will be empty. 
However, there are some basic customizations you can do that would probably allow 
you to work more efficiently. If you want all your documents, or the majority of them, 
created in a particular font, other than the Times New Roman (the default Normal.dot 
font), you can change that.  



 
To customize the Normal.dot template 

 

 Format menu, click Font. 

 Font dialog box displayed, change the font you prefer as your default starting font 

face, style, color, size, etc. 

Then, click on a Default button at the bottom of the dialog box. You'll be warned that this 

change will affect all new documents based on the Normal template. 

 
 

 Yes. 
Changing the Word 2003 Background Color 
Maybe you don’t know that Word 2003Background can be change! You can change it to any 

color that you like. 

Why you need to create different backgrounds for your documents? These backgrounds 
often come in good when you are creating brochures/flyers or certificates. 



 
There are five types of backgrounds available in Microsoft Word 2003. They are solid 
color, gradient, texture, pattern, and picture. We will start with the solid color 
backgrounds. 
To Create a Solid Color Background 

 Format menu, go to Background and choose a color. This will be your Word 

background color. 

 
 

 More Colorsoption.  



 

 
 

 Color dialog box displayed, select the color that you want to use and click 

the OK button.  

To Create a Gradient Background 
 Format menu, go to Background and click the Fill Effects to display the Fill 

Effects dialog box.  



 

 
 

– Gradient, Texture, Pattern and Picture that allow you to create different 

style of backgrounds. 

 was in the gradient tab. You need to select what type of color you want, one 

color, two colors, or preset. A preset is gradient backgrounds that are already made. 

 the color you want by dropping the box down on the right 

side of the screen. 

the screen. For example, red and yellow 



 

 
 

 presets, tick the presets box and go through the presets and find 

the one that you want to use. 

 Shading styles section, you can choose the different types of shading style to use. 

Here we choose the Diagonal up. 

 Variants section, select the variant that you like. 

click the OK button. The output will be as follow. 



 

 
Using Mail Merge 

The Mail Merge Wizard allows you to complete the mail merge process in a variety 

of ways. The best way to learn how to use the different functions in Mail Merge is to 

try to develop several of the different documents—letters, labels, and envelopes—

using the different types of data sources. 

To use Mail Merge: 

 Select Tools on the main menu. 
 Select Letters and Mailings Mail Merge. 
The Mail Merge task pane appears and will guide you through the six main steps to 

complete a mail merge. You will have several decisions to make during the process. The 

following is an example of how to create a form letter and merge the letter with a data 

list. 

 

 

Steps 1-3 

 Choose the type of document you wish to create. In this example, select Letters. 
 Click Next:Starting document to move to Step 2. 
 Select Use the current document. 
 Click Next:Select recipients to move to Step 3. 
 Select the Type a new list button. 
 Click Create to create a data source. The New Address List dialog box appears. 



 
 

To edit a new address list: 

o Click Customize in the dialog box. The Customize Address List dialog 
box appears. 

o Select a field, and click Delete. 
o Click Yes to confirm that you wish to delete the field. 
o Continue to delete any unnecessary fields. 
o Click Rename. The Rename Field dialog box appears. 
o Enter the new name you would like to give the field in the To: field. 
o Continue to rename any fields necessary. 
o Click OK to close the Customize Address List dialog box. 

 Enter the necessary data in the New Address List dialog box. 
 Click New Entry to enter another record. 
 Click Close when you have entered all of your data records. 
 Enter the file name you wish to save the data list as. 
 Choose the location where you wish to save the file. 
 Click Save. The Mail Merge Recipients dialog box appears and displays all data 

records in the list. 
 Confirm that the data list is correct, then click OK. 
 Click Next:Write your letter to move to Step 4. 

Steps 4-6 

 Write a letter in the current Word document. Stop writing when you reach a place 
in the letter where you wish to enter a field from your data record. 

To insert data from a data list: 

o Click the Insert Merge Fields button. The Insert Merge fields 
dialog box appears. 

o Select the field where you would like to insert in the document. 
o Click Insert. Notice that a placeholder appears where 

information from the data record will eventually appear. 
o Repeat these steps each time you need to enter information 

from your data record. 
 Click Next: Preview your letters in the task pane once you have completed your 

letter. 
 Preview the letters to make sure information from the data record appears 

correctly in the letter. 
 Click Next: Complete the merge. 
 Click Print to print the letters. 
 Click All. 
 Click OK in the Merge to Printer dialog box. 
 Click OK to send the letters to the printer. 
 

 
 



 
 

 

 

 

 

 

 

 

 

 

Microsoft Excel  
 

A spreadsheet is essentially a matrix of rows and columns. Consider a sheet of paper 

on which horizontal and vertical lines are drawn to yield a rectangular grid. The grid namely a 

cell, is the result of the intersection of a row with a column. Such a structure is called a 

Spreadsheet. A spreadsheet package contains electronic equivalent of a pen, an eraser and large 

sheet of paper with vertical and horizontal lines to give rows and columns. The cursor position 

uniquely shown in dark mode indicates where the pen is currently pointing. We can enter text 

or numbers at any position on the worksheet. We can enter a formula in a cell where we want to 

perform a calculation and results are to be displayed. A powerful recalculation facility jumps 

into action each time we update the cell contents with new data. MS-Excel is the most powerful 

spreadsheet package brought by Microsoft. The three main components of this package are  

 Electronic spreadsheet  

 Database management  

 Generation of Charts.  

Each workbook provides 3 worksheets with facility to increase the number of sheets. 

Each sheet provides 256 columns and 65536 rows to work with. Though the spreadsheet 

packages were originally designed for accountants, they have become popular with almost 

everyone working with figures. Sales executives, book-keepers, officers, students, research 

scholars, investors bankers etc, almost any one find some form of application for it.  



 
 

Microsoft Excel is an advanced computer-based spreadsheet, which is used to store data in 

columns and rows which can then be organized and/or processed. Spreadsheet is simply 

asheet that contains many columns and rows. 

 

To start Excel using the Windows Start menu  

 Click on the Start button, point to Programs, following by Microsoft Office and click 
onMicrosoft Office Excel 2003. 

Note: For previous version of Office - Click on the Start button, point to Programs and click 

onMicrosoft Excel. 

 Immediately you will see the screen shown below. In the right hand side of the screen, 
theGetting Started task pane provides help to you. 

 

 If you are not using it at the moment, click on the Close icon to close it. 
 The Microsoft Office Excel 2003 screen elements: 



 

 

By default, Microsoft Excel workbook contains 3 blank worksheets, which are identified by tabs 

displaying along the bottom of the screen. 

 

To enter text into a worksheet 

 Select the cell in which you want to enter the text and then type in the text. 
 Text entries are left aligned by default. 

 

To enter numbers into a worksheet 

 Select the cell in which you want to enter a number and type in the number. 
 If you want to enter a negative number, type a minus sign in front of it or enclose it in 

parentheses (bracket), e.g. -15 or (15). 
 To indicate decimal places, you type a full stop such as 125.89. 
 The numbers will be right aligned by default. 

 

To save a workbook 

 From File menu, click Save. 



 

 

 If it is a new file, the Save As dialog box will appear. If necessary select a different folder 
that you may wish to save the file in. 

 Enter a name in the File name: text box. 
 Click on the Save button. 

 

To minimize a workbook window 

 Click on the Minimize button in the top right-hand corner of the workbook window. 

 

Note: If you minimize the window, the file is not close yet. To re-open the program, just click on 

the 'minimized program icon' on the window taskbar. 

 

To close a file 

 From the File menu, click Close. 
 You will be asked if you wish to save any changes you have made to the file. 

Select Yes to save, or No to ignore the changes. 
 If you are saving a new file, the Save As dialog box will display. In the File name text 

box, enter a name and click on the Save button. 
 

To exit Microsoft Excel 

 From the File menu, click Exit. 
 If you have saved all the changes made in the active workbook files, Microsoft Excel will 

close. 
 If you have not saved all the changes, the Save confirmation box will be displayed. 



 
 To save the current workbook file before exiting, select Yes. 
 To exit without saving the file, select No. 
 To cancel the exit command, select Cancel or press Esc. 

 

Creating and Opening Workbooks 

 

To start using Microsoft Excel, you can start with a new blank workbookor open the 

existing Excel file. 

 

To create a new default workbook 

 New icon located on the Standard toolbar 

OR press Ctrl+N 

 

To open a file 

 File menu, click Open. 

 Open dialog box as displayed, use the Look in: drop down menu to select the drive 

or folder that contains the file you want. 

-click on the file name 

OR select the file name by clicking on it, and then click on the Openbutton. 

 

Microsoft Excel - Data Entry Techniques 

 

Here is the guide that shows the easy ways that you can use to enter data into the worksheet. 

To fill a range of cells with the same data 

the cells you wish to fill. 

 

 Ctrl+Shift+Enter and the range will be filled. 

 

To fill a range of cells with the 'automatic' data 

 

r the data into the cells as follow: A1: 1; A2: 2 



 
 A2. 

u see the “+” sign 

appear as follow: 

 

 

s you wish. You will see the selected range will fill 

with continuous numbers 3, 4, 5, 6,… 

Note: You also can replace the above A1 and A2 cells with days of week such as Monday, 

Tuesday,... and months like January, February,... 

 

Microsoft Excel - Navigating in the Worksheet 

 

How you can move from one place to another in Microsoft Excel? Here is the ways: 

To move to a particular cell (quick way) 

h to jump to into the Name Box (at the top, left of the screen). In 

the example shown the cell reference J50 has been entered. When you press the Enter key you 

will jump to the cell you entered. 

 

 

 

To move from cell to cell using the keyboard 

rom cell to cell, use one of the following key or combination keys: 

Icon Function 



 

→ One cell to the right. 

← One cell to the left. 

↓ One cell down. 

↑ One cell up. 

Ctrl + → To the right-hand edge of the current region. 

Ctrl + ← To the left-hand edge of the current region. 

Ctrl + ↓ To the bottom edge of the current region. 

Ctrl + ↑ To the top edge of the current region. 

Home To the first cell in the row. 

Ctrl + Home To the first cell in the worksheet. 

Ctrl + End To the lowest right-hand cell in the worksheet that contains a data entry. 

Page Down One screen down. 

Page Up One screen up. 

Alt + Page Down One screen to the right. 

Alt + Page Up One screen to the left. 

 

 

Microsoft Excel - Selection Techniques 

 

The selection techniques in Microsoft Excel allow you to select or highlight the cell(s) quickly so 

that you can perform the tasks such as deleting, copying, etc. 

To select a cell 

 

 



 
To select a range of cells by dragging the mouse 

 

-hand mouse button and drag over the cells you wish to include in the 

selection. 

 

To select a range of cells (making up a rectangular block) 

-left hand 

corner) 

m-right corner of the rectangular block. 

 the Shift key (and keep it depress). 

 Shiftkey. 

 

To select a non-contiguous range 

 

wn the Ctrl key, select the next range of cells. 

 

To select a row 

 

 

To select a column 

 

 

To select an entire worksheet 

 Ctrl+A 

 

Microsoft Excel - Inserting and Deleting 

 

Microsoft Excel offers a convenient way for you to either insert or delete cell(s), column(s), 

row(s), or entire worksheet. 



 
To insert a row(s) into a worksheet 

 

 one row, drag the mouse pointer across the required row headings. 

-click on the selected row(s) to display a pop-up menu. 

 Insert. Any existing data will move down to accommodate the new cells. 

 

 

To insert column(s) into a worksheet 

column is inserted. 

headings. 

-click on the selected column(s) to display a pop-up menu. 

 Insert. Any existing data will move down to accommodate the new cells. 

 

To delete a row or column 

 Deletecommand from the pop-up 

menu. 

 



 
To insert cells or range of cells 

want to insert a new cell. 

 Insert menu, click Cells. 

 Insert dialog box, select one of the following options: 

Entire column Moves all cells in the column to the right and inserts a new column. 

Entire row Moves all cells in the row down and inserts a new row. 

Shift cells down Moves existing cells down and inserts one cell. 

Shift cells right Moves existing cells to the right and inserts one cell. 

 

 

 OK. 

 

To delete cells or ranges of cells 

want to delete. 

 Edit menu, click Delete. 

 Delete dialog box displayed, select one of the options. 

 OK button. 

 

To insert a worksheet 

 sheet tab to select the worksheet where you want to insert a new one. The 

new worksheet will be inserted before this worksheet. 

 Insert menu, click Worksheet. 

 

To delete a worksheet 

 sheet tab to select the worksheet you wish to delete. 

 Edit menu, click Delete Sheet. 



 
 OK to permanently delete the selected sheet.  

 

 

Clipboard 

The clipboard is an area of memory in which you can store text, graphics or any other items in 

it. 

When you perform copy in the Excel spreadsheet, actually the copied item is store in the 

clipboard temporarily, and then when you paste the item, it is from the clipboard and paste the 

item to the intended location. 

 

Cut, Copy and Paste Data or Objects 

To use the clipboard to copy data to other program 

 the cell or range you wish to copy. 

om the Edit menu, click Copy.  

OR click on the Copy icon on the Standard toolbar. 

 destination program (e.g. Microsoft Word). 

 

 Edit menu, click Paste.  

OR click on the Paste icon on the Standard toolbar. 

 

To use the clipboard to cut data to other program 

 the cell or range you wish to cut. 

 Edit menu, click Cut.  

OR click on the Cut icon on the Standard toolbar. 

 destination program (e.g. Microsoft Word). 

 

 Edit menu, click Paste.  

OR click on the Paste icon on the Standard toolbar. 

 



 
Note: You noticed that cut and paste is different from copy and paste.Cut and paste will let the 

original data disappear when you paste it to thedestination program/location.  

To use the clipboard to copy an object between worksheet or workbook 

select it. 

 Edit menu, click Copy. 

Move to a new worksheet or workbook. 

-hand corner of the object. 

 Edit menu, click Paste. 

 

To use the clipboard to cut an object between worksheet or workbook 

 

 Edit menu, click Cut. 

 worksheet or workbook. 

-hand corner of the object. 

 Edit menu, click Paste. 

 

To copy a numeric value down a column 

 the first numeric value. 

 Ctrl+Shift+’(Apostrophe). 

 Enter to insert the value into the selected cell. 

 

To copy a column of text into a row 

elect the range of data you wish to copy and transpose. 

 Edit menu, click Copy. 

 the cell where you want to place the range. 

 Edit menu, click Paste Special. 

 Paste Special dialog box displayed, tick the Transposecheck box. 



 
 OK. 

 

The Excel Formatting Toolbar 
Excel formatting toolbar normally located near to the top of your screen as shown here. The 

toolbar icons have a specific purpose that can change the outlook of your spreadsheet when you 

apply formatting to it. 

 

 

 
 
The formatting toolbar icons and functions: 

Font – to select fonts from a drop-down list. 

Font Size – to select a font size from a drop-down list. 

Bold – to apply bold to a selected range. 

Italic – to apply italic to a selected range. 

Underline – to underline a selected range. 

Align Left – to align a selected range to the left. 

Center – to center a selected range 

Align Right – to align a selected range to the right. 

Merge and Center – to merge cells and center text across a selected range. 

Currency Style – to apply currency style to a selected range. 

Percent Style – to apply percentage style to a selected range. 

Comma Style – to apply comma style to a selected range. 

Increase Decimal – to decrease the number of decimal points displayed in a selected range. 

Decrease Decimal – to increase the number of decimal points displayed in a selected range. 

Decrease Indent – to decrease the level of indentation in a selected range. 

Increase Indent – to increase the level of indentation in a selected range. 

Borders – to select and apply borders to a selected range. 



 
Fill Color – to select and apply color to a selected range. 

Font Color – to select and apply color to text in a selected range. 

 

The Excel Formatting - Fonts 
To change the font used in a cell or range of cells 

 the cell or range of cells you wish to change. 

 Formatting toolbar choose a font from the Font drop down list. 

 

To change other font characteristics 
 the cell or range you wish to change. 

 Format menu, click Cells. 

From the Format Cells dialog box displayed, select the Font tab to change the Font, font 

style, or size. 

 Underline: drop down list box to select a style of underline or None to remove the 

underlining. 

 Color: drop down list box to choose a font color. 

 Effects section, you can tick Strikethrough, Superscript, orSubscript. 

the Style dialog box, tick the Normal font check box. 

t OK to close the Format Cells dialog box. 

 

The Excel Formatting - Alignment 
To align data between the left and right sides of a cell 

 the cell, or cells, you wish to align. 

 Formatting toolbar, click on the Align Left icon to align data with the left edge 

of the cell. 

 Align Right icon to align data with the right edge of the cell. 

 Center icon to center data in the cell. 

 

To align data between the top and bottom of a cell 
 the cell, or cells, you wish to align. 



 
 Format menu, click Cells. 

 Format Cells dialog box displayed, click on the Alignmenttab. 

 Text alignment section, choose the Top, Center, or Bottom option in the Vertical area 

to align the data in the cell. 

Justify 

distributed option and click on OK. 

 

To change the orientation of data cells 
 the cell, or cells, you wish to change. 

  From the Format menu, click Cells. 

From the Format Cells dialog box displayed, click on the Alignmenttab. 

 Orientation section, you can change the Degrees of the text or use the mouse to drag 

the 'red small diamond' up or down. When satisfied, click on OK. 

 

 
To wrap multiple lines of data in a cell 

 the cell and press Enter. The entry will appear as one long line 

and select the cell, or cells, you wish to format. 

 Format menu, click Cells. 

he Format Cells dialog box displayed, click on the Alignmenttab. 

 Text control section, tick the Wrap text check box and click onOK. 

 

To shrink the text into one cell 
 the cell and press Enter. 



 
 Format menu, click Cells. 

 Format Cells dialog box displayed, click on the Alignmenttab. 

 Text control section, tick the Shrink to fit check box and click on OK. 

 

To merge several cells 
ell. 

-click on the selected cells, click Format Cells. 

 Format Cells dialog box displayed, click on the Alignmenttab. 

 Text control section, tick the Merge cells check box and click on OK. 

Note: You also can use the Merge and Center icon on the ExcelFormatting toolbar. 

 

The Excel Formatting - Colors 
To change the color of text 

 

 Formatting toolbar, click the down arrow next to theFont Color icon. 

 

 
 Font Color palette. 

 Font Color palette will be displayed on the new icon face. 

Click on the icon face to apply the new color to the cell. 

 

To apply colors to cell(s) 
 the cell or range of cells you wish to color. 

 On the Excel Formatting toolbar, click the down arrow next to the Fill Color icon. 

 Fill Color palette. 



 

 

 
 
To turn off the cell(s) color 

 the cell or range of cells you wish to color. 

 On the Excel Formatting toolbar, click the down arrow next to the Fill Color icon. 

 No fill. 

 

The Excel Formatting - Numbers 
To change number formatting using the formatting icons 

ge by using the 

following icons on the Formatting toolbar. 

 

 

Currency 12345 will become $12,345.00 

Percent .25 will become 25% 

Comma 98765 will become 98,765.00 

Increase Decimal 12,345.00 will become 12,345.000 

Decrease Decimal 98,765.00 will become 98,765.0 

 

To format a number as a currency 
 the cell or range of cells you want to format. 

 Format menu, click Cells. 



 
 Format Cells dialog box displayed, select the Number tab. 

 Category: section, select Currency.  

 
 

 places you require by using the Decimal places: spin box 

arrows. 

 Symbol: section drop down list, select the type of currency. 

 OK. 

 

To format a number as a percentage 
 the cell or range of cells you wish to format. 

 Format menu, click Cells. 

 Format Cells dialog box displayed, select the Number tab. 

 Category: section, select Percentage. 

 Decimal places: spin box 

arrows. 

 OK. 



 
 

 
 
 
Excel Formula and Function 
 
Excel Formula 
A formula is an equation that performs operations on worksheet data. Excel formula can 

perform mathematical operations, such as addition and multiplication, or they can 

compare worksheet values or join text.  

 

To enter a formula 
 the cursor inthe cell where the formula will appear. 

 

value in A5 with the value in E5. 

 the formula is complete, pressEnter. The result ofthe formula will be calculated and 

displayed in the cell. 

display. 

To enter a cell or range reference by pointing 
 the cursor in the cell where the formula will appear. 

 the formula up to the point of the cell or range reference, e.g. to enter the 

formula =E2+E5, only enter the = sign. 

 the cell pointer to the first cell reference, in this case E2. The 

formula will track your progress and enter the current address into the formula. 

 

 the cell pointer to the second cell reference, in this case E5. If you 

are calculating a range of cells, hold down the Shift key while using the arrow keys to move to 

the intended cells. 

 Enter to complete the formula when you have reached the cellyou require. 

 



 
Excel Function 
Functions are special commands used in formulas to perform mathematical processes. 
To enter functions directly into the worksheet cell 

 the cell into which the formula will be entered. 

 the formula. The formula toolbar buttons will appear. 

e of the function [e.g. SUM], followed by an opening parenthesis [(], any 

arguments required for the function [e.g. E2:E5], and closing parenthesis[)]. 

 Enter. If there are no errors in the formula, the result of the function will be entered 

in the cell. If you activate the cell again, the function will be displayed in the formula bar. 

 

To use the AutoSum function 
 AutoSum icon on theStandard toolbar. 

-down menu will insert the function and predict 

the arguments. 

display a sum function with the list of the arguments.  

 

 

-- add the contents of the list of arguments. 

-- determine the average value of the list of arguments. 

-- count the number of values in the list of arguments. 

-- return the maximum number in the list of arguments. 

-- return the minimum number in the list of arguments 

 

 

Example: Using the Average function 

 the cell B6 which the formula will 

be entered. 



 

 

 
 AutoSum icon on the Standardtoolbar and 

choose Average from the drop-down menu. 

 predicted range is correct, press the Enter key. If it is incorrect, select (click and drag) 

the range you want with the mouse and press theEnter key. 

tions such as 

SUM, Max, etc. 

 

Note: Excel formula and function is one of the most powerful feature in Microsoft Excel. It is 

important for you to master it.  

 

Create an Excel Chart 
We will use the step-by-step Excel Chart Wizard to create a chart that related to the 

Student exam results for the subject English, Science and Mathematics. 

 

 

 
 
Step 1: The Chart Wizard (1) – Chart Type 

 Exam Results 
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wish to display as a 

chart, or highlight the exact data that you wish to display as a chart. 

 Chart Wizard icon on the Standard toolbar. This will display the Excel Chart 

Wizard as show below: 

 
 

 Chart type: section you can select the type of chart that you wish to create. 

 Chart sub-type: section you can select the exact format that you required for 

the selected chart type. 

 Press and Hold to View Sample button 

within the dialog box. In our example, we accept the default selection. 

 Next button to see the next page of the dialog box - Chart Source Data. 

 

Step 2: The Excel Chart Wizard (2) – Data Source 
 Data Range tab allows you to specify the exact data that you wish to display within your 

chart. 



 
 Series in Rows or Columns. In the case of the example data used, 

the two effects will be as illustrated. Choose the Series in Rows. 

  

 
 Next button, this will display the Chart Optionsdialog box. 

 

Step 3: The Excel Chart Wizard (3) – Chart Options 
From the chart options dialog box displayed, you can select Titles, Axes, Gridlines, 

Legend, Data Labels and Data Table tabs and make the necessary changes. 
 
To add title to a chart 

 Chart title: text box, enter the name for the chart, i.e. Exam results. 

 Category (X) axis: text box, enter a title for the X axis, i.e. Subject. 

 Category (Y) axis: text box, enter a title for the Y axis, i.e. Mark score. 

 the example used, the screen will be as illustrated. 



 

 
 
To customize the chart axis 

 Chart Option dialog box displayed, click on the Axes tab. 

-tick the check box 

to see the effects on the chart. 

 

To customize chart gridlines 
 Chart Option dialog box displayed, click on the Gridlinestab. 

the particular check box. 

 

To customize chart legend 
 Chart Option dialog box displayed, click on the Legend tab. 

chart by clicking on the radio button. 

 

To customize data labels 
  From the Chart Option dialog box displayed, click on the Data Labelstab. 

 chart data labels by clicking on the radio button. 

 

To display a data table 
 Chart Option dialog box displayed, click on the Data Tabletab. 

 chart data table by ticking on the check box. 



 
 Next button to continue and this will display the final page of the Chart Wizard 

– Chart Location. 

 

Step 4: The Excel Chart Wizard (4) – Chart Location 
To define the chart location 

 worksheet as an object, or you can place it 

on a new worksheet. Two options for you to choose: 

As new sheet: – It will place the chart in the new worksheet. 

As object in: - It will place the chart in the existing worksheet. 

 
 

 Finish button and the chart will be created as you have specified during 

the Chart Wizard creation process. 

Excel Template 
When working with spreadsheets you may want to use the same layout or design. You 
can re-create the design every time you want to use it, or you can create atemplate. 
Yes, it's Excel template... 
You can create templates for workbooks and worksheets. The default template for 
workbooks is called Book.xlt. The default template for worksheets is called Sheet.xlt. 
Creating templates can include the following elements: 

 

 

 

 

 

 



 
 

Create the workbook that contains all layout and formatting elements you wish to save as a 

template. 

 File menu, click Save As. 

 File name: text box. 

 Save as type: drop down list box, select Template. 

 
 

 Save. The extension .XLT is added to the file name and the template is saved in 

the Templates folder.  

 

To use a template 
 File menu, click New to display the New Workbook pane. 

 Template section of the New Workbook pane, click on the blue On my 

computer… link display the Templates dialog box:  

 
 



 
 General or the Spreadsheet Solutions tab to locate the template you want. For 

default template, click on the General tab and select the Workbook icon. 

 

Note: In the Spreadsheet Solutions tab, you can see 5 templatesavailable. Most of the times you 

need to use the Microsoft Office CD in order to install the features and use it. 

 OK to open a copy of the template. 

Note: Excel 2003 allows you to access additional templates on the Microsoft Office 
website (required Internet connection). Just click on theTemplates on 

Office Online link in the New Workbook pane, and you will be directed to the website 
and search for the template that you need. 
To download different types of free excel templates, click here.  
Template vs Style 
What is the different between Excel template and Excel style? 

Style is a collection of cell formatting information such as font size, patterns, alignment, 
etc that you can define and save as a group. 
If formatting information is assigned to cells using styles it is possible to easily update 
the appearance of a sheet by modifying the styles. 
Excel comes with a number of styles pre-defined, by default all cells have 
the Normal style assigned to them. It is possible to copy styles from one Workbook to 
another. 
 
To create a style 

s you required. 

 Format menu, click Style. 

 
 

 Style dialog box displayed, type the style name in the Style name: drop down list. 

http://www.msoffice-tutorial-training.com/free-excel-template.html


 
 Modify button to change any of the attributes. The Format Cells dialog box will be 

displayed. 

 Number, Alignment, Font, Border, Patterns andProtection tabs and make any 

changes required. Click OK to return to the Style dialog box. 

 OK. 

 

To apply a style 
ells that you wish to format. 

the Format menu, click Style. 

 Style name: drop down list box. 

 OK. 

 

Excel Macro 
 macro is a series of commands and functions that can be run whenever you need to perform 

the task. 

tasks and reduce the number of steps required to complete 

tasks that you perform frequently. 

 Excel macrois to have Excelrecords the actions and then store 

these actions as a macro. 

s can be played back or modified at any time. 

 

 
 Tools menu, point to Macro and click on Record NewMacro. 

 Record Macro dialog box displayed, enter a name for the macro in 

the Macro name: text box. 



 

 
 

description is displayed in the Description: text box, and contains the date and 

user name. If required, change it. 

 OK. 

 macro to record. Actions can be any combinations 

of Excel commands. 

To stop recording, from the Tools menu, point to Macro and click onStop Recording.  

 

To assign a shortcut key to the macro 
 Tools menu, point to Macro and click on Macros. 

 Macro dialog box displayed, select the macro name (if recorded before) to which 

you want to assign a shortcut key.  

 
 

 Options button to display the Macro Options dialog box. 

 Ctrl+ text box. This combination key will be used to invoke the macro. 



 
 OK to return to the Macro dialog box. 

 Cancel button to close. 

 

To run a macro using the Tools Macro command 
 Tools menu, point to Macro and click on Macros. 

 Macro dialog box displayed, click on the name of the macro you wish to run in 

the Macro name: list box. 

he Run button.Note: If you wish to edit or delete a macro, just click on the particular 

button. 

 

To run a macro using the assigned shortcut key 
 Ctrl+?, with ? is the letter which you assigned. 

 

To create a button and assign an Excel macro to it 
 If the Forms toolbar is not display, right click on any toolbar that is visible and from the pop-

up menu that is displayed select Forms. 

 Button icon on the Forms toolbar. 

 
 

d drag the mouse to the intended button size. 

 mouse button, the Assign Macro dialog box will be displayed. 



 

 
 

 Record button and the Record Macro dialog box will be displayed. 

 macro in the Macro name: text box. 

 OK button. 

 macro in the normal way, and click on the button and select Edit Text from the 

pop-up menu. 

 macro, simply click on the button. 

 

To change a button name 
ighlight the button name. 

ype in a new name and click on any worksheet cell to deselect the button. 

 

To delete a button 
 Delete key. 

 

Excel 2003 Worksheet and Workbook Protection 
 
Excel worksheet and workbook protection feature allows you to protect your file being 
open by unauthorised person. You can set the password so that anyone that intend to 
open the file required the password to open it. 



 
To specify a password for opening and modifying a workbook 

 File menu, click Save As. 

 Save As dialog box displayed, click on the Tools icon and from the drop down 

list displayed, select General Options. 

 

 
 

 Save Options dialog box displayed, enter a password into the Password to 

open: text box. In future you will be required to enter this password in order to open the file. 

 
 

 enter a password into the Password to modify: text box, this gives others the ability to 

open, view and edit a workbook, but not to save it with the same name. They must save a 

modified version of theworkbook with a different name. 

 OK button. You will be asked to re-type the password to ensure that it is 

consistent. 

Note: 

(1) The check box "Always create backup" forces Excel to create a backup copy of the file every 



 
time a worksheet file is saved. The file extension BAK is used, and the backup file is saved in 

the same folder as the original file. 

(2) If the "Read-only recommended" check box is ticked, the following dialog box is 
displayed when the file is re-opened. 

 
 

 Yes. 

-only’. 

 worksheet, you cannot save the file with the same file 

name. So, changing the file name allows you to save the file.  

 

To remove a password from a workbook 
 workbook containing the password you wish to remove (by entering the password 

when prompted). 

 File menu, click Save As. 

 Save As dialog box displayed, click on the Tools icon, and from the drop down 

list displayed select General Options. 

 Save Options dialog box displayed, clear either or both passwords text box. 

 OK button to close the Save Options dialog box. 

 Save button to save the file, which will display a dialog box. 

 on the Yes button.  

 

To protect a workbook 
 Tools menu, point to Protection and click on ProtectWorkbook. 

 Protect Workbook dialog box.  



 

 
 

 Protect Workbook dialog box displayed, you have two options: 

Structure 
Prevents any changes to the structure of the workbook ifchecked. i.e. you will be 

unable to edit, insert, delete, rename, copy, move or hide sheets. 

Windows 
Prevents changes to the workbooks size. The windows re-sizing controls (close, 

maximize, minimize and restore) are hidden. 

 Password column, you can enter a password (case sensitive). Click OK. 

-type the password to ensure that it is consistent. 

 OK.  

 

To unprotect a workbook 
 Tools menu, point to Protection and click on UnprotectWorkbook. 

 OK.  

 

To protect a worksheet 
 Tools menu, point to Protection and click on ProtectSheet. 

 Protect Sheet dialog box.  



 

 
 

From the Protect Sheet dialog box displayed, you can choose any option from the lists if you 

ALLOW other users to modify the checkedoption in the worksheet. 

 Password to unprotect sheet: column, you can enter a password (case sensitive). 

Click OK. 

-type the password to ensure that it is consistent. 

 OK. 

 

To unprotect a worksheet 
 Tools menu, point to Protection and click on UnprotectWorksheet. 

 OK. 

 

 

Excel Print 

 

In order to print, Microsoft Excel requires that a printer driver has been installed that 
matches the printer you are currently attached to your computer. 



 
If you are sure on that, then ON the printer and load some plain papers to the printer 
tray. 
Then, follow the step-by-step instructions below to print.  
 

Excel Printing - Page Settings 
The options that can change here includes the paper orientation, set the page scale and size, and 

print quality. 

 

To change Page Setup options 
 File menu, click Page Setup. 

 Page Setup dialog box displayed, click on the Page tab. 

 
 
To set the printing paper orientation 

 Orientation section, select Portrait or Landscape by clicking the option button. 

 

To set the scale of the page 
the Scaling section, choose the Adjust to: option button and enter a percentage to scale (in 

conjunction with normal size) in the Adjust tospin box. 

 Fit to: option and enter the dimensions of the pages in the wide and tall spin 

boxes. 

 



 
To set other printing options 

Paper size In the Paper size: drop-down list box, select the size you require. 

Print quality 
In the Print quality: drop-down list box, choose the quality you require (higher 

dpi – better quality). 

Page 

numbering 

To begin page numbering with a different number, select the First page number: 

text box and enter the number you want to use. 

 
Excel Printing - Margins Settings 
Proper Microsoft Excel printing that involves margins is to set the top, bottom, left and right 

margins of the page. You also can choose to center the data of a page. 

To change the page margins 
 Page Setup dialog box displayed, select the Margins tab. 

 
 

 Top, Bottom, Left, or Right margin spin box to change the settings. 

header and footer margins, click on the Header: or Footer:spin box. 

 OK.Note: At the bottom Center on page section, you can choose Horizontally or 

Vertically to reflect the best position of your data in a page. 

 



 
Excel Printing - Header/Footer Settings 
Proper settings of page header and footer are important as it will affect the overall look of a 

page in Excel printing.  

To change headers and footers 
 Page Setup dialog box displayed, select the Header/Footertab. 

 the down arrow to the right of the Header: list box to reveal a list 

of available headers. Click on the header required to select it. 

 Custom Header or Custom Footer button to display theHeader (or Footer) 

dialog box. 

 
 

 Left section: box, enter any data you want to appear at the left margin of the header or 

footer. 

 Center section: box, enter any data you want to appear at the center of the header or 

footer. 

 Right section: box, enter any data you want to appear at the right margin of the 

header or footer. 

 

 
 

Format font Click this button after highlighting the text to change the font, size, and style. 



 

Page number Insert the page number of each page. 

Number of 

pages 

Use this feature along with the page number to create strings such as "page 1 

of 15". 

Date Add the current date. 

Time Add the current time. 

File path Add the file path name (location of the file) 

File name Add the name of the workbook file. 

Tab name Add the name of the worksheet’s tab. 

Insert picture 
Bring up insert picture window and you can choose a location to insert 

picture. 

Format picture Format the inserted picture. 

 

 

 OK. 

 the Page Setup dialog box in 

the Header or Footer list box. 

 OK to close the Page Setup dialog box. 

 

Excel Printing - Sheet Settings 
In Excel printing, sheet settings is very important as it will control what and where to print of a 

page. So make sure you follow the steps here closely. 

To change sheet options 
 File menu, click Page Setup. 

 Page Setup dialog box displayed, select the Sheet tab. 



 

 
 

 

Print area 
Enter the worksheet range you want to print, or click on theicon in the right of 

the text box and drag through theworksheet areas you wish to print. 

Rows to 

repeat at top 

Click on the icon in the right of the text box and drag over the rows you wish to 

repeat at the top of the page. It enables you to print the selected top row appear 

on every printing sheet. 

Columns to 

repeat at left 

Click on the icon in the right of the text box and drag over the columns you 

wish to repeat at the left of the page. It enables you to print the selected left 

columns appear on every printing sheet. 

Elements that 

will print 

Tick on the element you wish to print, i.e. Gridlines, Black and 

White, Draft Quality, Row and Column Headings (see below). 

Page order 
Select Down, then over, or Over, then down. You only can see the effect if you 

have data across a sheet that cannot fit into one printing page. 

 

 

on): 



 

Gridlines Will print the Excel gridlines. 

Black and white Will print the data in blank and white without color. 

Draft quality The printing will be in draft quality, not the normal quality. 

Row and column headings Will print the worksheet including the row and column headings. 

 

 

 

Options Do necessary adjustment with the printer settings. 

Print Preview Preview your worksheet before printing. 

Print Print the worksheet. 

 

To change the Excel printing settings 
 File menu, click Print. 

 Print dialog box displayed, do the necessary changes as follow: 

 
 

 Printer section, the Name: list box, choose the printer you wish to use. 



 
 Page range section, select whether you want to print All pages in a range, or enter the 

starting and ending page numbers in the From:and To: spin boxes. 

 Print what section, i.e. Selection, Active sheet(s), or 

Entire workbook. 

opies you want to print in the Number of copies: spin box. 

 Properties button to display the Properties dialog box for the printer. 

have. 

 OK to close the printer properties dialog box. 

 OK again to start printing the worksheet. 

 

Note: Before hit the OK button, ensure that you have put the plain papers to the printer tray. 

 

Excel Help Feature 
 

With this feature, you can almost solve allExcel related problem. It is also one of the most 

important features whereby you can discover the Excelrich features from the basic to advance.  

 

So, just follow the step-by-step guide here.  

 

Note: It’s recommended that you connect to the Internet to use the Microsoft Excel 2003 Help 

feature.  

 

 

To start the Microsoft Excel Help 
 Microsoft Excel Help icon located on the Standardtoolbar. 

 
 

 Excel Help task pane display at the right hand side of 

your Excel screen. 



 
 Search for: text box.  

 
 

 chart' and press Enter. Then, thesearch results are displayed, 

normally with 20 results as shown here.  

 



 
 

 how to create a chart in Excel, 

then click on the Create a chart. 

 another window that guides you to create a chart. There are 2 steps to 

create a chart.  

 
 

 more information. When finish, click on 

the Close button. This will bring you back to the Search Results pane. 

 Back button from the Search Results pane. 

You also can use the Forward button.  

 
Microsoft Office Assistant 
By default this friendly little creature willwatch what you do and offer tips on how to 
work more productively. 
 



 
Occasionally the Office Assistant will display information on the screen. If you are 
unsure about how to use this feature you should always read the help offered. 
 
Note: You are required to connect to the internet when you use the Office Assistant 
feature. 
To show the Office Assistant 

 Excel Help menu, click on the Show the Office Assistant.  

Note: The Office Assistant feature required you to put in the Microsoft Office 

2003 installation CD to install it first only that you can use it. 

 Office Assistant on the screen and you can move it to any place by 

clicking and drag to the intended location. 

 

 
To use the Office Assistant 

ck on the Office Assistant, it will show something like this:  

 

 
 highlighted texts that say ‘Type your question here and then click Search’. 

combination of few words. Click the Searchbutton. 

 the link title that you would like to 

know. When finish, just close it.  



 

 

 
To hide the Office Assistant 

-click on the Office Assistant and from the pop-up menu displayed, select Hide. 

 

Excel Conditional Formatting 
Excel conditionalformatting allows you to apply different formatting options, such as color, to 

a cell or cells based on the data in the cell(s). 

Here are the 2 easy steps to implement the conditionalformatting:  
1. Create a set ofconditions that control formatting changes in the target cells. 
2. Enter your data. If the conditions you set are met by the data, then the formatting is 
applied.  
Note: Up to three conditions can be set for a cell, so it is possible to vary the formatting 
as the contents of a cell changes.  
To format cells using conditional formatting 

 conditionalformatting to it. 



 

 
 

 which you wish to apply conditionalformatting. In this example the 

range would be A1:C5. 

 Format menu, click Conditional Formatting. 

 
 

 the numbers in 

the correct fields, as illustrated above. 

 OK button, then no special formatting would be applied to these values, so 

next we need to click on the Format button within this dialog box.  



 

 
 

 Format Cells dialog box is displayed, from which we can specify how data 

that meets the specified criteria will be displayed. 

 conditional formatting; choose red, for this example. 

 OK button to close this dialog box, which will return to 

the Conditional Formatting dialog box. 

To add the other conditional formats, click the Add button. Otherwise, click on OK button to 

close this dialog box. 

 

Excel Add-in 
Excel add-in is the 'extension' of the Excel program. It’s a small application that when 

you install it, the will add an extra function to the Excel that can ease the complex tasks. 

 

To install Excel Add-ins 
rom the Tools menu, click Add-ins to display the Add-ins dialog box. 



 

 
 

-in you want to install is already in the list then tick the corresponding check box. 

Click OK button. 

 install the add-in as follow: 

 
 

 Yes to continue. It will take some time and you may need the Office 2003 installation 

CD to proceed. 

-in you want to install is not in the list then click the Browsebutton will displays a 

dialog box allowing you to browse for an additional Excel add-in. 

 Automation button will displays another dialog box that lists all registered COM 

automation servers available on the system. 

Note: If you install an additional add-in the changes are not saved until you actually close Excel 

completely. 

To uninstall Excel Add-ins 
 Tools menu, click Add-ins to display the Add-ins dialog box. 



 
If the add-in you want to uninstall is in the list then uncheck the corresponding check box. 

Click OK button to uninstall the add-in. 

To get free Excel Add-ins 
Save As PDF - Allows you to export and save to the PDF format from your Office 

applications. 

 

 

Excess Formatting Cleaner - Helps to remove any excess formatting in your workbooks. 

 

 

Password Remover - Removes password protected workbook orworksheet.  

 

 Excel IF Function! 
The Excel IF Functionchecks a condition that must be either true or false. If the condition is 

true, the function returns one value; if the condition is false, the function returns another value. 

The function has three arguments: the condition you want to check, the value to return 
if the condition is true, and the value to return if the condition is false. 
 
Here is the Excel IF()Syntax: 
IF(Logical_test, Ation_if_true, Action_if_false) 
Logical _test 
The logical_test evaluates an expression to see if it passes the test, i.e. is TRUE or does 
not pass the test, i.e. is FALSE. 
 
Logical operators 

http://www.microsoft.com/downloads/details.aspx?familyid=F1FC413C-6D89-4F15-991B-63B07BA5F2E5&displaylang=en
http://www.microsoft.com/downloads/details.aspx?familyid=ECFD076C-B873-48CC-B842-DA999C848C82&displaylang=en
http://www.straxx.com/excel/password.html


 

 
 
 
Action_if_true 
Action_if_true can be a value or an operation. Whichever, the result is placed in the 
cell that contains the IF ( ) Function if the logical_test is true. 
Action_if_false 
Action_if_false can be a value or an operation. Whichever, the result is placed in the 
cell that contains the IF ( ) Function if the logical_test is false. 
To demonstrate the Excel IF function 
Lets look at an example for calculating a bonuses based on total sales. A company offers 
its salesman a 5% bonus if the value of the total sales is below $5,000 per month. If the 
total sales exceed $5,000 per month, the bonus will be 10%. 
When translated into the IF ( ) function it looks like the following: 
IF(TotalSales>5000,TotalSales * 10%, TotalSales * 5%) 
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 the cell to contain the IF( ) function. In this case, cells C2. 

 Insert menu, click on Function…to display the Insert Function dialog box. 

OR press the Shift+F3 

 
 

 Insert Function dialog box displayed, select the IF option and then 

click OK button. The following dialog box will be displayed. 



 

 
 

 B2 > 5000 into the Logical_test text area. Press the Tab key. 

 10% into the Value_if_true text area. Press the Tab key. 

 5% into the Value_if_false text area. Click OK. 

to C6. 

 

Note: Every time, you just need to change the data from B2 to B6, thenthe bonus will be 

automatically calculated. 

 

Excel CHOOSE Function 
The Excel Choose function allows you to select a value from a list of up to 29 items. 

It uses index_num to return a value fromthe list of value arguments. 
For example, if value1 through value7 are the days of the week, CHOOSE() returns one 
of the days when a number between 1 and 7 is used as index_num. 
 
Here is the Excel CHOOSE( ) Syntax:  
CHOOSE(Index_num, Value1, Value2, Value3, …) 
Index_num 
This specifies which of the set of values is returned by this function. It must be a 
number between 1 and 29, or a formula or reference to a cell containing a number 
between 1 and 29. 
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r greater than the number of the last value in the list, CHOOSE 

returns the #VALUE! error value. 

fraction, it is truncated to the lowest integer before being used. 

Value1, Value2, Value3… 
A set of values from which the result is returned. 
To use the Excel CHOOSE function (an example) 

 the cell where the function is to go. 

 Insert menu, click on Function…to display the Insert Function dialog box. 

 
 

 Insert Function dialog box displayed, under the Or select a category: box, select 

the Lookup & Reference. 

 Select a function: section, select the CHOOSE and click OK to display 

the CHOOSE dialog box. 



 

 
 

 Index_num text entry box. In our case, enter the 

word 3. 

 Tab key and enter the first value to be chosen from into theValue1 text entry box. 

Enter the word Monday. 

 Tab key again and enter the second value to be chosen from into the Value2 text 

entry box. Enter the word Tuesday. 

 

Click OK when complete. You will see the result display Wednesday. 

 

Note: If we enter the 5 in the Index_num text entry box, then it will return the Friday. 

 

 

The Excel Date Function 
Excel stores dates as a serial number giving each day of each year a unique number. The 
numbering system starts with 'day 1' being the 1st January 1900, 'day 2' being the 2nd 
January 1900, and so on. 
 
Here is the Excel DATE Function Syntax: 
DATE(year,month,day) 
Year 
The year argument can be one to four digits. 



 
 Excel adds that value to 1900 to calculate the 

year. For example, DATE(100,1,2) returns January 2, 2000 (1900+100). 

 Excel uses that value as the year. For example, 

DATE(2000,1,2) returns January 2, 2000. 

less than 0 or is 10000 or greater, Excel returns the #NUM! error value. 

Month 
Month is a number representing the month of the year. If month is greater than 12, 
month adds that number of months to the first month in the year specified. Example: 
DATE(1996,14,2) returns the serial number representing February 2, 1997. 
Day 
Day is a number representing the day of the month. If day is greater than the number of 
days in the month specified, day adds that number of days to the first day in the month. 
Example: DATE(1996,1,35) returns the serial number representing February 4, 1996. 
Mathematical Date Functions 
To calculate the difference between two dates in days or weeks 

 the cell A1 enter the first date. In the cell A2 enter the second date. 

 the cell A3 enter the formula =A2-A1 to calculate the difference between the second 

date and the first date. 

 formula calculates the difference between the two dates in days. 

 the formula =(A2-A1)/7. 

To add days or weeks to a date 
 

 A2 enter the following formula: =A1+120. This adds 120 days to the date. 

 the number of weeks by seven to calculate the number of 

days, i.e. =A1+(10*7) adds ten weeks to the date. 

To add months to a date 
 

 A2 enter the following formula: =DATE(Year(A1), MONTH(A1)+1, DAY(A1)) 

 the +1 value to +2 or +3, you will add two months or three months on 

respectively. 

To find out the last day of the month 
 

 A2 enter the following formula: =DATE(Year(A1), MONTH(A1)+1, 1)-1 



 
This will give you a date that represents the last day of the month found in cell A1. 

 

 

Create an Excel Pie Chart 
Here is the step-by-step guide to create an outstanding Excel pie chart: 
Key in the data illustrated below accordingly as we will use it as our example to create 
chart. 

 
 
Step 1: The Chart Wizard (1) – Chart Type 

the information that you wish to display as a 

chart, or highlight the exact data that you wish to display as a chart. 

 Chart Wizard icon on the Standard toolbar. 

 



 
 

 Chart type: section you can select the chart type: Pie. 

m the Chart sub-type: section you can select the exact format that you required for 

the selected chart type. 

 Press and Hold to View Sample button 

within the dialog box. In our example, we accept the default selection. 

 Next button to see the next page of the dialog box - Chart Source Data. 

Step 2: The Chart Wizard (2) – Data Source 
 Data Range tab allows you to specify the exact data that you wish to display within your 

chart. 

choose to display Series in Rows or Columns. In our case here, choose the Series 

in Columns will be more appropriate. 

 
 

 Next button, this will display the Chart Optionsdialog box. 



 
Step 3: The Chart Wizard (3) – Chart Options 
From the chart options dialog box displayed, you can select Titles, Legend, and Data 

Labels tabs and make the necessary changes. 
To add title to a chart 

 Chart title: text box, enter the name for the chart, i.e. Score Marks. 

 the example used, the screen will be as illustrated. 

To customize chart legend 
 Chart Option dialog box displayed, click on the Legend tab. 

legend in the 

chart by clicking on the radio button. 

To customize data labels 
 Chart Option dialog box displayed, click on the Data Labelstab. 

 chart data labels by clicking on the radio button. In our 

example, tick the Percentage check box to display the percentage info. 

 
 

 Next button, this will display the Chart Location dialog box. 

Step 4: The Chart Wizard (4) – Chart Location 
To define the chart location 

ce the Excel pie chart on an existing worksheetas an object, or you can 

place it on a new worksheet. Two options for you to choose: 



 
As new sheet: – It will place the chart in the new worksheet. 
As object in: - It will place the chart in the existing worksheet. 

 
 

Click on the Finish button and the Excel pie chart will be created as you have specified during 

the Chart Wizard creation process. 

 

Excel Paste Special Feature 
After copying data, you can use the ExcelPasteSpecialcommand to paste specific cell contents 

such as formulas,formats, or comments from the clipboard into an Excel worksheet. 

You can also usePaste Special to paste a link to Excel data or data from another 
program, such as Microsoft Word. 
 
 
To use Paste Special to link to Excel data 

 the range of data that contain the items or attributes you wish to copy. 

 Edit menu, click Copy.OR press Ctrl+C 

 the cell where you want to place the range. 

 Edit menu, click Paste Special. 



 

 
 

 Paste Special dialog box displayed, under the Pastesection, choose All or All 

except borders option. Other options included: 

 
 

 Operation section, specify which mathematical operation, if any, you want to apply to 

the copied data. 



 

 
 
 
Note: Mathematical operations can be applied only to values. To use an option other 
than None, you must choose All, Values, All except border, or Values and 

number formats under Paste section. 
 occur in the copy area, 

select Skip blanks check box. 

columns of copied data to rows, or vice versa, selectTranspose check box. 

 OK button when finish. 

To use Paste Special to link data from another program (MS Word) 
 text that you wish to copy. 

 Edit menu, click Copy.OR press Ctrl+C 

 the cell where you want to place the range in Excel. 

 Edit menu, click Paste Special to display the dialog box. 



 

 
 

 As box, click the Microsoft Office Word Document Object. 

the Paste link: option to link the pasted data to its source document. To paste and 

embed the information without creating a link, choose Paste: option. 

 OK button. 

 

Excel AND Function 
The Excel AND function returns TRUE if all conditions are TRUE. It returns FALSE if any of 

the conditionsare FALSE. 

To determine whether the return will be TRUE or FALSE, the function evaluates at least 
one mathematical expression located in another cell in thespreadsheet. 
The syntax for theAND function is: 
=AND (Condition1, Condition2, ...)  
condition is something that you want to test that can either be TRUE or FALSE. 
Note: In Excel 2007, the AND function can contain a maximum of 255conditions. For 
earlier versions of Excel, the limit is 30 conditions. 
To use the AND() function (an example) 

 Excel A1 and A2 as follow: 

 



 
 

the AND function will return the following results: 

=AND(A1>10, A1<100) would return TRUE.  
=AND(A1=88, A2="Microsoft") would return FALSE.  
=AND(A1>=50, A1<=88, A2="Microsoft Excel") would return TRUE.  
 
To combine the AND function with IF function 

 ANDfunction inside 

the IF function. 

 spreadsheet, type-in the following values accordingly: 

Cell C1: 75  

Cell C2: 95  

Cell C3: 85  

 

 

 the cell C5 and enter the function below. 

=IF(AND(B1>80,B2>80,B3>80),"Good","Not Good")  

ree of these cells (C1,C2 and C3) contains a value greater than 80, the IF function 

will show the statement Good in cell C5. 

 IF function shows the 

statement Not Good in cell C5. 

be Not Good since the cell C1 contains value that is less that 80. 

 

Excel MIN Function 
 
The Excel MIN function is used to find the smallest value in the selected range of cells 
or a given list of arguments. Text and blank entries are not included in 
the calculations of the MIN function. 
The syntax for the MIN function is:  
 
=MIN (Argument1, Argument2, ... Argument30)  
Argument1, Argument2, ... Argument30 can be numbers, named ranges,arrays, or cell 
references. Up to 30 arguments can be entered in Excel2003. 
To use the MIN function (an example) 

 



 

 
 

 

 =MIN(B1:B5) in cell B7. 

 Enter key on the keyboard. 

appears in cell B7 which is the smallest number in the list. 

 

Excel MAX Function 
The Excel MAX function is used to find the largest value in the selected range of cells or a given 

list of arguments. Text and blank entries are not included in thecalculations of 

theMAX function. 

The syntax for theMAX function is:  
 
=MAX(Argument1, Argument2, ... Argument30)  
Argument1, Argument2, ... Argument30 can be numbers, named ranges, arrays, or cell 
references. Up to 30 arguments can be entered in Excel 2003. 
To use the MAX function (an example) 

 



 

 
 

 

 =MAX(C1:C5) in cell C7. 

 Enter key on the keyboard. 

The answer 953.5 appears in cell C7 which is the largest number in the list. 

 

Excel COUNT Function 
 
Excel COUNT function will return the number of entries (actually counts each cell that 
contains number data) in the selected range of cells. 
Text and blank entries are not counted. If number data is later added to an empty cell in 
the range, the count total is automatically updated. 
The syntax for the function is: 
=COUNT(argument)  
Argument is the range of cells to be totaled.  
To use the COUNT function (an example) 

ng data into cells B1 to C6:  

 
 



 
 displayed. 

 =COUNT(B1:C6) in cell C7. 

 Enter key on the keyboard. 

 

Note: Since dates, times, and formulas are stored as numbers in Excel,the 
COUNT function will include any cells containing these types of data in the total. 
Excel AVERAGE function 
 
The Excel AVERAGE function can be used to calculate the average, or arithmetic mean, 
of values in a selected range of cells. 
The syntax of this function is written as follows: 
= AVERAGE (argument)  
The argument for this function is data contained in the selected range of cells.  
To use the AVERAGE function (an example) 

 

Click on cell C7 where the results will be displayed. 

=AVERAGE( ” in cell C7 (without the quote). 

 

 after the cell range in cell C7 (without the quote). 

 Enter key on the keyboard. 

 

 =AVERAGE(C1:C6) appears in the formula bar. 

 

Excel OR Function 
 
The Excel OR function returns TRUE if one condition are TRUE. It returns FALSE if all 
of the conditions are FALSE. 
To determine whether the output will be TRUE or FALSE, the function evaluates at 
least one mathematical expression located in another cell in the spreadsheet. 
The syntax for the OR function is: 
=OR (Condition1, Condition2, ...)  
condition is something that you want to test that can either be TRUE or FALSE. 
To use the OR( ) function (an example) 

 



 

 

 
 displayed. 

 =OR(C1>500, C2>500, C3>500) in cell C5 

 Enter key on the keyboard. 

The answer TRUE appears in cell C5. 

Note: If any of these three cells (C1,C2, or C3) contains a value greater than 500, the 
output for the OR function in cell C5 will be TRUE. If all three cells have numbers less 
than or equal to 500, the output will be FALSE.  
The Excel RAND function 
 
The Excel RAND function will generate a random number in Excel that is greater than 
or equal to 0 and less than 1. 
The syntax for the RAND function is: 
=RAND( )  
 
To use the RAND( ) function (examples) 

 random number between 0 and 100, use =RAND() *100 

 random number and return only whole numbers use=INT(RAND()*100) 

 random number between 100 and 200, use =RAND() *(200-100)+100 

Note: If you want to use RAND function to generate a random number but don't 
want the numbers to change every time the cell is calculated, you can 
enter =RAND() in the formula bar, and then press F9 key to change the formula to 
a random number. 
Excel Automatic Calculation Capability 
Microsoft Excel AutomaticCalculation feature is an extremely dynamic capability that by 

default automatically recalculates any changes you make to your Microsoft Excelworksheets. 

Sometimes though you may find that due to the complexity and the size of 
yourworksheet, you may want to control when the Microsoft 



 
Excelapplicationrecalculates your workbook or you may find that you just want a 
singleworksheet to be recalculated. 
To control the Excel 2003 Automatic calculation the worksheet, you must first turn the 
default automatic calculation function to manual.  
To turn off the automatic calculation 

 Tools menu and select the Options command. 

 Options dialog box will displayed, select the Calculation tab. 

 
 

 Calculation section, select the Manual radio button. 

 OK button. 

Once you are in manual calculation mode, there are two ways you can force the 
Microsoft Excel to recalculate.  
To use the automatic calculation feature 

 Tools menu and select the Options command. 

 Options dialog box will displayed, select the Calculation tab and then use either 

the Calc Now (F9) or Calc Sheet buttons. 

recalculate the entire workbook, click on the Calc Now (F9) button 

OR press F9 key. 



 
 Calc Sheet button will only update your current worksheet 

OR press Shift + F9. 

 

Copy Excel Worksheet from one Workbook to Another 
If you use MicrosoftExcel, then you’ve run into the situation where the information in a 

worksheet is needed in anotherworkbook. You could go through and copy and paste the cells 

from one worksheet to another, but if you are working with a large spreadsheet, this is way too 

painful. Excelmakes it easy to copy (and even easier to move) worksheetsfrom one workbook to 

another. 

 

 

To copy a worksheet to another workbook 
Open the workbook that you intend to copy the worksheet. (Ex: Book1) 

 another workbook that you want the worksheet copied to. (Ex: Book2) 

 workbook with the desired worksheet that you wish to copy. Right-click on the tab 

of the target worksheet. 

 
 

 Move or Copy… from the menu. 



 

 
 

 Move or Copy window appears, use the To book: dropdown list to select 

the workbook that you want to copy the worksheet to. (Ex: Book2) 

 sheet that you want the copy to be placed in front of. For example, if 

you select the Sheet2, the copied worksheet will be place before the Sheet2. 

 Create a copy check box. 

 OK. You will now have the same worksheet in both workbooks. 

 

Note: To move a worksheet to another workbook, just follow the above steps and simply 

exclude checking the Create a copy check box. 

 

The Excel Shared Workbook - How to Setup? 
Do you know the Excel Shared Workbook function? 
Yes, Microsoft Excel 2003 allows multiple people entering information into the same 

spreadsheet at the same time. This function in Microsoft Excel is called SharedWorkbooks. It’s 

also one of the clear advantages of using Excel over other spreadsheet programs. 

If a user tries to opena Workbook that is already open, then they normally get a 
message saying that the File is locked by a certain user and would you like to open the 
file in Read only mode. However, you can open aworkbook in shared mode by 
following these steps. 
Note: To utilize this feature, make sure your computer is running in the 
network environment. 
To share an Excel file 

 the Excel file that you want to share. 



 
 Tools menu and choose Share Workbook. 

 
 

 Share Workbook dialog box displayed, in the Editing tab, check the Allow 

changes by… check box. 

 OK. This allows other people to use your Excel workbook whilst you are working on it. 

To know the advanced share workbook features 
 the Excel file that you want to share. 

 Tools menu and choose Share Workbook. 

g box displayed, click the Advancedtab. 

There are three areas that you can change: 
1. Track Changes.  
Microsoft Excel allows you to store over 32000 days worth of changes to your Excel file, 
however, there is a catch. All of that information is stored in your file and consequently 
your file will grow exponentially. Most organisations generally work on a maximum of 
30 days (the default). However the value entered simply depends on 
your workbooksrequirements. You can choose the second option - Don't keep change 
history. This simply ensures no changes are maintained. 
2. Update Changes.  



 
This function simply allows you to define how often the spreadsheet changes are 
updated. The most common element users use is the Update Every 15 minutes. What 
this does is to force a save and filter through the data to all the users. One point to 
consider is that if you workbook is relatively large and you are working on a slow 
computer you may want to increase that time to 30 minutes. 
3. Save Changes.  
This defines whose changes will override who's. There are two optionsavailable: 
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 Excel File 
  

 

  

Which option you choose really depends on the type of workbook you have created. 

Another critical issue you need to consider is if somebody disables theExcel 

Shared Workbook function. If this occurs, when you try to save your workbook you 
will be required to save it somewhere else or lose your work. This is one of the 
downsides to the Share Workbook function. 
Excel Drop Down List - How to Create It 
Microsoft Excel 2003 allows you to build your own Excel drop down list! 

Well, this feature is really cool. 
Have you ever been in a situation where you were building a template in Microsoft 
Excel 2003 and it would have been really useful to actually have a drop down list so 
that your users could choose from a preset list, rather than them simply typing in their 
own values? 
This tutorial show you how to create the drop down list in Excel. 
To create an Excel drop down list 

 workbook. On the first worksheet (Sheet1) enter the following data. 

Cell A1 - Title 
Cell B1 - Full Name 

 worksheet (Sheet2) in your workbook. Enter the following data. 

Cell A1 - Title 
Cell A2 - Mr 



 
Cell A3 - Miss 
Cell A4 - Mrs 
Cell A5 - Ms 

 the cell range A2 to A5. We are going to give a name for this range of cell. 

 Insert menu choose the Name option from the menu and click Define.  

 
 

 Define Name dialog box displayed, in the Names inworkbook: text box simply 

type in the name Title and click the OKbutton. 

 worksheet (Sheet1). We will create a drop down list in cell A2 so click 

on cell A2. 

 Data menu, click on Validation. This will open the Data Validation dialog box. 



 

 
 

 Settings tab, in the Allow: drop down list, choose the Listoption. 

 Source: text box, typing in = Title (This is to define the name Title as the range). 

the OK button. 

 the cell A2 and you will now see a drop down box. If you click on the arrow you 

will see the results from your second sheet. 

 
 
Note: If you do not want your range for your list to be on the sameworksheet, then you 
must name the range. 
The Excel Time Function 
 
The Excel Time Function – What its use for? The Excel Time function is to display the 
time in a cell. 
Excel allows you to manipulate dates and times and perform calculations on them. If 
you type a date or time (e.g. 13/3/08 or 9:28) directly into a cell Excel should recognise 



 
it as such. The program will normally align it to the right of the cell and display it in the 
formula bar in a standard format (e.g. 13/03/2008 or 9:28:00 AM). 
The TIME Function Syntax:  
TIME (Hour, Minute, Second)  
Hour is a number from 0 (zero) to 23 representing the hour.Minute is a number from 0 
to 59 representing the minute.Second is a number from 0 to 59 representing the second. 
Examples:  
TIME(12, 0, 0) is equivalent to 12:00:00 p.m.  
TIME(16, 48, 10) is equivalent to 4:48:10 p.m.  
 
To add and subtract times 

dd 1 hour, 35 minutes, 10 seconds to a time in A1, use the function =A1 + TIME(1,35,10) 

 subtract 1 hour, 35 minutes, 10 seconds from a time in A1, use the function =A1 - 

TIME(1,35,10) 

Note: You can add times using the =SUM worksheet function. Just enter all of your 
times as HH:MM:SS, and then use SUM function to add them up. 
The Excel Date Function 
 

In Excel, the Date Function is to display the date in a cell. 

To display the current time or date in a cell, use the NOW() function. Just 
type =NOW() in the cell and it will display the current data and time. 
The DATE Function Syntax: 
DATE (Year, Month, Day)  
To add and subtract dates 

 the cell A1, type a date such as 1/2/08. 

ell A2, if you wish to add 8 days to cell A1, use =A1+9, which gives 9/2/08. 

In cell A3, if you wish to subtract 5 days to cell A1, use =A1-5, which gives 4/1/08. 

 

Excel Comment – Why and how to add and manipulate it in Excel spreadsheets? 
 
Excel Comment is basically short notesthat can be inserted into any cell in Excel. You 
cannot see it if you do not click on the comment. It’s useful for reminders, notes for 
others, or for cross-referencing other workbooks. 
Adding comment toworksheets cells are a great way to explainthe cell contents, 
formulas, offer tips to users or other data in the spreadsheet. 
Basically there are three ways to add a comment: 
1) Using Menu bar 
2) Using mouse right-click 



 
3) Using Reviewing toolbar (not explain here)  
 
To insert a Comment using menu bar method 

 the cell in which you want the comment. 

 Insert menu, click on Comment. You can see something like this: 

 
 

 the cursor is flashing. 

rt a new line, press theEnter key. 

l outside the comment box. 

To insert a Comment using right-click method 
 the cell in which you want the comment. 

-click on the cell and click Insert Comment. 

comment where the cursor is flashing. 

cell outside the comment box. 

To display a specific Comment 
-click the cell which contains the comment. 

 Show/Hide Comment.  

To hide the Comment 
-click the cell which contains the comment. 

 Hide Comment. 

To edit the Comment 
-click the cell which contains the comment. 

 Edit Comment. 

 

To delete the Comment 
-click the cell which contains the comment. 



 
 Delete Comment. 

To change the Comment Shape 
-click the cell which contains the comment. 

 Edit Comment. 

 

 Drawing toolbar, click the Draw icon, point to Change AutoShape, and choose a 

category. 

 

finished, click outside the comment. 

To change the others Comment attribute 
-click the cell which contains the comment. 

 Edit Comment. 

. 

 Format menu, click Comment. 

 



 
 

the Format Comment dialog box displayed, click on the specific tab to change the 

necessary settings. 

margin, etc. 

 OK. 

 

Excel 2003 Data Analysis Tools: Sort Data, Subtotals, Pivot Tables and What-If 
Analysis 
Sorting and filtering lists: With the information you have in a list, you can sort and display 

data that meet certain criteria, insert formulas to calculate subtotals, and create summary tables. 

Subtotals: Excel can quickly goes through the whole table and insertsrows and adds 
totals for the column that you specify. 
PivotTable: It is a quick way toanalyze data such as summing up data in a rectangular 
table shape when you have more than one category to summarize upon. 
What-If Analysis: The ability to assist in decision making with dynamic models. 
A dynamic model uses formulas that instantly recalculate when you change values in 
cells that are used by the formulas. 
Excel Styles and Custom Formatting 
When you format a cell in a worksheet, you can define cell shading, font color, font, font 
size, borders, and much, much more. In short, there are many definitions that can be set 
for a single cell. 
You save all the formatting you have customized. The main limitation is that all custom 
formatting is only saved in the current workbook. Without defining a name for the 
format, it will be difficult for you to find and reuse it. 
Furthermore, when using this method, you cannot save definitions such as font, 
patterns, borders and any of the wide variety of formatting options in the Format 

Cells dialog box. 
Then the Excel Styles are different! 
Changing the definitions of the style will modify the default format of text or numbers 
in the workbook. 
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To change the default Style in a workbook 
 Format menu, click Style. 

 
 

 Style dialog box displayed, in the Style name box, selectNormal. 

 Modify button. 

 Format Cells dialog box displayed, do the necessaryadjustments. 

Number tab: Set the number format that appears in the cells. 

Alignment tab: Change the vertical and horizontal alignments of the text/number in the cells.  

Font tab: Change the font pattern, style, color of the text/number in the cells.  

Border tab: Add or remove the border of the cells.  

 OK. 

The formatting suggested by default in the workbook allows you to enter both text and 
numbers into cells. Formatting a cell for text only by selecting the Text format from the 
list of standard formats appearing in the Category box in the Number tab of the Format 

Cells dialog box will allow only text and not numbers to be displayed in the cell. The 
opposite is also true. If you format a cell for numbers only, you will not be able to 
display text in the cell. 
 
Actually, in the Style dialog box, you can create a wide range of complex styles and 
save each one separately with a unique name. These styles can then be applied 
repeatedly. 
The example below shows you how to format a number so that a negative number 
displayed in brackets and zero (0) is replaced with a dash (-). Choose the font and font 
size. 



 
To create and save custom styles 

 Format menu, click Style. 

OR press Alt+’ . 

 
 

 Style dialog box displayed, in the Style name box, enterNegative Numbers with 

brackets, 0=-. 

 Modify button. 

 Format Cells dialog box displayed, select the Number tab, and in 

the Category: box, select Custom.In the Type: box, change and type in the following number 

format #,##0 ;[Red](#,##0);- ;  



 

 
 

 Font tab. 

 Font: box, select Arial. In the Font style: box, select Regular, and in the Size: box, select 

10. 

 OK. 

 Style dialog box, click OK. 

 

Use the SUMIF Function Correctly 
In Excel 2003, theSUMIF function adds all numbers in a range of cells, based on a given criteria. 

Sometimes you may need to use only certain values inside a range in a summation, 
based on a defined condition. Using Microsoft Excel 2003, this can be calculated with 
the SUMIFfunction. 
The SUMIF function can also use another range of cells to determine whether or not the 
condition is met. 
The syntax for the SUMIF function is:  
=SUMIF(range,criteria,sum_range) 
range is the range of cells you want to evaluate (apply the criteriaagainst).  
criteria is the criterion you want to meet to evaluate the number.  



 
sum_range are the numbers you want to actually sum.  
 
To use the SUMIF function (example) 

 worksheet as shown below:  

 
 
Now, we will use this worksheet to calculate the Smith’s total sales. 

 the cell B10, the cell that will displays the result. 

 Insert menu, click on Function. 

 
 

 Insert Function dialog box displayed, under the Search for a function: box, type in 

sumif and click the Go button. 



 
 Select a function: box, make sure you select the SUMIF and click OK. 

 Function Arguments dialog box displayed, do the followings: 

Range: Select or type in A2:A8 as we want to evaluate within this ranges that contains the name 

Smith’s.  

Criteria: Type in Smith.  

Sum_range: Select or type in B2: B8 as this is the ranges that we want to add up the total sales 

by Smith’s.  

 
 

 OK. This produces the result 85450. That is 35200+22100+28150. 

Note: To find the sum of the sales that exceed 30000, use this function:  
=SUMIF(B8:B8,>30000) 

 



 
 

This produces the result 100700 (35200+22100+28150). 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 
 

 

 

 

 

 

 

Microsoft PowerPoint 
 

The Microsoft PowerPoint is one of the Microsoft Office suites of programs. It primary 
function is to produce presentation materials. 
 
To start a PowerPoint program 
 

 Start button, point to Programs, follow by Microsoft Office and click 

on Microsoft Office PowerPoint 2003. 

 

Note: For previous version of Office - Click on the Startbutton, point toPrograms and click 

on Microsoft PowerPoint.   

 

 right hand sideGetting Started task 

pane provides help to you. 



 

 
 

 If you are not using it, you can click on the Close icon to close it. You also can start by clicking 

on Create a new presentation… at the bottom of the task pane. 

 

 
 
To enter text into a presentation 

rPoint slide pane, there is ‘box’ that labeled ‘Click to add title’. Just simply 

click and enter the text there. 



 
 

  

 

Saving and Closing a presentation 
This feature allows you to store new or existing presentations on disk. If you not save the file, 

you will be unable to view the presentation in the future. Once saved, you can re-open the file 

for viewing or editing.  

 

To save a presentation 
 File menu, click Save.  

 
 

 Save As dialog box displayed, ensure that you are located in the 

folder/disk drive of your choice by clicking the arrow to the right of the Save in: drop down 

box and navigating to your required location. 

 File name: text box. The default file name is Presentation1, you can 

use it or type in a new file name. 

Save button to save. Note: 

Now the presentation is saved to My Documents folder.  

 

To close a presentation 
 File menu, click Close 

OR click Close Window icon. 



 
 displayed, 

giving you the chance to save the presentation prior to closing.  

 
 

 Yes to save the presentation before closing 

OR click No to close without saving changes 

OR click on Cancel to cancel the operation. 

 

To exit Microsoft PowerPoint 
 Close icon displayed on the top-right corner of the screen. 

Creating PowerPoint Presentation Slide ...Where to Start? 
 

The answer is Task Pane. Once you open the PowerPoint presentation program, the task pane 

is display along the right hand side of the screen. 

The Task Pane lists some of the most common tasks you may want to accomplish in 
PowerPoint. The taskpanes are descriptive to help you quickly locate the task you want. 
 
To display Task Pane (if it has been closed) 

 View menu, click Task Pane. 

 
 
To switch to other Task Panes 

 Other Task Panes down arrow and select another Task Pane from the menu.  



 
 

 
To display the New Presentation Pane 

 File menu, click New.  

 
 
To open an existing presentation 

 New Presentation task pane, click From existing presentation…to display 

the New from Existing Presentation dialog box, and select the file you want. 

  

 
 

 Create New button. The presentation is opened and you can do the necessary 

modifications.  

 

To create a new blank presentation 
 Blank Presentation in the New Presentation Pane. 

OR click the New icon on the Standard toolbar. 

 Slide Layout pane that allows you to choose the layout of your slide. 

The layouts contains text, content and both text and content.  



 

 
 

  

 

The Outline and Slides Tabs 
The Outline Tab presents a title and text outline of each slide in your presentation. 
Slides can be edited in the Outline area or directly on the slide. If you prefer to edit your 
text and slides in the Outline area, the Outlining toolbar is dedicated to working in this 
view.  
 
To change the size of the Outline and Slides Tabs 

 

 Zoom box on the Standard toolbar and specify 

the percentage you want. 

 thumbnailsize. The Slides tab area is 

an easy way to navigate your presentation. You can jump to a slide just by clicking on it.  

 
 



 
4 Different PowerPoint Views 
To see the different PowerPoint views, from the Menu bar, click on theView and you 
will see 4 types of view. Click on the particular view to see the effect.  

 
 
1) Normal ViewThe Normal View is the default view in PowerPoint. All slide editing is 
performed in this view. The normal view comprises the Slide Pane, Outline and Slides 
tabs and the Notes Pane. 
 
2) Slide Sorter ViewThe Slide Sorter view displays all slides in your presentation as 
thumbnails. This view is useful to reorder, add, or delete slides. You an also preview 
animation effects applied to each slide. 
 
3) The Slide Show View The Slide Show view allows you to view your presentation as 
a slide show. Your presentation is displayed as a full screen and you can view applied 
animations. 
 
4) The Notes ViewThe Notes Page view displays how notes pages will print. A notes 
page contains a smaller version of the slide and notes entered from the Notes Pane 
underneath the slide. 
The PowerPoint Toolbars and Slide Manipulations 
PowerPoint has 13 toolbars, including the Task Pane. By default, the Standard, 
Formatting, and Drawing toolbars are displayed. 
The other toolbars are used only for specific functionality in PowerPoint. 
This page will let you know the most commonly used toolbars and its function. 
To show a toolbar 

 View menu, choose Toolbars and select the toolbar you want to display (you will 

see a check mark beside a toolbar when it is visible)  

 

To hide a toolbar 
 View menu, choose Toolbars 

 check mark beside a toolbar when it is 

hidden). 

 



 
The Standard Toolbar 
The commonly used action is represented by an icon of the Standard toolbar. When you put 

your mouse pointer over an icon, it is highlighted and a descriptive wording appears. Click the 

icon/action you want to apply to your slide objects. 

 
 
The icons on the Standard toolbar and it function: 

Icon Function 

New To start a new presentation 

Open To open a presentation 

Save To save a presentation 

Permission To sets permissions for opening or changing a presentation 

E-mail To send the presentation as an e-mail 

Print To print the presentation 

Print Preview To change the display to print preview 

Spelling To start the spell checker 

Search To display the Basic Search Pane 

Cut To cut selected text or object to the Clipboard 

Copy To copy selected text or object to the Clipboard 

Paste To paste the last item from the Clipboard 

Format Painter To copy formatting (for duplication purpose) 

Undo To undo the last action 

Redo To redo the last undo action 

Insert Chart To start the Chart Wizard 



 

Insert Table To insert a table 

Table and Borders To display the Table and Borders toolbar 

Insert Hyperlink To insert a hyperlink 

Expand All To expand the title and text for all slides on the Outline tab 

Show Formatting To show or hide character formatting 

Show/Hide Grid To show or hide gridlines 

Color/Grayscale To show the presentation in color, black and white, or grayscale 

Zoom To zoom the Slide, Outline tab area, or Slides tab area 

 

 

The Formatting Toolbar 
The formatting toolbar are located near to the top of your screen as shown here. Each toolbar 

icon on the toolbar has specific function that allows you to change the effects of the objects in 

your PowerPoint slides. 

 

 
 
The icons on the Formatting toolbar and it function: 

Icon Function 

Font To select font styles from the drop-down list 

Font Size To select a font size from the drop-down list 

Bold To apply bold formatting to selected text 

Italic To apply italic formatting to selected text 

Underline To apply underline formatting to selected text 

Shadow To apply shadow formatting to selected text 



 

Align Left To align text or inline objects to the left 

Center To align text or inline objects to the center 

Align Right To align text or inline objects to the right 

Distributed To align text or inline objects distributed across the whole line 

Change Text Direction To change the text direction (horizontal to vertical) 

Numbering To add or remove numbering from a selected paragraph 

Bullets To add or remove bullets from a selected paragraph 

Increase Font Size To increase font size 

Decrease Font Size To decrease font size 

Decrease Indent To decrease the paragraph indent 

Increase Indent To increase the paragraph indent 

Font Color To change the font color with a drop-down list 

Slide Design To display the Slide Design Task Pane 

New Slide To insert a new slide 

 

 

To insert a new slide 
 Insert menu, click New Slide.  

OR click the New Slide icon on the Formatting toolbar 

 

To insert a duplicate slide 
 Insert menu, click Duplicate Slide. 

 



 
Copy and Paste Slides 
You can copy and paste slides in Normal View with the Outline and Slides tabs or 
in Slide Sorter view. 
 
To copy slides with the Outline tab 

 

 Copy icon on the Standard toolbar. 

OR right-click on the slide icon and select Copy. 

 

To paste the slide 
 

 Paste icon on the Standard toolbar. 

OR right-click on the slide icon and select Paste. 

Note: You also can copy and paste the slide with the Slides tab or in the Slide Sorter view. 

 

Deleting Slides 
You can delete slides in Normal View with the Outline and Slides tabs or in Slide 

Sorter view. 
 
To delete slides with the Outline tab 

de icon of the slide you want to delete. 

 Edit menu, click Delete Slide.  

OR right-click on the slide icon of the slide you want to delete and select Delete Slide. 

 

To delete slides with the Slides tab 
you want to delete. 

 Edit menu, click Delete Slide. 

OR right-click on the slide thumbnail of the slide you want to delete and selectDeleteSlide. 

 

To delete slides in Slide Sorter view 
 

 Edit menu, click Delete Slide. 
OR right-click on the slide thumbnail of the slide you want to delete and selectDelete 

Slide. 



 
PowerPoint Design and AutoContent Wizard 
PowerPoint design template contains color schemes, slide and title masters with custom 

formatting and styled fonts, all designed to create a particular look. 

After you apply a PowerPoint design template, each slide you add has the same 
outlook. You can use the New Presentation Pane to create a new presentation from 
adesign template. 
 
To create a new presentation from a design template 

 From design template in the New Presentation Pane. 

 
 

 design templates available below the pane. For example, if click 

on Mountain Top template, you will see the slide as follow: 

 
 

round of the slide is included and you just need to insert the text as you wish. 

Looking for free PowerPoint design templates, click here.  
 
PowerPoint AutoContent Wizard 
The AutoContent Wizard allows you to create a presentation based on suggested content and 

design. There provides the idea for your presentation so you just need to modify the suggested 

http://www.msoffice-tutorial-training.com/powerpoint-template.html


 
idea or you can add your own points.  

 

To create a new presentation using the AutoContent Wizard 
 From AutoContent Wizard… in the New Presentation Pane. 

 AutoContent Wizard dialog box displayed, click Next to continue.  

 
 

that you wish to create. If you click on 

the All button, then you can use the scroll bar to move down the list and then select the type of 

presentation that you are interested in. 

Note: Some options displayed may not be installed on your system and you may ask to insert 

the Microsoft Office installation CD to install it before use. 

 

 Next button to continue. 

default, On-screen presentation was selected. 

 Click Next button to continue working through the Wizard. 

 

 Next button to continue. 

 Finish to complete the AutoContent Wizard. 



 
ng the guidelines supplied, 

modify the content to meet your requirements and needs. 
PowerPoint Slide Manipulations 
PowerPoint Slide Layout 
A PowerPoint slide layout refers to how placeholders are arranged on a slide. Each slide layout 

contains a different combination of text and content placeholders. Typically a slide is divided 

into title and text placeholders. 

 

 

 

To display the Slide Layout Pane (if it has been closed) 
 Format menu, click Slide Layout. 

 

To apply a text layout to a slide 
 the Slide Layout Pane, Text Layouts section click on the particular layout you want. 

Title and Text, Title and 2-Column Text, Title and Vertical Text, and Vertical Title and Text. 

 

To apply a content layout to a slide 
 Slide Layout Pane, Content Layouts section click on the particular layout you want. 

 Clip Art, Pictures, Tables, Diagrams or Organization 

Charts, or Media Clips.  

 

To apply text and content layouts to a slide 
 Slide Layout Pane, Text and Content Layouts section click on the particular layout 

you want. 

 

 

To apply other layouts to a slide 
the Slide Layout Pane, Other Layouts section click on the particular layout you want. 

content layouts. 

 



 
PowerPoint Slide Background 
Backgrounds can be applied to the PowerPoint slides, handouts, and notes. The 
Background options that you can change include colors,gradients, textures, patterns, 
and pictures. 
 
To select a Slide Background Color 

 Format menu, click Background. 

 
 

select the color you wish to apply to the slide background. 

 More Colors to choose from a wider selection of colors. 

 

To select a Slide Background Fill Effect 
 Format menu, click Background. 

 Fill Effects. This will open a Fill Effects dialog box. 

colors as you like. 



 

 
 

 OK. 

 the Background window, there are 4 buttons: 

Apply to All To apply the formatted background to all slides. 

Apply To apply the formatted background to the current slide only. 

Cancel To cancel the formatted background. 

Preview To preview what the slide background will look like. 

 

 

button that suit your needs.  

 

To get some free PowerPoint slide background, click here.  
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PowerPoint Slide Headers and Footers 
Headers and footers consist of the text, slide or page number, and date you want at the top or 

bottom of your slides. You can use headers and footers on single slides or all slides. 

 

To insert slide Headers and Footers 
 View menu, click Header and Footer. This will display theHeader and 

Footer dialog box. 

 
 

 date and time, tick the Date and time check box. 

 Slide number check box. 

 Footer check box ischecked and type in your 

desired text. 

 Click Apply to apply to the current slide. Click Apply to All to apply to all slides.  

 

Bullets and Numbering 
Bullets and Numbering is useful tool to divide your slide into points. Bullets and 
numbering come in different styles, sizes, and colors that you can apply.  
 
To add or remove bullets 

 



 
 Bullets icon on the Formatting toolbar.  

 

To change bullet style 
 Format menu, click Bullets and Numbering.  

 
 

the bullet style you want. 

 OK.  

 

To create Custom Bullets 
 Format menu, click Bullets and Numbering. 

 Bullets and Numbering dialog box, click on the Customizebutton to display 

the Symbol dialog box.  



 

 
 

 bullet and click OK. 

 

To add or remove numbering 
 

 Numbering icon on the Formatting toolbar. 

 

To change numbering style 
From the Format menu, click Bullets and Numbering. 

 Numbered tab. Click on the numbering style you want. 

 OK. 

 

To change Bullets or Numbering Color 
 Format menu, click Bullets and Numbering. 

 the Color drop-down menu box. 

 you wish to apply to your bullets or numbering. 

 OK. 
The PowerPoint Drawing Toolbar 
 
The PowerPoint drawing toolbar provides many commands for creating and editing 
graphics. The toolbar normally located at the bottom of the PowerPoint screen. 



 

 
To display the drawing toolbar 

 View menu, point to Toolbars and click on Drawing. 

Here are the PowerPoint Drawing toolbar icons and its function: 

Draw 
Enables you to apply different adjustments to the objects that you 

draw. 

Select Objects 
Enables you to select a particular drawing object. For selecting 

multiple objects, keep the Shift key depressed. 

AutoShapes 
Click on the AutoShapes icon to bring up a list of shape menus. Drag 

the mouse on to a selected set of shapes and select one from the list. 

Line 
Used to draw a line. To draw perfectly horizontal or vertical line, 

depress the Shift key while dragging. 

Arrow Used to draw a line with an arrowhead on it. 

Rectangle 
Used to draw a rectangle. To draw perfect square, depress the Shift 

key while dragging. 

Oval 
Used to draw an oval. To draw perfect circle, depress the Shift key 

while dragging. 

Text Box Used to draw a text box into which you can enter text. 

Vertical Text Box 
Used to draw a vertical text box into which you can enter the text 

vertically. 

Insert WordArt Used to insert different pattern of WordArt to your presentation. 

Insert Diagram or 

Organization Chart 
Used to insert diagram or organization chart. 

Insert Clip Art Used to insert clip art. 

Insert Picture Used to insert picture from the location that you specify. 

Fill Color Used to fill a drawing object with a color or shading. 



 

Line Color Used to define the line color of a drawing object. 

Font Color Used to formats the selected text with the color you pick. 

Line Style Used to define the line style used by an object. 

Dash Style Used to define the dashed line style used by an object. 

Arrow Style Used to define the arrow line style. 

Shadow Style Click the shadow style you want for the selected object. 

3-D Style Click the 3D style you want for the selected object. 

 

 

To add an AutoShape 
 AutoShapes icon on the PowerPoint Drawing toolbar to display 

the AutoShapes menu. 

 AutoShape you required to select it. 

 where you want theAutoShape to begin. 

 AutoShapeon the slide. 

 

To further adjust the shape, select the shape and drag the adjustment handle. 

 

To draw a line 
 Line icon from the PowerPoint Drawing toolbar. The mouse pointer changes into a 

cross-hair pointer when moved over the slide. 

n where you want the line to begin and drag. Release the mouse button 

when you want the line to end. 

 

To draw an arrow head 
 Arrow icon from the PowerPoint Drawing toolbar. The mouse pointer changes into 

a cross-hair pointer when moved over the slide. 



 
egin and drag. Release the mouse button 

when you want the arrow to end. 

 

To draw a rectangles 
 Rectangle icon from the PowerPoint Drawing toolbar. The mouse pointer changes 

into a cross-hair pointer when moved over the slide. 

cation where you want the rectangles or ovals to begin and drag to draw the 

object. When you have finished, release the mouse button. 

 

To draw an ovals 
 Oval icon from the PowerPoint Drawing toolbar. The mouse pointer changes into a 

cross-hair pointer when moved over the slide. 

object. When you have finished, release the mouse button. 

 

To create a text box 
 Text Box icon on the PowerPoint Drawing toolbar. 

-hair pointer using the mouse and depress the left mouse button. Drag the 

mouse until the size you require, then release the mouse button. 

ill appear in the document, and you can now type in text or import a graphic 

into the text box. 

 

To create a vertical text box 
 Vertical Text Box icon on the PowerPoint Drawingtoolbar. 

-hair pointer using the mouse and depress the left mouse button. Drag the 

mouse until the size you require, then release the mouse button. 

into the text box. 

 

To create a WordArt object 
 the Insert WordArt icon on the PowerPoint Drawing toolbar. 



 

 
 

 WordArt Gallery select a style to use and click on the OKbutton. 

 Edit WordArt Text dialog box displayed, enter the required text in the ‘Your Text 

Here’ area. 

on the OK button to insert the WordArt. You can move theWordArt to the intended 

place in the slide. 

 

To create a Diagram or Organization Chart 
 Insert Diagram or Organization Chart icon on the 

PowerPoint Drawing toolbar. 



 

 
 

 Diagram Gallery select a diagram type and click on the OKbutton. 

 

To insert a clipart 
 Insert Clip Art icon on the PowerPoint Drawing toolbar to open the Clip 

Art side pane. 

 
 



 
 Search for: field allows you to enter one or more words pertaining to a specific graphic 

you wish to search for. Once enter, click on Gobutton to begin search. Note: Most of the time, 

this required Internet connection. If you do not have, then… 

 Organize clips… (blue color wordings) 

 Microsoft Clip Organizer window, double-click on the Office Collections.  

 
 

-categories such as academic, agriculture, etc. Each category has 

few clip arts on it. 

ure and selectCopy.  



 

 
 

n where you wish to place theclip art. Click 

the Paste icon on the Formatting toolbar. 

 

To insert a picture 
 Insert Clip Art icon on the PowerPoint Drawing toolbar to open the Insert 

Picture dialog box. 

rt and click on Insert button. 
PowerPoint Design Template 
 
You can create a PowerPoint design template of your own. 
Starting from a blank design, you can add elements such as a slide background, color 
scheme, font size and style, placeholder size and position, etc. Then, save the file 
as PowerPoint template. 
To create your own design template 

 Standard toolbar, click New icon. 

 View menu, point to Master and click on Slide Master. This will switch your slide 

to Master view. 

some of the changes that you can make to the slide master: 



 
1. To change the fonts formatting, click the text or the placeholder containing the text On 

the Format menu, click Font, and then make your selections in the Font dialog box. 
Click OK when finish. 

 

 

2. To change the background, on the Format menu, clickBackground, make selections in the 
dialog box, and then clickApply. 

 

 

3. To insert a picture, text box, a shape, etc, use the buttons on theDrawing toolbar. 
 

 

4. To move a placeholder, click it to select it, and then point to the placeholder border. When the 
pointer becomes a four-headed arrow, drag the placeholder to a new location. You also can 
resize the placeholders. 

 

the File menu, click Save As. 

 
 

 Save As dialog box, in the File name: box, type a name for your template, and then, 

in the Save as type: box, click the drop down menu and select Design Template. 



 
 Save.  

 
Note: The template is automatically saved to the Templates folder. After you exit and 
restart PowerPoint, the template is available in the Slide Design task pane, in 
alphabetical order by file name, under AvailableFor Use.  
PowerPoint Slide Design 
 
The PowerPoint Slide Design Pane offers three easy ways to make your presentation 
look professional, colorful, and interesting: Design Templates, Color Schemes, and 
Animation Schemes. 
 
To Display the Slide Design Pane 

 Slide Design icon on the Formatting toolbar 

OR From the Format menu, click Slide Design. 

 

1) PowerPoint Slide Design - Design Templates 
Design Templates offer a quick and easy way to provide an attractive and interesting 

background to your presentation. For more informationabout the design templates, click here.  

 

2) PowerPoint Slide Design - Color Schemes 
Color Schemes quickly add to or change the colors of your slides including the background, 

title text, body text, fills, shadows, and hyperlinks. 

A default color scheme is applied to your slides when you select a Design Template. 
Each Design Template includes additional Color Schemes you can use. 
 
To apply a Color Scheme to One Slide 

Open the PowerPoint slide where you want to apply the Color Scheme. 

 Scheme you want. 

 Apply to Selected Slides. 
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Note: If you wish to apply the color scheme to all slides, click Apply to All Slides.  
 
To customize Color Schemes 

 Slide Design – Color Schemes Task Pane, clickEdit Color Schemes… 

 open the Edit Color Scheme dialog box.  

 
 



 

click Change Color… button. 

 OK. 

 click Apply button. 

 

3) PowerPoint Slide Design - Animation Schemes 
Preset Animation Schemes make it easy to animate your slide show. Animations are 
divided into subtle, moderate, and exciting schemes, and generally apply animations to 
titles, bulleted lists, and paragraphs. 
 
To apply an Animation Scheme to One Slide 

 the PowerPoint slide where you want to apply the Animation scheme. 

 the Slide Design – Animation Schemes Task Pane, and select the animation you want. 

 
 

utomatically be applied to the current slide. 

 

To apply an Animation Scheme to All Slides 
 



 
 Apply to All Slides button at the bottom of the Slide Design – 

Animation Schemes Task Pane. 
PowerPoint Slide Show 

 

Once you finish created the presentation slides, what is next? 

PowerPoint SlideShow. 

Yes, PowerPoint slide show is the slide thatrunning in 'full screen' mode. That is the 
actual show screen that your audiences will see, so run it with just a click or press of a 
button. 
 
 
To view a Slide Show from the first Slide 

 View menu, click Slide Show.  

 

To view a Slide Show from the current Slide 
 the Slide Show icon at the bottom left of the PowerPoint screen. 

 
 
To move to the next slide in a Slide Show 

 Enter key.  

 

To move to the previous slide in a Slide Show 
 Backspace key.  

 

To move to a specific slide in the Slide Show 
-click on the current slide (in the slide show) and select Go to Slide. 

e you want.  

 

To Pause the Slide Show 
-click on the current slide (in the slide show) and select Pause.  

 

To Turn the Screen Black 
-click on the current slide (in the slide show). 

 Screen and click on Black Screen.  

 



 
To Turn the Screen White 

-click on the current slide (in the slide show). 

 Screen and click on White Screen.  

 

Pointer Options 
The Automatic Pointer is the default pointer in a PowerPoint slide show. When set to automatic, 

the pointer disappears after fifteen minutes of inactivity.  

 

To use the arrow pointer 
  

 

To select the arrow pointer 
-click on the current slide (in the slide show). 

 Pointer Options and click on Arrow.  

 

To change the pointer to a pen 
 show. 

-click on the current slide (in the slide show). 

 Pointer Options and click on Pen.  

 

To change pen color 
t-click on the current slide (in the slide show). 

 Pointer Options and Ink Color. 

  



 

 
PowerPoint Presentation Printing 

 

Is the presentation printing easy? Seethe guides below to find your answer. 

In order to print,MicrosoftPowerPointrequires that a printer driver has been installed in 
your computer that matches the printer you are currently using. 
ON the printer and load some papers to the printer tray. 
 
To change Page Setup options 

 File menu, click Page Setup. 

 Page Setup dialog box displayed, click on the down arrow on the Slides sized 

for: box and choose one of the following options: 



 

 
 

On-screen Show 
Page orientation is set to landscape. Width is set to 10 inches, height to 7.5 

inches. 

Letter Paper (8.5 X 

11 in) 

The width is set to 10 inches, height to 7.5 inches. To allow your slides to 

fill the page, the orientation is set to landscape. 

Ledger Paper (11 X 

17 in) 

The width is set to 13.32 inches, height to 9.99 inches. Page orientation is 

set to landscape. 

A3 Paper (297 X 420 

mm) 

The width is set to 14 inches, height to 10.5 inches. Page orientation is set 

to landscape. 

A4 Paper (210 X 297 

mm) 

If the orientation is set to landscape, the width is set to 26 cm, height to 18 

cm so that the slide fill the A4 page. 

B4 (ISO) Paper (250 

X 353 mm) 
The width is set to 11.84 inches, height to 8.88 inches. 

B5 (ISO) Paper (176 

X 250 mm) 
The width is set to 7.84 inches, height to 5.88 inches. 

35 mm Slides 
The width is set to 11.25 inches, height to 7.5 inches. If the orientation is 

landscape, the slide content will fill the slide area. 

Overhead 
The width is set to 10 inches, height to 7.5 inches. To allow your slides to 

fill the page, set the orientation to landscape. 

Banner The width is set to 8 inches, height to 1 inch. 

Custom Select the dimensions you require by clicking on the up and down arrow 



 

in the Height and Width boxes. 

 

 

number in the Number slides from: box. 

 Orientation section, select the orientation for your slides in theSlides box. Choose 

either Portrait or Landscape. 

 Notes, handouts & outline section, select the orientation for your notes, handouts and 

outline. Choose either Portrait or Landscape. 

 OK.  

 

To print 
 File menu, click Print.  

 
 



 
 Print dialog box has 4 sections: Printer, Print range, Copies and Print what. 

Printer section 
e currently selected printer. Make sure that in 

the Name: box display the printer name that you are going to print to.  

Properties Button 
Click on this button will let you set the printing paper size, paper orientation, color or 

black/white printing, etc. This is very important, as it will affect the printing output. 

Click OK when finish and return to thePrint dialog box. 

Print range section 
This section allows you to define what to print. The options available are: 

All – the whole presentation. 

Current Slide – the currently selected slide. 

Selection – a subset of the presentation selected by the mouse. 

Slides – a selection of continuous and/or non-continuous slides by entering the slide 

numbers. 

Copies section 
This region allows you to enter the number of copies required and whether you want them 

collated or not. 

Print what section 
It contains the following options: 

Print what: 

– The PowerPoint normal slides. 

– Allows you to print 2, 3 or 6 slides in a page (normally to be 

distributed to the audiences) 

– the notes page of your slides. 

- The outline view of your presentation slides. 

Color/grayscale: 

- This will print using the color settings as in the slides. 

- This will print using grayscale color adjustment. 

- This will print purely black and white color. 
 



 
Scale to fit paper - Tick the option will fit the paper size printing. 
Frame slides - Tick the option will print the slide frame as well. 
 
When everything finish, click the OK button to start printing. 
Effective PowerPoint Presentation, What to Prepare? 
 
Here are some guides when you do PowerPoint presentation that you need to pay 
attention to: 
 
Physical Environment Planning 
1) Room size - in relation to the anticipated number of attendees. Avoid over-crowding, or too 

large a room for a small audience. 

 

2) Light sources - Brightest light on the presenter where possible, medium light over the 

audience, and less light around the screen, or between the screen and the projector, if possible. 

 

3) Electrical socket outlets – the availability for setting up equipments and make sure it is 

functioning. 

 

4) Electrical extension cables – approximately 18 feet/6 meters long or at least can connect 

from socket outlets to the equipments. 

 

5) Projector and screen - for the viewing by a larger audience. 

 

6) Projector and computer - Consider simultaneous display. Having a laptop at the podium so 

the presenter can see exactly what the audience is seeing on screen without having to turn 

his/her head, and at the same time, retain eye contact with the audience. 

 

7) Microphone, speakers and amplifier - for the presenter in a large venue. Test the 

functionality and ensure the person in-charge is qualified to control the amplifier. 

 

8) Cordless Presenter – enables the presenter to activate slides, indicate key points in the slide 

from a distance. 

 

 

 

PowerPoint Presentation – A quick guides 
(1) Begin the slide show by pressing the F5 key.  

 

(2) Move to the next slide by pressing the ENTER or by clicking the left mouse button. 

 



 
(3) Go back to the previous slide by pressing BACKSPACE, or the left arrow key. 

 

(4) To end the slideshow before it is complete press ESC key on the keyboard. 

 

(5) A pen tool is available for drawing on the screen with the mouse. Press CTRL+P and the 

pointer will change to a pen that allows you to draw freehand on the screen using the mouse. 

Press the E key to erase all pen strokes. Press CTRL+A to disable the pen feature and revert the 

pen back to a pointer arrow. 

 

(6) If you would like to use the pen to draw on a blank screen during a presentation, press 

the B or W keys to turn the screen to black/white. Press B or W again to return to the 

presentation when you are finished drawing. 

 

(7) To hide the pointer and button from the screen press the A key. 

 

(8) Be sure to preview the slide show using a projector if one will be used during the 

presentation. Words or graphics that are close to the edge of the screen may be cut off by the 

projector.  

 

 

 

Delivering PowerPoint Presentation with Credibility 
1. Set up your "Authority". 

Early on, explain why you have the right to talk to them on the topic by highlighting relevant 

elements of your background: 

er, say so. 

 

d interviewed experts, say so. 

working in (this other field), I had considerable experience in (the topic) that I believe applies 

here..." 

 

2. Demonstrate Understanding.  

Prove that you know what you're talking about by: 

 



 
g the audience's language. Learn and use the terms your audience knows to facilitate 

understanding and demonstrate that you took time to prepare. Be careful with acronyms and 

jargon. 

ou do about some 

aspects of the matter at hand, but that your study gives you a good grasp of what needs to be 

done. 

 

3. Establish Facts.  

Identify the source of the information you are using such as: 

 

 

rs in the Southwest concludes..." 

 charts and graphs. 

 

4. Tell the truth.  

Your audience will never really trust you if they catch you in a lie. Avoid the temptation to 

pretend to know the answer to a question and fake it. It's better say "I don't know" and find the 

answer from the group or commit to research the issue after the session. 

 

5. Be yourself.  

Trying to be someone you're not is almost as bad as telling a lie. It's also a lot more work. You 

can, however, take up a temporary role to illustrate your understanding of the views of others 

by using introductory phrases such as: 

s the parent of a teenage girl, I might be thinking...." 

 

 

6. Doing what you say you will do. 

 

ks, allow for frequent breaks. 

  

 

7. Speak with conviction and enthusiasm.  

Say it like you mean it, and your audience will believe in your words. If you sound tentative, 

people will book you as "squishy" and question your commitment on the matter. Eye contact is 



 
extremely important. 

 

Establishing solid credibility improves your chances of success in several ways: 

 

wondering who you are or where you got your information 

recommendations 

 builds your reputation for future presentations! 
How PowerPoint Help Feature Can Solve Your PowerPoint Problem? 

 

Having trouble when using PowerPoint? Use the PowerPoint Help feature to solve your 

problem! 

 

Below are the step-by-step guides that you can use to solve almost all your PowerPoint related 

difficulty. Thanks to this PowerPoint useful feature. 

 

Note: It’s recommended that you connect to the Internet to use the PowerPoint Help feature.  

 

 

 

To start the Microsoft PowerPoint Help 
 Microsoft Office PowerPoint Help icon located on theStandard toolbar. 

 
 

 PowerPoint Help task pane display at the right hand side of your 

PowerPoint screen. 

 Search for:text box.  



 

 
 

 Enter. Then, the search results are displayed, 

with 30 results as shown here.  

 
 

PowerPoint, then click on the Animate text and objects. 

 another window that guides you to do the text animation.  



 

 
 

 more information. When finish, click on the Close 

button. This will bring you back to the Search Resultspane. 

 Back button from theSearch Results pane. 

You also can use the Forward button.  

 
PowerPoint Slide Master - What you can do with it? 
 
What is PowerPoint Slide Master? 

Slide Masters are basically templates that 



 
are used to create a new presentation. You can use the existing PowerPoint templates or create 

new ones. 

The PowerPoint slide master contains text placeholders and placeholders forfooters, 
such as the date, time, and slide number. When you want to make a global change to 
the look of your slides, you don't have to change each slide individually. Just make the 
change once on the slide master, and PowerPoint automatically updates the existing 
slides and applies the changes to any new slides you add. 
To create a new presentation template file (Slide Master) 

 File menu, click New. This will display the New Presentation pane on the right 

hand side of the screen. 

 
 

 From design template link. This will displayed a list of design templates. 

presentation template. For example, choose 

the Firework.pot template. 

 View menu, point to Master and click on Slide Master. The following slide will be 

displayed. 



 

 
 

u can use the 

drag and drop method to move items around the page. 

 Clip Art, graphics, company logo, etc to the slide. 

you have finished your customization, click on the File menu and choose Save 

As command. 

the File name: box, enter a name for the new template. 

 Save as type: box, click on the drop down menu and selectDesign Template (*.pot) . 

he Save button and close the file. 

 on the Filemenu and 

select New command. Your new template will normally be displayed in the Recently 

Used section of the Slide Design pane. 

To insert the slide header and footer 
 View menu, point to Master and click on Slide Master. 

 View menu again, click Header and Footer to display the header and footer dialog 

box. 



 

 
 

 date and time, tick on the Date and time check box. You can decide that this is 

entered as a fixed date or one that updates each time you print the presentation. 

 Slide number check box. 

 Footer option and enter the required text. 

o disable the display of information on the title page, tick the Don’t show on title 

slide check box. 

 Apply to All button. 

To make a slide different from the slide master 
o the font, color, 

background, etc as required. 

 individual slide will not be reflected on any other slides, or Master 

Slide. 

To reapply the slide master formats to the slide 
Point Slide Master formatting. 

 Format menu, click Slide Layout. 

 Reapply. The text and placeholders on the slide revert to theSlide 

Master format. 



 
Presentation Planning  
– The Essential 10 Steps 

 
PowerPoint presentation planning is the important preparation steps before you go to 
the stage. Follow the 10-step guides here can lead you to deliver the presentation just 
like the pros. 
 
Step 1: Identifying Audience and Purpose 
To start your presentation planning, think of your audience and ask yourself these 
questions: 

 many people will be attending the presentation? And the average age? 

 

 

 

 

Step 2: Choosing Presentation Method 

-led presentations – the speaker is the main attraction, the slide and handout are the 

add-on 

-running presentations – the slides carry the entire burden as there is no live speaker and 

handouts 

-interactive presentations – the audience chooses when to advance slides and what to 

see next. 

 

 

Step 3: Choosing Delivery Method 

PowerPoint (recommended) 

 

 

 

 

 

 

Step 4: Choosing Appropriate Template and Design 

PowerPoint includes 2 kinds of templates: Design templates and AutoContent Wizard. 
Some suggestions here: 



 
 

 

ed on screen, use high contrast color 

 

It’s best if all slides use the same design and color scheme. Use the appropriate fonts 
color and size. 
 
 
Step 5: Developing the Content 
Type the text to the PowerPoint slides. Your content may include charts, graphics, 
linking, video, and other necessary elements. 
You also can enhance your slide elements with visual image. This can be achieve by 
changing the font size, reposition the slide element (e.g. logo), etc. 
 
 
Step 6: Adding Multimedia Effects 
The multimedia effects are important for developing the audience interest: 

 short video and soundtracks whenever appropriate 

– how to proceeds/moving from slide to slide 

– simple movement of the objects on a slide 

 

 

Step 7: Creating Handouts and Notes 

This step is only applicable only for speaker-led presentations. It can be printed either 
in black and white or color. You can print from one to nine slides per page. 
 
 
Step 8: Rehearsing Presentation 
The goals for rehearsing are different for each type of presentation: 

-led presentations: Check the presentation slides to ensure they are complete, 

accurate and in the correct order. 

-running presentations: Ensure the content is correct, audience able to read the text on 

each slide (even the slow reader can catch it) and the voice matches the slide description. 

-interactive presentations: Ensure the link accuracy. Each button link or hyperlink to 

the web site is working fine. 



 
Also, the main purpose here is you can completely deliver your presentation within the 
given time frame.  
 
 
Step 9: Giving Presentation 
Enough preparation is the key to deliver your presentation with full confidence. Speak 
as loud as needed with proper eyes-contact and body language. 
 
 
Step 10: Refining Your Work 
Immediately after the presentation, jot down your responses to these questions: 

 

en or handouts? Was that what you 

intended? 

 speaking? 

 

 omit? 

ons and animations add the entertainment value or distracting? 

clips play with adequate quality, appropriate and useful? 
 
Note: This step is very important in the entire of presentation planning process, make 
sure you fine-tune it, correct the mistakes and you will be on the way towards 
excellence. 
PowerPoint 2003 Package for CD Feature 
 

The new PowerPointPackage for CDfeature 

is introduced in PowerPoint 2003 which replaces the earlier version of Pack and Go. 

 

It allows users to prepare a presentation for distribution and run on a computer that does not 

have PowerPoint installed. The feature allows you to write your files to a folder on your 

computer hard disk or copy to a CD.  

 

 

To use the PowerPoint Package for CD 
Open the presentation that you want to package. If you are working with a new presentation, 

it is recommended that you save the presentation first. 

-RW disc into the CD drive. 



 
 File menu, click the Package for CD.  

 
 

 Package for CD dialog box displayed, in the Name the CD:column, give a name 

for the CD. 

name of the folder your files are written to. 

 Add Files button allows you to add more presentations or other files to your archive. 

You need to browse the files you would like to include and click the Add button. 

 Options button will display the dialog box.  

 
 
 
PowerPoint Viewer: Select it will allow you to run PowerPoint presentation on 
computers that do not have the PowerPoint installed.  



 
Select how presentations will play in the viewer: To prevent presentations from 
playing automatically, or to specify a different automatic play option.  
Embedded TrueType fonts: Select it to include TrueType fonts.  
Help protect the PowerPoint files: To require a password to open or edit all packaged 
presentations, enter the password that you want to use.  

 OK to close the Options dialog box. 

 Copy to CD button. Your files will be written to the CD. 
 
Note: If you are using Windows 2000, you must first write your files to a folder. From 
the folder, you can copy the Package for CD archive to a CD.  
How to Change the PowerPoint AutoRecover Interval? 
 
PowerPoint AutoRecover feature can automatically save your presentation/document 
for you at a specified interval. This lets you recover your document if tragedy strikes. 
So, if you are working on an important document, you should decrease this interval. 
To change the AutoRecover Interval in PowerPoint 2003 

 

om the Tools menu, click Options. 

 Options dialog box displayed, click the Save tab. 



 

 
 

on. 

minutes or you can 

directly highlight and type-in a number. 

 OK button. Microsoft PowerPoint will now automatically save your 
presentation for you at the specified interval. 
 
Note: The above steps can be use in Microsoft Office Word and Excel. 
Add Slide from other PowerPoint Presentations 
You can insert or add slide that previously-made from one PowerPoint 2003 presentation into 

another. This can save your time from creating the new slide.  

To add/insert slides from other presentations 

 the presentation that you want to insert slides. 

 Insert menu, click Slides from Files. 

 Slide Finder dialog box displayed, click Browse button and locate the presentation 

that has the slide(s) you want to insert. 



 
in the Select slides: section. Drag the slider to see other slides in the 

presentation. 

 

 

 Select slides: section, choose the slide(s) 
Slide Transitions 

Slide Transitions are special effects you can add to a slide show to determine how one 
slides moves to the next. It's the visual movements as one slide changes to another. 
The transition effect for a slide refers to how the slide enters, not how it exits. So, when 
you are creating your presentation slides, do remember to apply the feature otherwise 
your presentation will be quite boring and not attractive as all the slides movements are 
same. 
PowerPoint has many different slide transition options to choose from to enhance your 
slide show. Please note that transitions add a nice little flourish to your presentation, 
but you don't want them to distract unduly from your message. 
To add transitions to a slide show  

 Change to Slide Sorter view by clicking on the Slide Sorter icon (at the left hand side bottom 
of the screen). 

 

 



 
 From the Slide Sorter view, click/select the slide that you wish to apply the slide transition. 
 From the Slide Show menu, select Slide Transition to display the Slide Transition pane in 

the right-hand side of the screen. 

 

 Under the Apply to selected slides: section, select the transition you want from the lists. 
 Click on the Play button to see a preview or to see the real live action, just click the Slide 

Show button. 
 Under the Modify transition - Speed: section, select how fast you want the transition to take 

place by selecting Slow, Medium or Fast option. 
 Under the Modify transition - Sound: section, you can choose the sound for the slide 

transition. 
 To apply the transitions of all slides in the presentation, click on Apply to All Slides. 

Use Slide Show Timing and Annotations to Control Your Presentation 

Setting the slide show timing allow you to automate your presentations! 



 
Each slide in your slide show can have a different timing applied to it. For instance, the 
first slide may appear for 10 seconds, the second for 20 seconds, and the third for 5 
seconds. That means you preset the slide timings and let the presentation run 
automatically. 
One drawback for this is that this feature may not suitable for all presenter. For 
example, if you are required to do lots of explanations during the presentation process, 
this feature may not suitable as you cannot control the timings. 
 
To set the slide show timing  

 From the Slide Show menu, click Rehearse Timings. From the pop-up show, the top left-
hand corner of the screen a button is displayed with a clock. 

 

 The clock shows how long the slide has been on the screen. When you are ready to move to 
the next screen, click anywhere on the slide, or on the clock button. 

 When you reach the end of the presentation a dialog box is displayed telling you the total time 
taken for the slide show. 

 

 You will be asked if you want to record the new timings and use them in slide show view. 
Select Yes to record the new timings, or No to cancel them. 

 
To see the timing for each slide  

 Switch to Slide Sorter view and the timings for each slide will be displayed below the slide. 

 
 
Slide Show Annotations  
The slide show annotations feature in PowerPoint allows you to write or draw 
anything you like freely during the slide show in order to highlight the point or grab 
the audiences attention. 
 
To add annotations during a slide show  

 Begin the slide show by clicking on the Slide Show icon or just press Shift + F5. 
 Right-click anywhere in the slide to display the pop-up menu. 
 From the pop-up menu, point to Pointer Options and select either Ballpoint/Felt Tip 

Penor Highlighter option from the sub-menu displayed. 



 

 

 Hold down the left mouse button to write or draw anything on the screen. 
 To erase the annotations during a slide show press the E key. 
 When finished, press the Esc key to turn the feature off. 

PowerPoint Hidden Slides - How to Hide or Unhide It 

The purpose of PowerPoint hidden slides is to bypass certain slides during the slide 
show.  
Put a scenario like this - The presentation slide is created but just don't want to show to 
the audiences maybe because of the time constrain or slide contain sensitive issue for a 
particular group of people. 
So the solution is you make the slide hidden. How to do it? Follow the tutorial here. 
 
To hide slides in a slide show  

 Select the slide(s) you wish to hide. 
 From the Slide Show menu, click Hide Slide. 
 If you are working in the Slide Sorter view, you can see an icon appears below the slide, which 

contain the slide number with a line through it, to indicate that it is hidden. 



 

 

 
To display a hidden slide during a slide show  

 Within the slide show, right click on the slide that precedes the slide that is hidden. 
 Click on the Go to Slide command, and then click on the slide that are hidden to display it. 

 
To unhide the slide  

 If you are working in the Slide Sorter view, right-click on the hidden slide and from the pop 
up menu, select Hide Slide. 

 



 
PowerPoint Custom Animation Effects 

PowerPoint custom animation effects are the special visual or sound effect to text or an 
object. You can control how and when each individual object enters and exits, and you 
can even make objects dance around and make noise while they are just sitting there on 
the slide. 
For example, you can have your text bullet points fly in from the left, one word at a 
time, or hear the sound of applause when a picture is uncovered. You can animate any 
number of objects on a slide, and you can even animate elements of a chart. 
This kind of animation effects can dramatically increase the interest of the audiences 
and make your presentation more alive. 
There are four types of animation effects possible on a slide, and each has a different 
color icon as follows:  

 Entrance (green): The item appears on the slide separately from the slide itself. Either it does 
not appear right away, or it appears in some unusual way (like flying in), or both. 

 Emphasis (yellow): An item that is already on the slide moves or changes in some way. For 
example, perhaps it spins around, grows, or changes color. 

 Exit (red): The item disappears from the slide before the slide itself disappears, and 
(optionally) it does so in some animated way. 

 Motion paths (gray): The item moves on the slide according to a preset path you specify, like 
a toy train running on a track you have designed. 

Note: Entrance and exit effects usually involve some type of motion. Emphasis 
effects can involve motion but not necessarily; there are also emphasis effects for 
changing color, changing font, growing/shrinking, and so on. 
 
To apply the PowerPoint custom animation effects to the objects  

 Select the slide that you wish to apply the PowerPoint custom animation. 
 From the Slide Show menu, select Custom Animation to display the Custom Animation 

pane in the right-hand side of the screen. 

 



 
 Select the object in a slide i.e. text box, chart, clipart, etc that you wish to apply the animation 

effects. 
 Click the Add Effect drop-down button, a menu appears with the four types listed previously. 

Point to the one you want, and a submenu appears. 
 Choose a recently used effect from the submenu, or choose More Effects option to open a 

dialog box. 

 

 If you opened the dialog box, make your selection. A preview of the effect appears behind the 
dialog box. Then, click OK to apply it. 



 

 

 After applying the effect, use the Start: drop-down list at the Modify: section to set its start 
event (On Click, With Previous, or After Previous). 

 If there is a property or setting in the middle drop-down list in the task pane, set it. For 
example, for an entrance or exit effect, there may be a Direction: setting (Top, Bottom, 
horizontal, vertical and so on). 

 Open the Speed: drop-down list in the task pane and select the speed at which the animation 
should occur (Very Fast, Fast, Medium, and so on). 

 Test the animation by clicking the Play button at the bottom of the task pane, or click the Slide 

Show button there to preview it full-screen. (If you do the latter, press Esc to return 
to Normal view.) 

 
To reorder PowerPoint custom animation effects  

 The animations effects that you applied are listed in the Custom Animation task pane. 
 To reorder them, drag-and-drop them up or down on the list, or use the Re-Order up/down 

arrow buttons at the bottom of the task pane. 

 
 
 
 



 

MS Access Tutorials - The Fundamentals 

Welcome to your first lesson on Microsoft Access! Microsoft Access is a powerful 

database program you can use to store all kinds of information from a simple list 

of recipes to an inventory catalog with tens of thousands of products. Once 

information is stored in a Microsoft Access database, it's easy to find, analyze, 

and print. 

Of all the programs in the Microsoft Office suite, Microsoft Access is the one that 

most intimidates people. "Mastering Microsoft Excel or Word was hard enough," 

they think. "How can I ever understand a complicated program like Access?" 

While it's true that Microsoft Access has many advanced features (there are 

computer consultants whose only job is programming Access databases), 

creating and working with a Microsoft Access database is probably a whole lot 

easier than you think. 

With that in mind, this tutorial is your introduction to Microsoft Access and the 

world of databases. In this tutorial you will learn more about exactly what a 

database is, what it is used for, and how to perform simple database tasks, such 

as adding and deleting records. This tutorial also takes you on a basic tour of 

various parts of a Microsoft Access database: Tables, Forms, Reports, and 

Queries. If you have worked with one of the other Microsoft Office applications, 

such as Microsoft Excel or Word, you will find that you already know a lot about 

the concepts covered in this tutorial. And so, without further ado, turn the page 

and take your first step into the world of databases. 



 

Introduction to Databases 

 

...databases store and manage information related to a particular subject or purpose. 

 

In its simplest form, a database is a collection of information that is organized into a list 

and stored in a manner similar to a file cabinet, as seen in figure. Whenever you make a 

list of information, such as names, addresses, products, or invoices, you are, in fact, 

creating a database. Technically speaking, you don't even have to use a database 

program to create a database. You can make a list of information in all kinds of 

programs, such as Microsoft Excel, Word even the meek and lowly Notepad program! 

A database program, however, is much more powerful than a simple list you keep on 

paper or in a Microsoft Word document. A database program lets you: 

 Store Information: A database stores lists of information that are related to a 

particular subject or purpose. It could be a list of aunt Mildred's home recipes, or 

business information, such as a list of hundreds of thousands of customers. A 

database also makes it easy to add, update, organize, and delete information. 



 

 Find Information: You can easily and instantly locate information stored in a 

database. For example, you can find all the customers with the last name 

"Johnson" or all the customers who live in the 55417 zip code and are older than 

65. 

 Analyze and Print Information: You can perform calculations on information in a 

database. For example, you could calculate what percent of your total sales 

comes from the state of Texas. You can also present information in a 

professional-looking printed report. 

 Manage Information: Databases make it easy to work with and manage huge 

amounts of information (see figure 1-2). For example, with a few keystrokes you 

can change the area code for hundreds of customers in the (612) area code to a 

new (817) area code. 

 Share Information: Most database programs (including Microsoft Access) allow 

more than one user to view and work with the same information at once. Such 

databases are called databases. 

Databases usually consist of several parts. A Microsoft Access database may contain up 

to seven different database object types. The following table identifies the database 

objects you can use when creating a Microsoft Access database. Some objects you will 

use all the time (such as Tables), others you will hardly use (such as Modules). Table 1-1 

lists various database objects and describes their uses. 

Database Objects 

Object  Description  

 

Tables store a database's data in rows (records) and columns (fields). For 

example, one table could store a list of customers and their addresses while 

another table could store the customers' orders. A database must always contain 

at least one table where it can store information all the other are optional. 

 

Queries ask a question of data stored in a table. For example, a query might only 

display customers who are from Texas. 



 

Object  Description  

 

Forms are custom screens that provide an easy way to enter and view data in a 

table or query. 

 

Reports present data from a table or query in a printed format. 

 

A special type of Web page designed for viewing and working with Microsoft 

Access data from an intranet or over the Internet. 

 

Macros help you perform routine tasks by automating them into a single 

command. For example, you could create a macro that automatically opens and 

prints a report. 

 

Like , automate tasks but by using a built-in programming language called 

Visual Basic or VB. Modules are much more powerful and complex than macros. 

 

Starting Access and Opening a Database 

 



 

The Open dialog box. 

 

You start Access 2003 the same as you would start any other Windows programwith the 

Start button. Because every computer is set up differently (some people like to 

rearrange and reorder their Program menu), the procedure for Access on your 

computer may be slightly different from the one listed here. 

1. Make sure that your computer is on and the Windows desktop appears on the 

screen. 

2. Click the Windows Start button, located in the bottom-left corner of 

the screen. 

The . 

3. Use the mouse to move the pointer over the words All Programs. 

A menu pops up to the right of All Programs. The programs and menus you see 

listed depend on the programs installed on your computer, so your menu will 

probably look somewhat different from other users' menus. 

4. On the All Programs menu, move the pointer over the words Microsoft Office 

2003, then point to and click Microsoft Office Access 2003. 

Once you click the Microsoft Access program, your computer's hard drive may 

whir for a moment while it loads Access. The Access program appears and the 



 

task pane displays options for an existing database or creating a new database, as 

shown in figure. 

You really can't do anything in Microsoft Access unless you open an existing 

database or create a new database. Most of the time you will open an existing 

database, and here's how to accomplish this simple task. 

5. Click the Open button on the toolbar. 

Other Ways to open a File are to Press Ctrl + O, or select File » Open from the 

menu. 

The Open dialog box appears, as shown in figure. Now you have to tell Access 

where the database you want to open is located. 

6. Navigate to the folder where your practice files are located. 

7. Find and double-click the Lesson 1 file. 

Access opens the Lesson 1 database and displays it in the database window. The special 

in the and their descriptions are outlined in table. 

Special Folders in the Open and Save As Dialog Boxes 

Heading  Description  

 

Displays a list of files that you've recently worked on. 

 

Displays all the files in the the default location where Microsoft Office 

programs save their files. 

 

Displays the files and folders saved on your computer desktop. 

 

Displays a list of the disk drives and other hardware attached to your 

computer. 

 

Displays all the files and folders you can access on other computers. 



 

 

TO START MICROSOFT ACCESS: 

1. CLICK THE WINDOWS START BUTTON. 

2. SELECT ALL PROGRAMS » MICROSOFT OFFICE 2003 » MICROSOFT OFFICE 

ACCESS 2003. 

TO OPEN A DATABASE: 

 CLICK THE OPEN BUTTON ON THE TOOLBAR. 

OR... 

 SELECT FILE » OPEN FROM THE MENU. 

OR... 

 PRESS CTRL + O. 

Understanding the Access Program Screen 

You might find the Access 2003 program screen a bit confusing and 

overwhelming the first time you see it. What are all those buttons, icons, menus, 

and arrows for? This lesson will help you become familiar with the Access 

program screen. There are no step-by-step instructions in this lesson all you have 

to do is look at figure and then refer to figure for details about each item. And, 

most of all, relax! This lesson is only meant to help you get acquainted with the 

Access screen you don't have to memorize anything. 

Don't worry if you find some of these objects confusing at firs tthey will make 

more sense after you've actually used them. 



 

One more important note about the Access program screen: We have been 

examining the in this lesson, but it is by no means the only screen that you will 

encounter in Microsoft Access. Just as there are several different types of in 

Microsoft Access, there are also dozens of different program screens something 

that makes Access quite different from its Microsoft Office cousins Word and 

Excel. You will see some of these screens as we continue this tutorial's tour of 

Microsoft Access. 

The Microsoft Access screen. 

 

The Access Program Screen 

Element  What It's Used For  

Title bar Displays the name of the program you are currently using (in this case, 

Microsoft Access). The title bar appears at the top of all Windows 

programs. 

Menu bar Displays a list of menus you use to give commands to Access. Clicking a 

menu name displays a list of commands for example, clicking the Edit 

menu name would display different formatting commands. 

Toolbar Toolbars are shortcuts they contain buttons for the most commonly used 

commands (instead of having to wade through several menus). The 

toolbars in Access change depending on what you are working on. The 

database toolbar (the toolbar currently displayed) contains buttons for the 

Access commands that you will use most often, such as opening and 

printing databases. 

Database The command center for a database, the Database window, allows you to 



 

Element  What It's Used For  

window view, create, edit, and modify database objects. 

Objects 

bar 

The Objects bar categorizes the different types of database objects. Each 

type of database object has its own iconto view a type of object, click its 

icon on the Objects bar. 

Database 

objects 

Database objects are the basic components that make up a database. 

Database objects include tables, queries, forms, reports, pages, macros, and 

modules. 

Status bar Displays messages and feedback. The Status bar is especially important in 

Access since it can give you meaningful information and messages when 

you are entering information into a database. 

 

Using Menus 

The File menu. 

 



 

The Customize dialog box. 

 

This lesson explains one of the best ways to give commands to Accessby using the . 

Menus for all Windows programs can be found at the top of a window, just beneath the 

program's title bar. In figure, notice the words File, Edit, View, Insert, and Tools. The 

next steps will show you why they're there. 

1. Click the word File on the menu bar. 

A menu drops down from the word File, as shown in figure. The File menu 

contains a list of file-related commands, such as New, which creates a new file; 

Open, which opens or loads a saved file; Save, which saves the currently opened 

file; and Close, which closes the currently opened file. Move on to the next step 

to try selecting a command from the File menu. 

2. Click the word Open in the File menu. 

The Open dialog box appears. You don't need to open a database quite yet, so... 

3. Click the Cancel button to close the Open dialog box. 

Notice that each of the words in the menu has an underlined letter somewhere in 

it. For example, the "F" in the File menu is underlined. Holding down the Alt key 

and pressing the underlined letter in a menu does the same thing as clicking it. 



 

For example, pressing the Alt key and then the F key would open the File menu. 

Move on to the next step and try it for yourself. 

4. Press the Alt key and then press the F key. 

The File menu appears. Once you open a menu, you can navigate to a different 

menu by using either the mouse or the Alt key and the letter that is underlined in 

the menu name. 

If you open a menu and then change your mind, it is easy to close it without 

selecting any commands. Click anywhere outside the menu or press the Esc key. 

5. Click anywhere outside the menu to close the menu without issuing any 

commands. 

The menus in Access 2003 work quite a bit differently than in other Windows 

programs even previous versions of Access! Microsoft Access 2003 displays its 

menu commands on the screen in three different ways: 

o By displaying every command possible, just like most Windows 

programs, including earlier versions of Access. 

o By hiding from view the commands you don't use as frequently (the more 

advanced commands). 

o By displaying the hidden commands if you click the downward-pointing 

arrows at the bottom of the menu or keep the menu open for a few 

seconds. 

6. Click the word Tools in the menu. 

The most common menu commands appear in the . Some people feel intimidated 

when confronted with so many menu options, so the menus in Office XP don't 

display the more advanced commands at first. To display a menu's advanced 

commands, either click the downward-pointing arrow at the bottom of the menu 

or keep the menu open for a few seconds. 



 

7. Click the downward-pointing arrow at the bottom of the . 

The more advanced commands appear shaded on the Tools menu. 

If there isn't a downward-pointing arrow at the bottom of the Tools menu, skip 

this step and move on to Step 8. 

If you're accustomed to working with earlier versions of Microsoft Office, you 

may find that hiding the more advanced commands is disconcerting. If so, you 

can easily change how the work. Here's how: 

8. Select View » Toolbars » Customize from the menu and click the Options tab. 

The appears, as shown in figure. This is where you can change how Access's 

menus work. There are two check boxes here that are important: 

o Always show full menus: Clear this check box if you want to hide the 

advanced commands. 

o Show full menus after a short delay: If this option is checked, Access waits 

a few seconds before displaying the more advanced commands on a 

menu. 

9. Click Close. 

See table below for the menus in Access and their descriptions. 

Menus Found in Microsoft Access 

Menu 

Item  
Description  

File File-related commands to open, close, print, and create new files. 

Edit Commands to copy, cut, paste, find, and replace text. 

View Commands to change how the screen is displayed. 

Insert Items that you can insert into a database, such as graphics and charts. 



 

Menu 

Item  
Description  

Format Commands to format fonts, cell alignment, and borders. 

Records Commands to add, delete, sort, and filter information. 

Tools Tools such as the spell checker and macros. You can also change the default 

options for Microsoft Access here. 

Window Commands to display and arrange multiple windows (if you have more 

than one file open). 

Help Provides help with using Microsoft Access. 

 

TO OPEN A MENU: 

 CLICK THE MENU NAME WITH THE MOUSE. 

OR... 

 PRESS ALT AND THEN THE UNDERLINED LETTER IN THE MENU. 

TO DISPLAY A MENU'S HIDDEN COMMANDS: 

 CLICK THE DOWNWARD-POINTING ARROW AT THE BOTTOM OF THE 

MENU. 

OR... 

 OPEN THE MENU AND WAIT A FEW SECONDS. 

TO CHANGE HOW MENUS WORK: 

1. SELECT VIEW » TOOLBARS » CUSTOMIZE FROM THE MENU AND CLICK 

THE OPTIONS TAB. 



 

2. CHECK OR CLEAR EITHER THE ALWAYS SHOW FULL MENUS AND/OR 

SHOW FULL MENUS AFTER A SHORT DELAY OPTIONS, THEN CLICK 

CLOSE. 

3. CHECK ALWAYS SHOW FULL MENUS TO SHOW MORE ADVANCED 

MENU COMMANDS. 

Working with Multiple Windows 

Use the Windows taskbar to view and move between open windows. 

 

Display two windows at the same time by selecting Window » Tile Horizontally from 

the menu. 

 



 

One of the many benefits of working with Windows is that you can open and 

work with several windows at once. Working with is particularly important in 

Access because each database object you open appears in its own window and 

you will often have to switch between those windows. The Database window 

always remains openclosing the Database window closes the current database. 

This lesson explains how to open and work with more than one window. You 

will also learn some tricks on changing the size of a window, moving a window, 

and arranging a window. 

1. Click the Tables icon on the Objects bar to display the tables in the current 

database. 

Access displays all the tables in the current database. 

2. Double-click the Employees table icon. 

Remember that to open any database object, you can select the object and 

click the Open button in the Database window or just double-click the 

database object. 

The Employees table appears in its own window. The Database window is 

still open too, although you may not be able to see it because it's behind 

the Employees table window. 

One of the big changes in Access 2003 is that each open window appears as 

an icon on the Windows taskbar, as shown in figure. To switch to a 

different document, click its icon on the taskbar. 

3. Click the Lesson 1: Database icon on the Windows taskbar. 

Another way to switch between windows is to select Window from the 

menu bar and then select the window you want to view. 



 

The Database window appears. The Employees table window is still open, 

but you can't see all of it because it is located behind the Database window. 

Sometimes it can be helpful to view two or more windows on your screen 

at the same time. When you want to do this, you use the Window menu to 

select a tile option. Move on to the next step to try this for yourself. 

4. Select Window » Tile Horizontally from the menu. 

Both windowsthe Database window and the Employees table window 

appear on top of each other, as shown in figure. Sometimes it's useful to 

look at more than one window at a time. Notice how the title bar for the 

Employees table window is a different color than the Database window? 

That's because the Database window is active, meaning it's the window or 

document you're currently working on. The other window, Employees 

table, is inactive. 

5. Click anywhere in the Employees table window. 

The Employees table window becomes active and the Database window 

becomes inactive. 

To make working with several windows at once easier, you can change the 

size of the windows. You can maximize or enlarge a window so that it 

takes up the document window. 

6. Click the Maximize button in the Employees table window title bar. 

The Employees table window maximizes and fills the entire screen. You 

can change a maximized window back to its original size by clicking the 

Restore button, which replaces the Maximize button whenever a window 

is maximized. 



 

7. Click the Restore button in the Employees table window title bar to 

restore the Employees table window to its previous size. 

Make sure you click the lower Restore buttonthe Restore button for the 

Employees table windowand not the Restore button for the Access 

program. The window returns to its previous size. 

You can also manually fine-tune a window's size to meet your own 

specific needs. A window must not be in a maximized state if you want to 

manually size it. 

8. Position the mouse pointer over the top edge of the Employees table 

window until it changes to a . 

The arrows point in two directions, indicating that you can drag the 

window's border up or down. 

The mouse is very picky about where you place the pointer, and 

sometimes it can be a little tricky finding the exact spot where the pointer 

changes. 

9. While the pointer is still over the top edge of the window, click and drag 

the mouse up a half-inch to move the window border, and release the 

mouse button. 

Notice how the window border follows as you drag the mouse. When the 

window is the size you want, you can release the mouse button to resize 

the window. You just resized the window by adjusting the top edge of a 

window, but you can also adjust the left, right, and bottom edges of a 

window. 

Sometimes when you have more than one window open at once, you may 

find that one window covers another window or other items on your 



 

screen. When this happens, you can simply move the window to a new 

location on the screenjust like you would move a report or folder to a new 

location on your desk. 

10. Click and drag the title bar of the Employees table window to a new 

location on the screen. Release the mouse button to drop the window. 

Remember that the title bar is at the top of the window or program and 

displays the name of the window or program. 

11. Click on the Close button to close the Employees table window. 

That's all there is to working with multiple windows! 

TO SWITCH BETWEEN MULTIPLE OPEN 
DOCUMENTS: 

 CLICK THE DOCUMENT ON THE WINDOWS TASKBAR. 

OR... 

 SELECT WINDOW AND SELECT THE NAME OF THE DOCUMENT 

YOU WANT TO VIEW. 

TO VIEW MULTIPLE WINDOWS AT THE SAME TIME: 

 SELECT WINDOW FROM THE MENU BAR AND SELECT TILE 

HORIZONTALLY, TILE VERTICALLY, OR CASCADE FROM THE 

MENU. 

TO MAXIMIZE A WINDOW: 

 CLICK THE WINDOW'S MAXIMIZE BUTTON. 

TO RESTORE A WINDOW: 



 

 CLICK THE WINDOW'S RESTORE BUTTON. 

TO MANUALLY RESIZE A WINDOW: 

 CLICK AND DRAG ANY OF THE WINDOW'S BORDERS. 

TO MOVE A WINDOW: 

 DRAG THE WINDOW'S TITLE BAR TO THE LOCATION WHERE YOU 

WANT TO POSITION THE WINDOW 

Adding, Editing, and Deleting Records 

Adding a new record to a table. 

 

You can easily add, change, or delete the records in your table. For example, you 

might want to add a record to store information about a new employee, change 

an existing record when an employee's address changes, or delete a record for an 

employee who no longer works for the company. This lesson explains how to do 

all three of these tasks. First, here's how to add a record to a table: 

1. Click the on the Record Navigation bar, as shown in Figure. 

Other ways to add a new record are to press Ctrl + +, or click the New 

Record button on the datasheet toolbar.  



 

The record selector jumps to the blank row at the end of the table and 

the blinking insertion point (|) appears in the first LastName field. 

2. Enter your last name in the LastName field. 

If you make a mistake you can press the Backspace key to correct it. 

Once you have finished entering data into a field you can press Tab or 

Enter to move to the next field or Shift + Tab to move to the previous field. 

3. Press Tab to move to the next field and enter your first name. 

Getting the hang of this data entry stuff? Move on to the next step and 

finish entering the new record. 

4. Complete the record by entering your own information into each 

respective field (enter today's date for the hire date). Remember to press 

Tab to move to the next field. 

When you have finished adding or editing a record, move to any other 

record to save your changes.  

Finished entering all that information? Super! When you enter data, you 

don't have to click a Save button to save the informationAccess 

automatically saves the information as you enter it. Neat, huh? 

You can also make changes to the records in a table at any time. To edit a 

record, simply click the field you want to edit and make the changes. Let's 

try it! 

5. Position the mouse over the left edge of the Title cell in your record (the 

pointer changes to a ) and then click to select the cell. 



 

When a cell has been selected, anything you type will replace the original 

contents. 

6. Type Inside Sales Coordinator. 

The text "Inside Sales Coordinator" replaces the original contents of the 

Title field in your record. You might want to glance at table, which lists 

several keys that are very important for editing and changing the contents 

of a field. 

7. When you have finished making the change, press Tab. 

You can permanently delete records that you no longer need from a table. 

Here's how: 

8. Place the insertion point anywhere in the record you just added. 

9. Click the on the toolbar. 

Other ways to delete a record are to click the row selector for the record 

you want to delete and press Delete, or right-click the row selector of the 

record you want to delete and select Delete Rows from the shortcut menu.  

The record disappears and a warning dialog box appears, asking you to 

confirm the deletion. 

10. Click Yes to confirm the deletion and then close the table. 

Congratulations! While it may not seem like you have gone over very much, you 

have just learned the ins and outs of data entry with Accessthe most important 

(and boring) database task of all! 

Helpful Editing Keys 

Key(s)  Description  



 

Key(s)  Description  

Tab or 

Enter 

Moves to the next field in the table. If you're at the last field or cell in a 

table, pressing Tab or Enter will save your changes and move to the first 

field in the next record. 

Esc The is the "Wait, I've changed my mind" key. Press Esc to cancel any 

changes you've made to a record. 

, , , or 

» 

Use the to move between fields and records. If you are editing a field, 

pressing the left and right arrow keys will move the insertion point one 

character to the left or right. 

Delete Nothing surprising here. The deletes or erases whatever is selectedtext, cell 

contents, even entire records. If you're working with text, the Delete key 

erases characters to the right of the insertion point. 

Backspace Use the to fix your typing mistakesit erases characters to the left of the 

insertion point. 

 

TO ADD A NEW RECORD: 

1. CLICK THE NEW RECORD NAVIGATION BUTTON. 

OR... 

CLICK THE NEW RECORD BUTTON ON THE TOOLBAR. 

OR... 

PRESS CTRL + +. 

2. ENTER THE RECORD INFORMATION FOR THE FIELD, PRESSING TAB 

TO MOVE TO THE NEXT FIELD AND SHIFT + TAB TO MOVE TO THE 

PREVIOUS FIELD. 



 

TO EDIT A RECORD: 

 CLICK THE FIELD YOU WANT TO EDIT AND MAKE THE CHANGES. 

TO DELETE A RECORD: 

 PLACE THE INSERTION POINT ANYWHERE IN THE RECORD AND 

CLICK THE DELETE RECORD BUTTON ON THE TOOLBAR. 

 
 
 
 
 
 


